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Techniques de modélisation pour la conception des bâtiments parasismiques en tenant 

compte de l’interaction sol-structure 

Résumé 

 
La conception des bâtiments selon le code sismique européen ne prend pas en compte les effets de 

l'interaction sol-structure (ISS). L'objectif de cette recherche est de proposer une technique de 

modélisation pour prendre en compte l’ISS et l'interaction structure-sol-structure (ISSS). 

L'approche de propagation unidirectionnelle d’une onde à trois composantes (1D-3C) est adoptée pour 

résoudre la réponse dynamique du sol. La technique de modélisation de propagation unidirectionnelle 

d'une onde à trois composantes est étendue pour des analyses d'ISS et ISSS. Un sol tridimensionnel (3-

D) est modélisé jusqu'à une profondeur fixée, où la réponse du sol est influencée par l’ISS et l’ISSS, et 

un modèle de sol 1-D est adopté pour les couches de sol plus profondes, jusqu'à l'interface sol-substrat. 

Le profil de sol en T est assemblé avec une ou plusieurs structures 3-D de type poteaux-poutres, à l’aide 

d’un modèle par éléments finis, pour prendre en compte, respectivement, l’ISS et l’ISSS dans la 

conception de bâtiments. 

La technique de modélisation 1DT-3C proposée est utilisée pour étudier les effets d’ISS et analyser 

l'influence d'un bâtiment proche (l'analyse d’ISSS), dans la réponse sismique des structures poteaux-

poutres. Une analyse paramétrique de la réponse sismique des bâtiments en béton armé est développée 

et discutée pour identifier les paramètres clé du phénomène d’ISS, influençant la réponse structurelle, 

à introduire dans la conception de bâtiments résistants aux séismes. 

La variation de l'accélération maximale en haut du bâtiment avec le rapport de fréquence bâtiment / sol 

est tracée pour plusieurs bâtiments, chargés par un mouvement à bande étroite, excitant leur fréquence 

fondamentale. Dans le cas de sols et de structures à comportement linéaire, une tendance similaire est 

obtenue pour différents bâtiments. Cela suggère l'introduction d'un coefficient correcteur du spectre de 

réponse de dimensionnement pour prendre en compte l’ISS. L'analyse paramétrique est répétée en 

introduisant l'effet de la non-linéarité du sol et du béton armé. 

La réponse sismique d'un bâtiment en béton armé est estimée en tenant compte de l'effet d'un bâtiment 

voisin, pour un sol et des structures à comportement linéaire, dans les deux cas de charge sismique à 

bande étroite excitant la fréquence fondamentale du bâtiment cible et du bâtiment voisin. Cette approche 

permet une analyse efficace de l'interaction structure-sol-structure pour la pratique de l'ingénierie afin 

d'inspirer la conception d'outils pour la réduction du risque sismique et l'organisation urbaine. 

 

Mots clés : Interaction Structure-Sol-Structure ; interaction Sol-Structure ; méthode d’éléments finis ; 

propagation d’onde ; chargement sismique à trois composantes ; béton armé ; comportement non-

linéaire. 
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Modeling techniques for building design considering soil-structure interaction 

 

Abstract 

 
Building design according to European seismic code does not consider the effects of soil-structure 

interaction (SSI). The objective of this research is to propose a modeling technique for SSI and 

Structure-Soil-Structure Interaction (SSSI) analysis.  

The one-directional three-component (1D-3C) wave propagation approach is adopted to solve the 

dynamic soil response. The one-directional three-component wave propagation model is extended for 

SSI and SSSI analysis. A three-dimensional (3-D) soil is modeled until a fixed depth, where the soil 

response is influenced by SSI and SSSI, and a 1-D soil model is adopted for deeper soil layers until the 

soil-bedrock interface. The T-soil profile is assembled with one or more 3-D frame structures, in a finite 

element scheme, to consider, respectively, SSI and SSSI in building design. 

The proposed 1DT-3C modeling technique is used to investigate SSI effects and to analyze the influence 

of a nearby building (SSSI analysis), in the seismic response of frame structures. 

A parametric analysis of the seismic response of reinforced concrete (RC) buildings is developed and 

discussed to identify the key parameters of SSI phenomenon, influencing the structural response, to be 

introduced in earthquake resistant building design. 

The variation of peak acceleration at the building top with the building to soil frequency ratio is plotted 

for several buildings, loaded by a narrow-band motion exciting their fundamental frequency. In the case 

of linear behaving soil and structure, a similar trend is obtained for different buildings. This suggests 

the introduction of a corrective coefficient of the design response spectrum to take into account SSI. 

The parametric analysis is repeated introducing the effect of nonlinear behaving soil and RC. 

The seismic response of a RC building is estimated taking into account the effect of a nearby building, 

for linear behaving soil and structures, in both cases of narrow-band seismic loading exciting the 

fundamental frequency of the target and nearby building. This approach allows an easy analysis of 

structure-soil-structure interaction for engineering practice to inspire the design of seismic risk 

mitigation tools and urban organization. 

 

 

Keywords: Structure-Soil-Structure Interaction; Soil-Structure interaction; finite element method; 

wave propagation; three-component seismic motion; reinforced concrete; nonlinear behavior. 
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Résumé étendu 
 

Mon travail s’intéresse à la réponse sismique des structures dans leur environnement. Cette 

réponse sismique d'une structure dépend de la secousse incidente et de la propagation des ondes 

dans le sol et dans la structure elle-même. La structure étant couplée mécaniquement au sol, 

son excitation renvoie les ondes dans le sol. Ce phénomène est l’Interaction Sol Structure (ISS).  

Selon les codes européens de conception parasismique en vigueur (CEN 2003), le mouvement 

en surface libre est actuellement utilisé comme chargement sismique au bas d'un bâtiment à 

base fixe (BF), pour la conception de bâtiments à fondation superficielle. Cette analyse en 

« deux étapes » (Saez et al., 2011), ne permet donc pas de simuler numériquement l’ISS. Les 

effets d’ISS ne sont pris en compte que lorsque la réponse sismique de la structure est obtenue 

en résolvant le problème de l'équilibre dynamique appliquée à l'ensemble du domaine sol-

structure : analyse en une étape. Nous avons montré que l’on pouvait, dans certaines conditions, 

considérer les effets de l’ISS comme une modification de la sollicitation sismique, influencée 

par les caractéristiques dynamiques structurelles, les paramètres mécaniques du sol et les 

caractéristiques de mouvement d'entrée. 

Lors d’une sollicitation sismique, la topographie, la caractérisation géologique et 

géomécanique du sol affectent de manière significative le mouvement enregistré à surface libre. 

‐n particulier, de plus en plus les études s’attachent à comprendre les effets d’un comportement 

mécanique non linéaire dans les couches superficielles, comme dans les structures. Ces effets 

sont mis en évidence par exemple lors du benchmark PRENOLIN (Régnier et al. 2016) au 

cours duquel plusieurs relations constitutives non-linéaires ont été comparées par simulation 

numérique de la réponse sismique non-linéaire de site 1-D. Mais ces modèles testés exigent un 

nombre de paramètres important pour correctement reproduire la réponse du sol à un niveau 

de charge élevé. Comme pratiquement ces paramètres de sol peuvent être difficiles à 

déterminer, ces modélisations, importantes pour la compréhension des phénomènes, sont 

impossibles à introduire dans la règlementation. Je me suis attachée à concevoir un système 

équivalent plus simple : un modèle constitutif de sol efficace est celui qui est fiable et nécessite 

peu de paramètres à caractériser. 

Plus largement, lorsque la construction est étendue à plus d'une structure, l’excitation sismique 

d’une structure est affectée par la présence des structures adjacentes. Cette interaction croisée 

entre structures voisines et le sol lors d’une sollicitation sismique est appelée interaction 
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structure-sol-structure (ISSS). Nous avons aussi abordé cette question fondamentale dans la 

construction des villes. 

Afin d’étudier l’ISS et l’ISSS, une modélisation numérique du système sol-structure sous un 

chargement sismique est nécessaire. Plusieurs méthodes numériques ont été utilisées pour 

résoudre la propagation de l’onde dans un environnement complexe : les différences finies, les 

éléments finies (EF), les éléments spectraux, les éléments frontières et d’autres. Selon Chaljub 

et al. (2010), aucune méthode numérique unique ne peut être considérée comme la meilleure. 

Dans mon travail, la solution directe de l'équation d'équilibre dynamique est résolue dans un 

schéma EF et le comportement non-linéaire des matériaux est pris en compte. Des conditions 

aux limites latérales périodiques sont adoptées, pour réduire le domaine du sol modélisé, 

lorsque l'hypothèse de périodicité est possible. Les résultats obtenus me permettent de proposer 

un modèle efficace pour la pratique de l’ingénierie qui tient compte de l’ISS. 

 

Modèle de propagation unidimensionnel d’onde à trois composantes pour l’interaction sol-

structure 

Pour mettre en œuvre la simulation, un modèle de propagation unidirectionnelle (1D) est 

couplé à un modèle de bâtiment tridimensionnel (3-D) dans l’hypothèse de propagation d’onde 

verticale et de fondation superficielle rigide (modèle 1D-3C). Cette formulation est adaptée à 

la description de la colonne de sol par les données géotechniques généralement disponibles et 

permet de réduire le temps de calcul. Il est encore assez rare de connaître la géométrie et la 

stratigraphie d’un bassin sédimentaire qui serait nécessaire à une modélisation 3-D plus 

complète. 

La loi de comportement d’Iwan (Iwan 1967), a été utilisée pour décrire le comportement non 

linéaire du sol sous chargement cyclique, en termes de contraintes totales. La solution du 

problème d’ISS est obtenue par solution directe de l’équation d’équilibre dynamique de 

l’ensemble. L’hypothèse de sol infiniment étendu dans les directions horizontales est traduite 

par une condition de périodicité latérale. Le mouvement sismique est imposé à la base de la 

colonne de sol en utilisant une condition absorbante qui prend en compte l’effet de l’élasticité 

du substratum rocheux.  

Le modèle 1D-3C a été vérifié, dans le cas de comportement linéaire de sol et en utilisant un 

algorithme d’intégration implicite, par comparaison avec les résultats obtenus par le code 

maison SWAP_3C (Santisi d’Avila and Lenti 2012) pour les études de réponse sismique du 
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sol à la surface libre et S‑RINT_3C (Santisi d’Avila and Lopez-Caballero 2018) pour les 

études de réponse sismique de sol et du bâtiment en considérant l’ISS. ‐nsuite, le modèle 1D-

3C est validé, dans le cas de comportement non-linéaire de sol. 

L’objectif est de prouver la pertinence du modèle de propagation 1D-3C dans un problème 

d’ISS, comparé à un modèle 3D-3C. Conceptuellement, ce dernier donne l’avantage de pouvoir 

modéliser la dalle de fondation par des éléments finis solides et donc de prendre en compte sa 

déformabilité. Par contre, dans le modèle de propagation 1D-3C, le même mouvement est 

imposé à la base de tous les poteaux du bâtiment simulant une base rigide. La comparaison 

quantitative des signaux obtenus par le modèle 1D-3C est effectuée en termes de pics en 

amplitude, d’intégrale d’Arias, d’intégrale en énergie, de spectre de ‑ourier et de réponse et de 

rapport de corrélation (coefficients du comparatif Goodness-of-fit proposés par Anderson, 

2004). Les résultats obtenus dans le cas de propagation verticale montrent la fiabilité du modèle 

1D-3C pour le sol quand les hypothèses de couches horizontales suffisamment étendues et de 

fondation superficielle rigide sont respectées. Le cas d’un champ d’onde incliné fera partie 

d’une étude ultérieure.  

 

Propagation unidirectionnelle d'onde à trois composantes dans un domaine de sol en forme 

de T pour l’ISS et l’ISSS 

L'approche de propagation unidirectionnelle d’une onde à trois composantes (1D-3C) est 

adoptée pour résoudre la réponse dynamique du sol. La technique de modélisation de 

propagation unidirectionnelle d'une onde trois composantes est étendue pour des analyses d'ISS 

et ISSS. Les résultats obtenus sur l’ISS montrent que cette interaction n’est observée dans le 

sol que dans les premières couches. Par conséquence, un modèle de sol 3-D est adopté jusqu'à 

une profondeur fixée, au-dessus de laquelle on considère que la déformation est influencée par 

l’ISS et l’ISSS, alors qu’un modèle de sol 1-D est adopté pour les couches de sol plus 

profondes, jusqu'à l'interface sol-substrat (modèle 1DT-3C). Le profil de sol en T est assemblé 

avec une ou plusieurs structures 3-D de type poteaux-poutres à l’aide d’un modèle par éléments 

finis, pour prendre en compte, respectivement, l’ISS et l’ISSS. Ce modèle permet de prendre 

en compte la déformabilité de la fondation et les effets de basculement et peut simuler 

l’interaction entre plusieurs bâtiments.  

L'approche 1DT-3C est vérifiée par comparaison avec un modèle entièrement 3D-3C, dans le 

cas d'une propagation verticale dans un sol stratifié horizontalement. La technique de 
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modélisation 1DT-3C proposée est donc un outil pour la conception de bâtiments, permettant 

de prendre en compte l’ISS de manière efficace et simple. De fait, dans le cas d’une propagation 

verticale et de paramètres géotechniques homogènes dans chaque couche de sol, l’utilisation 

d’éléments solides unitaires pour les couches plus profondes, au lieu d’un domaine 3-D, 

représente une réduction du temps de calcul sans affecter les résultats.  

L’effet d’ISS est défini comme la différence en termes d'accélération maximale a _ /a _   entre la solution en une étape (résolution directe du problème d’équilibre 

dynamique de l’ensemble sol-bâtiment) et la solution obtenue par la méthode en 2 étapes 

(mouvement à surface libre appliqué à un bâtiment à base fixe). Mon étude montre que cet effet 

est plus important dans le cas où le sol est plus mou et dans le cas d'un comportement de sol 

non linéaire. Des effets de résonance entre les fréquences du bâtiment, la fréquence associée 

au sol et le contenu fréquentiel du signal sismique produisent une réponse sismique amplifiée. 

L'effet d’ISS est observé pour les deux premiers modes de translation du bâtiment et est plus 

prononcé dans la direction du mode excité par la charge d'entrée.  

 

Spectre de réponse pour la conception parasismique tenant compte de l'interaction sol-

structure 

Une analyse paramétrique de la réponse sismique des bâtiments en béton armé est développée 

et discutée pour identifier les paramètres clé du phénomène d’ISS, influençant la réponse 

structurelle, à introduire dans la conception parasismique de bâtiments. 

La variation de l'accélération maximale en haut du bâtiment avec le rapport de fréquence 

bâtiment / sol est tracée pour plusieurs bâtiments, chargés par un mouvement à bande étroite 

qui excite leur fréquence fondamentale. Dans le cas de sols et de structures à comportement 

linéaire, une tendance similaire est obtenue pour différents bâtiments. En régime élastique 

linéaire, l’ISS peut être pris en compte à l'aide d'un facteur de correction appliqué au résultat 

d'une analyse en deux étapes (modèle de bâtiment à base fixe chargé par un signal sismique à 

surface libre). Ce facteur de correction dépend du rapport de fréquence fondamentale /  du 

bâtiment au sol.  

L'analyse paramétrique est répétée en introduisant l'effet de la non-linéarité du sol et du béton 

armé. L'effet de la non-linéarité du sol sur la réponse sismique des bâtiments est prépondérant 

par rapport à l'effet de la non-linéarité du béton armé. La non-linéarité du comportement du sol 

ou du sol et de la structure, tend à augmenter l'irrégularité de la réponse sismique des bâtiments. 
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De plus elle modifie la fréquence de vibration pendant le processus. Par conséquent, en tenant 

compte du comportement non-linéaire des matériaux, la réponse sismique des bâtiments 

considérant l’ISS ne peut plus être reproduite en appliquant un simple facteur de correction sur 

les résultats obtenus par l’analyse en deux étapes. 

 

Analyse de l'interaction structure-sol-structure 

La réponse sismique d'un bâtiment en béton armé est estimée en tenant compte de l'effet d'un 

bâtiment voisin, pour un sol et des structures à comportement linéaire. Cette approche permet 

une analyse efficace de l'interaction structure-sol-structure pour la pratique de l'ingénierie afin 

d'inspirer la conception d'outils pour la réduction du risque sismique et l'organisation urbaine. 

L'analyse effectuée à l'aide de la technique de modélisation 1DT-3C montre que l’ISSS est 

observée dans la direction du premier mode de vibration du bâtiment. L’ISSS donne, pour 

certains cas, une amplification jusqu’à  % du mouvement non prise en compte lorsque le 

bâtiment est considéré comme isolé. En outre, dans un sol meuble, la réponse sismique du 

bâtiment excité ne présente pas de variations importantes du fait de la présence de bâtiments 

voisins. L’effet de l’ISS l’emporte sur l’effet de l’ISSS.  

 

Conclusions et perspectives 

Dans les pratiques professionnelles, les normes de conception évoluent en fonction des 

nouvelles découvertes et des progrès croissants les capacités informatiques. Aujourd'hui, les 

codes de conception sismiques européens ne prennent toujours pas en compte l’ISS et l’ISSS 

dans la conception des structures. Cette recherche étudie les phénomènes d’interaction entre 

sol et structures, propose et valide des techniques de modélisation pour évaluer les réponses 

dynamiques des sols et des structures aux séismes, en prenant en compte l’ISS et l’ISSS.  

L'approche de propagation des ondes sismiques 1DT-3C est proposée comme technique de 

modélisation pour la simulation de la réponse sismique des sols et des bâtiments, en tenant 

compte des effets de site, de la déformabilité des fondations, des effets de basculement et, 

éventuellement, de l’ISSS. Le modèle 1DT-3C consiste à adopter un modèle entièrement 3-D 

jusqu'à une profondeur fixe, au-dessus de laquelle les effets d’ISS et d’ISSS modifient le 

mouvement du sol et au-delà de laquelle un modèle 1-D est supposé être une approximation 

suffisante.  
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La technique de modélisation 1DT-3C proposée est un outil efficace pour la conception de 

bâtiments, permettant de prendre en compte facilement et efficacement les ISS et ISSS pour 

des comportements des matériaux linéaires et non-linéaires, offrant des avantages en terme de 

temps de modélisation et de calcul par rapport à un modèle entièrement 3-D. L’introduction 

des comportements non-linéaires est absolument nécessaire car les observations actuelles dans 

les zones soumises à de fortes sollicitations sismiques, montrent que ces effets sont importants. 

Par ailleurs cet outil s’adapte bien aux pratiques :  

- les paramètres géotechniques peuvent assez simplement caractérisés pour un modèle 

de sol unidimensionnel en utilisant un forage, alors qu’une caractérisation 3D serait très 

lourde (plusieurs forage et mise en adéquation des observations).  

- la définition des conditions aux limites est simple : le signal d'entrée et la condition aux 

limites d'absorption ne sont donnés que pour un seul élément.  

- le maillage est considérablement réduit. 

L’analyse paramétrique combinant 11 profils de sol et 5 structures différentes montre qu’en 

régime élastique linéaire l’ISS peut être pris en compte assez facilement à partir des résultats 

d’une étude traditionnelle en deux étapes. Elle permet donc de proposer une amélioration 

potentielle des spectres de réponse pour la conception parasismique proposés par l’‐urocode 8 

en régime élastique. 

Par contre le comportement non-linéaire du matériau provoque une modification de la réponse 

sismique du sol et des bâtiments, avec en particulier, une modification les fréquences 

caractéristiques. L’analyse paramétrique que je présente permet de tirer quelques résultats 

qualitatifs, mais montre qu’il n’y a pas de façon simple, pour la conception des bâtiments, de 

s’appuyer sur les modélisations traditionnelles qui se limitent à un comportement linéaire des 

matériaux. 

La méthode proposée est efficace aussi pour une analyse de l'influence de l’ISSS sur un 

bâtiment cible. Je présente une analyse paramétrique le régime élastique linéaire. Les résultats 

montrent que si, dans le cas de sol mous, l’effet de l’ISS l’emporte sur l’effet de l’ISSS, dans 

les autres conditions de sol l’ISSS ne peut pas être négligé. L'analyse paramétrique donne des 

résultats préliminaires qui ne permettent pas encore de généraliser. 

Cette recherche pourrait se prolonger par une analyse paramétrique et une étude statistique 

approfondies visant à généraliser la conception des structures dans les zones sismiques, en 

tenant compte des effets d’ISS. Pour permettre la vérification du modèle numérique, des 
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expériences sur des structures instrumentées à des échelles réelle ou proportionnelle pourraient 

être utilisées pour comparer observations et calculs numériques. L'approche de propagation des 

ondes 1D-3C pourrait évoluer pour modéliser les fondations profondes et les sols encaissants, 

en considérant un domaine 3-D atteignant une plus grande profondeur. Une analyse de 

contrainte efficace, prenant en compte la position de la nappe phréatique dans un modèle de 

propagation d'ondes 1DT-3C pour l’analyse de l’ISS, est actuellement développée dans le cadre 

de la thèse de doctorat de Stefania Gobbi. D'autres améliorations peuvent être introduites 

comme, la corrosion des barres d'acier dans le béton armé ou la considération des matériaux de 

construction différents tel que le bois et l’acier. 
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Introduction 

 
Earthquake engineering research is an interdisciplinary field involving structural and 

geotechnical engineers, seismologists, architects and urban planners. It is a discipline that 

studies the antiseismic conception of new structures and the ability of existing structures to 

survive an earthquake without sever damage. The building codes are based on actual 

knowledge concerning the seismic conception and design. 

The need for such codes is initiated by several major earthquake disasters causing damage to 

structures hence, to population. The damage concerns reinforced concrete structures as well as 

wooden and steel structures and is observed in low-, mid- and high- rise buildings and that, 

either in lower, mid or upper story of structures. Earthquake damage also attains the soil leading 

to soil failure and eventual the collapse of the structures.  

Due to variabilities in observations and seismic risk in regions the requisite for research in this 

field becomes higher in order to understand soil and structure responses to earthquakes and 

contribute in the progress of seismic codes. There are several seismic codes used in the world, 

most of them share similar fundamental design approaches and only differ in the techniques of 

application regarding local geological conditions and common new and old construction types.  

In France the first text aiming to prevent constructions to earthquake shakings was written in 

1955 in the recommendation AS55. The text was updated through time with studies and new 

earthquake events. In 2005 the Eurocode 8, a new seismic code based on the European rules 

for construction, is employed in France to protect people and restrain structural damages to 

earthquakes. The metropolitan France presents moderated seismicity in which the eastern 

Provence presents the highest risk. For this reason, the region of Provence-Alpes-Côte d'Azur 

encourage research on seismic risk in the purpose of prevention of structural seismic damages.   

Previous researches have shown that the interaction between the soil and the building induces 

modification in the dynamic response of the building (Veletsos and Meek 1974; Jennings 1970; 

Wolf 1985; Gazetas 1991). This modification of the structure response is not beneficial in all 

conditions and if it is the case, an overdesign is assumed.  

The soil-structure interaction (SSI) has been the subject of many works, showing the 

importance of the SSI assessment in seismic structural design. In the Eurocode 8 the structure 

is considered as a simplified model using single degree of freedom (SDOF) and SSI is studied 

in a two-step analysis as named by Saez et al. (2011). This two-step analysis doesn’t correctly 

model the interaction between the soil and the structure. An update to such procedure 
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considering the advances in theory and practice is mandatory. The lack of the previous version 

of the Eurocode 8 has encourage this research to consider SSI for structures with shallow 

foundation, model multilayered soil profiles and study the dynamic response of the assembly 

soil-structure.  

The Eurocode 8 is limited to the elastic linear behavior of materials. However, evidence of 

nonlinearity in the soil has been observed for a long time now. In Japan, a seismological data 

is recorded in Kiban Kyoshin Network since 1995, following the Hyogo-Ken Nanbu 

earthquake of 1995 Kobe Japan, and provides evidence that soils tend to quickly reach 

nonlinearity properties for higher shaking amplitude. On the other hand, a non-cracked 

structure is an overstatement, cracks are created in concrete at early age and nonlinear behavior 

of the reinforced concrete should be considered to study the seismic response of a structure. 

The aim of this research is to provide additional knowledge on structure and soil seismic 

responses, evaluate the accuracy of modeling techniques employed to replicate the SSI effect 

due to dynamic excitation and propose eventual advancement in the earthquake engineering 

field. 

The progression of this research goes as following: 

• Modeling technique for SSI (Chapter 2): The one-directional three-component (1D-3C) 

wave propagation approach is propagated in a one-dimensional (1-D) soil assembled with 

3-D frame structure in a finite element (FE) scheme (1D-3C). The linear elasticity is 

employed, it is a simplification considered for structural design, assuming a behavior in 

elastic strain range, sufficiently far from yielding threshold. This hypothesis simplifies 

the numerical computations, avoiding modeling of nonlinear material behavior, accepting 

superposition principle and modeling concrete as a homogeneous material before 

cracking without the effect of reinforcing bars. Later the nonlinear behaving of materials 

is considered, in a dynamic analysis, introduces the hysteretic dissipation of energy in the 

assembly soil-structure and the system soil response is modified and depends on more 

parameters and on the time history, increasing the difficulty of prediction with simplified 

empirical tools.  

The 1D-3C model is verified comparing with validated codes in a free field (FF) analysis 

using SWAP_3C (proposed by Santisi d’Avila and Lenti 2012), and in a SSI analysis 

using S‑RINT_3C (proposed by Santisi d’Avila and Lopez-Caballero 2018), considering 
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linear and non-linear soil behaving. Analysis are undertaken using the 1D-3C model for 

SSI analysis. 

• Advanced modeling technique for SSI and structure-soil-structure interaction (SSSI) 

(Chapter 3): Analysis using the 1D-3C model for SSI have shown evidence of the effect 

of SSI in the first layers of the soil and negligible or no effect in deeper soil. Based on 

this observation a T-shaped soil modeling is proposed (1DT-3C). It consists on modeling 

3-D soil model until a certain thickness to be defined, depending on the SSI, connected 

to a 1-D soil modeled until the bedrock interface. The 3-D soil model permits the 

embedment of a 3-D foundation connected to the base node of the columns of the 3-D 

structure allowing rocking effect. The 1DT-3C present an efficient modeling technique 

for engineering practice, to consider SSI in any commercial FE code. 

The proposed 1DT-3C model is verified, in linear and non-linear soil behaving, and SSI 

analysis are undertaken. 

• Parametric investigation on SSI (Chapter 4): After verification of the proposed model for 

dynamic SSI and SSSI analyses, different computations are carried out to compare the 

structure and soil responses to earthquake, in the cases of linear and nonlinear behaving 

materials. A parametric analysis is performed to investigate the variation of the SSI effect 

with soil and structure dynamic features of the frequencies.  

• Parametric investigation on SSSI (Chapter 5): Afterward a study on SSSI is held focusing 

on a target building and varying the nearby building and quake predominant frequency. 

The lateral boundary condition is investigated in order to assess a complex geometry of 

soil and structure plan for SSSI investigations. 
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Continuous efforts have been made towards improving modeling techniques in earthquake 

engineering (characterization of geotechnical parameters, rheologic behavior, site effects, 

interaction between structure and soil, and with nearby structures), beside the continuous 

development of risk mitigation tools. Moreover, design codes need to evolve in the regulation 

of seismic loading definition using signals. Numerical methods that solve a dynamic soil-

structure interaction problem is not currently adopted in the engineering practice for building 

design, but it remains a subject for researchers or taken into account in design of bridges, dams 

or towers. In the following, basic concepts of structural dynamics are introduced and previous 

research findings are presented.  

 

 

 

 

 

 

 

 

 

 

 

 



1.1 Introduction to structural dynamic problem 

40 

 

1.1 Introduction to structural dynamic problem 

In structural analysis, static and dynamic loading are considered. If the applied load has a long 

period, enough to be consider constant and neglect inertial forces it is static otherwise it is a 

dynamic load.  

The structural dynamics aims to study the behavior of a structure under dynamic loadings. In 

particular, in earthquake engineering the structural response to earthquakes is analyzed. 

1.1.1. Single degree of freedom (SDOF) 

An adopted simplification to model structures under seismic loading is to represent the 

structure using a single degree of freedom oscillator (SDOF). It consists on a lumped mass  

held by a massless column with stiffness , damping coefficient  (Figure 1-1). The system is 

considered fixed at the bottom and subjected to earthquake loading, = − � ,  that is 

time dependent, according to Newton’s second law, where �  is the ground acceleration at 

the building base. The differential equation of motion for the SDOF oscillator is  

 + + =  (1-1) 

 
where , , and  are the inertial, viscous and elastic force, respectively. The dot 

represents time derivative and ,  and  are the structural displacement, velocity and 

acceleration, respectively. 

 
Figure 1-1 Single degree of freedom oscillator (SDOF) subjected to earthquake ground motion  

(t) . 

Dividing Eq. (1-1) by the mass m gives 
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 + w + = − �  (1-2) 

where �  is the seismic loading,  = ⁄  is the damping ratio, =  is the critical 

damping coefficient and = √ ⁄  is the undamped angular frequency of the oscillator 

(Chopra 2001). The solution of the homogenous equation of motion (− � =  having 

initial static conditions = , =  is written in  

 = e_ζ 0 [ cos + + ⁄ sin ] (1-3) 

where = √ −  ². The natural period of the oscillator is � = ⁄  its frequency is  = �⁄  implying that more the structure is stiffer, higher is its natural frequency of 

vibration. 

The increase of the damping ratio in Eq. (1-2) outcomes a slow to fast attenuation of the free 

vibration (Figure 1-2). Damping in structures originate from a low friction in materials but it 

is mostly due to damage in non-structural elements (Bachmann et al. 2012). The typical 

damping  for buildings vary between  and %, this implies that the damped and undamped 

natural period and frequencies are almost identical.  

 
Figure 1-2 Free vibration of a SDOF system with different levels of damping:  = , , , and %. (Chopra 2001) 
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1.1.2. Numerical solution of the dynamic equilibrium equation for SDOF oscillators 

The dynamic equilibrium equation for a SDOF oscillator under seismic loading �  is written 

in Eq. (1-2), it can be rewritten as   

 = � Δt − + � Δt  − + � Δt   (1-4) 

 = � +   (1-5) 

where the subscript  is the iteration step, = − �   and 

 
= [ ] (1-6) 

Eq. (1-4) and Eq. (1-5) can be solved by iteration, considering the static initial conditions  = , = . The variables � Δt , , , � Δt  and � Δt  in Eq. (1-4) and Eq. (1-5) 

are defined as following 

 � Δt = [− Δt ℎ Δt− ℎ Δt ℎ Δt ], = [ ], = [− − ] (1-7) 

 
� Δt = � Δt − Δt /Δt − , � Δt = Δt /Δt − � −  (1-8) 

where the functions presented in Eq. (1-7) and Eq. (1-8) are defined as 

 
Δt = � Δt − � −  (1-9) 

 Δt =  − / −ζ 0Δ cos Δ + /  sin Δ  (1-10) 

 ℎ Δt = − / −ζ 0Δ sin Δ  (1-11) 

 ℎ Δt = −ζ 0Δ cos Δ − w /  sin Δ  (1-12) 

1.1.3. Dynamic study of a MDOF system in the frequency domain 

The dynamic solution of a multiple degree of freedom (MDOF) structure under seismic loading � t , assuming linear constitutive behavior of materials, is written as 
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 + + = − �u�  (1-13) 

where the ,  and  are the mass, stiffness and damping matrices respectively. The dot 

represents the time derivative, consequently, ,  and  are the displacement, velocity and 

acceleration vectors, respectively, and � is the influence vector. 

Under the assumption of lumped mass, the structural model is simplified as in Figure 1-3 and 

the mass matrix is diagonal as = diag{ , … } , where the subscript  represents the 

total number of stories in the building. 

 

 

Figure 1-3 Multiple degree of freedom (MDOF) oscillator subjected to an earthquake ground 
motion (t) . 

The modal analysis can solve the dynamic equilibrium of a multiple degree of freedom MDOF 

system under the assumption of structural response resulting from the superposition of mode 

shapes. This, under the hypothesis of linear behaving materials. The dynamic equilibrium 

equation Eq. (1-13) can be written in modal coordinates by imposing the transformation = ��. Accordingly, it is  

 �� + �� + �� = − � �  (1-14) 

where �  is the modal displacement at the time step  and � is the modal matrix compound by 

the eigenvectors obtained by solving 
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 � = ��  (1-15) 

The natural angular frequencies are obtained as solution of 

 det − � =  (1-16) 

where � is the vector of eigenvalues such that � =  and �� = { }. Each �  

corresponds to the squared angular frequency of the structure such that < < ⋯ < .  

The subscript  represents the jth mode shape.  

The modal transformation corresponds to an operation of diagonalization of matrices ,  and 

. Consequently, the dynamic equilibrium equation for the MDOF system in Eq. (1-14) is 

solved as a system of independent dynamic equilibrium equations of SDOF systems  

 � + �� + � � = −�� �Δu�  (1-17) 

where � = ���{ } and the modal matrix must be orthonormal with respect to the mass 

matrix and satisfy �� � = � and �� � = � . Each one of Eq. (1-17) is solved as explained 

in section 1.1.2, since the analytical solution is known for the SDOF. The modal superposition 

is possible only for linear behavior of materials and proportionally damped structures. 

1.1.4. Dynamic equilibrium for MDOF structures 

In the case of nonlinear behaving materials, i.e. when the stress-strain relationship is nonlinear, 

the dynamic equation is 

 + + = − �Δu�  (1-18) 

where the stiffness and damping matrices vary during the process. 

Time discretization is needed in order to solve this problem. According with the -method 

(Hughes 1987), at each time step  the following equation can be resolved 

 
+ + + + − − −− − − = + Δ − Δ −  

(1-19) 

In the following equation, for simplicity, the time instant  is indicated by the subscript i: 
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+ + + + − − − − − −  = + Δ − Δ −  

(1-20) 

The increment of velocity  and acceleration  at time step  are written in function of 

the increment of displacement , as following, and substituted in the Eq. (1-20) 

 
 = γ/ Δt − γ/   − + − γ/  Δt −    = / Δt − / Δt  − + /  Δt −  

(1-21) 

at each time step, the displacement increment is obtained by modified equilibrium equation 

 
̅ = + −  (1-22) 

where the modified stiffness matrix is 

 ̅ = / Δt  + + γ/ Δt + +   (1-23) 

and the vector −  is dependent on the result of the previous time step and calculated as  

 
 − = [ / Δt + + γ/  ] −                +[ /  + + γ/ − Δt ] −         + − − + − − − Δ −  

(1-24) 

After evaluating the increment of displacement  using Eq. (1-22), the increment of velocity 

 and the increment of acceleration  are calculated using Eq. (1-21). The total 

displacement , velocity  and acceleration  are then deduced as 

 = − + = − + = − +  (1-25) 

The derivation introduces high frequency noise into the solution; numerical damping removes 

this high-frequency noise without having any significant effect on the meaningful, lower 

frequency response. The control over the amount of numerical damping is provided by the  

-method using the parameters , = . −  and = . −  such that − /  (Hughes 1987). 

The Newmark algorithm is obtained for = , using .  in the case of 

unconditional stability. 
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1.2 Numerical methods 

A numerical method is evaluated according to its efficiency, in terms of time, computer 

memory, and accuracy. According to Chaljub et al. (2010), no single numerical method can be 

considered as the best. Several methods have been used to solve wave propagation in media; 

finite difference method (FDM), boundary element method (BEM), spectral element method 

(SEM) and standard finite element method (FEM).  

PRENOLIN benchmark (Régnier et al. 2016) has compared 20 codes with different numerical 

scheme and found a standard deviation in results of 0.065 in logarithmic unit for a low-

frequency input motion at low PGA values, this deviation increases with the PGA but this may 

also be due to the differences in the nonlinear model implementation. In this paragraph four 

different numerical modeling methods are selected to be presented along with their advantages 

and disadvantages, that often depend on the application.  

1.2.1 Finite difference method  

The FDM has a long tradition in seismology and geophysics. It consists on replacing the partial 

derivatives by divided differences or combinations of point values of the function in a finite 

number of discrete nodes of the regular mesh (Moczo et al. 2004).  

Considering , , ,  a function in space and time. The approximation of the derivative, 

according to Taylor series of order one, is  

 � , , , /� ≈ [ + Δ , , , − , , , ]/Δ +  � Δ  (1-26) 

Where � Δ  is the error due to the approximation.  

The FDM has been employed in SEISMOSOIL http://asimaki.caltech.edu/resources/index. 

html#software) for analysis and signal processing of 1-D site-specific response problems, by 

Li and Assimaki (2010) using a modified hyperbolic soil model, in NOAH (Bonilla 2001), for 

wave propagation in saturated soil subjected to vertically incident ground motion and by Moczo 

et al. (2004) in an adjusted finite difference approximation.  

The advantages that present this method are the simplicity of modeling and its low cost in 

computer memory. However, this method presents as inconvenient the limitation in 

representing a complex geometry as heterogeneity and topography. The regularity of the mesh, 

http://asimaki.caltech.edu/resources/index.%20html#software
http://asimaki.caltech.edu/resources/index.%20html#software
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forces a meshing relative to the minimum shear wave velocity and causes difficulty to consider 

complex topography and structures, requiring a small meshing and, consequently, an important 

computational time and memory. 

1.2.2 Finite element method  

The FEM is the most used for engineering applications. It consists of approaching, in a finite-

dimensional subspace, a problem written in variational form (as minimization of energy in 

general) in an infinite dimensional space. In this case, the approximate solution is a function 

determined by a finite number of parameters (Hughes 1987).  

Let us consider the following differential equation 

 {− ′′ =   ,    ∈ ] , [= =                (1-27) 

to transform this differential system to variational form, the Galerkin method proposes a 

function ∈ � = {� [ , ]  such that = = } and Eq. (1-27) is written  

 −∫ ′′ = ∫  (1-28) 

Integrating by part we obtain  

 −∫ ′ ′ = ∫      ∀ ∈ � (1-29) 

The problem is, hence, brought to solve the variational Eq. (1-29) approximating the problem 

in a sub-space �̃ of finite dimension N posing ̃ =  ∑ ��= ∈  �̃ , where �  are 

shape functions linearly independent in �. 

The FEM has been widely employed, as example, Abaqus CAE 

(https://www.3ds.com/products-services/simulia/products/abaqus/), ASTER code 

(http://www.code aster.org), CESAR (www.cesar-lcpc.com) and OpenSees 

(http://opensees.berkeley.edu/), are softwares used for modeling, analyzing and visualization 

of results. 

SWAP_3C is a code for three-component seismic wave propagation, that uses line quadratic 

finite elements (Santisi d’Avila and Lenti 2012), verified and validated during the PRENOLIN 

https://www.3ds.com/products-services/simulia/products/abaqus/
http://www.cesar-lcpc.com/
http://opensees.berkeley.edu/
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benchmark. The same 1D-3C wave propagation model is used for SSI analysis, by assembling 

the 1-D soil profile with a 3-D frame structure (Santisi d’Avila and Lopez-Caballero 2018). 

The advantages of this method are the ability to model complex geometry as heterogeneity and 

topography, the feasibility to use adaptive mesh and the numerous available theories on the 

convergence of this method. The inconvenient is the expensive cost in computational time and 

memory. 

1.2.3 Spectral element method  

The SEM was initially used for fluid mechanics (Patera 1984). It derives from the FEM using 

polynomial functions (�  of high degree of type Chebyshev (Priolo et al. 1994) or 

Legendre (Komatitsch and Vilotte 1998).  

The SEM is used in EFISPEC1D (http://efispec.free.fr/) software that solves 1-D wave 

propagation equations and by Mercerat et al. (2006). 

The advantage of SEM is the accuracy in the convergence. The inconvenients are the loss of 

adaptive mesh (loss in geometry flexibility), comparing to FEM method, and the expensive 

cost in computational time and memory. 

1.2.4 Boundary element method 

When the domain of interest extends to infinity, the BEM represents a powerful alternative to 

FEM. It is founded on the boundary integral equation theory that describes the problem by 

equations with known and unknown boundary states. The discretization only concerns the 

surface rather than the volume, and reduces the dimension of the problem by one (Bonnet 1999; 

Hall 1994; Kythe 1995).  

The BEM is mostly used for fracture or contact problems but it is also used in seismology to 

evaluate the topography effect and the wave propagation in alluvial basin (Bouchon and 

Sánchez-Sesma 2007; Mogi and Kawakami 2007; Semblat et al. 2002). 

The BEM is especially advantageous in the case of problems with infinite or semi-infinite 

domains, it requires less computation time and memory when it provides more accurate 

solution at the interior nodes of the domain. Unfortunately, it presents some disadvantages as 

it is uncommon for engineering problems. Moreover, the boundary integral equations, 

requiring an explicit solution, available only for linear problems. Problems with nonlinearities 

are not accessible by BEM in its standard formulation. In addition, the BEM represents some 

http://efispec.free.fr/
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mathematical complications to choose the accurate boundary integral equations, a lot of 

mathematical analysis need to be performed. The inconvenient is also in terms of loss in 

geometry flexibility, BEM is not applicable for frame structures in 3-D analyses because of the 

large surface to volume ratio, this causes erroneous in the solution. 

1.3 Site effect 

The geological characterization and topography nature of the soil affect significantly the 

registered signal at the free surface soil, caused by ground shaking with respect to the bedrock 

motion. The seismic site response has shown amplification of the seismic motion, comparing 

to that latter registered at bedrock surface, and this is due to seismic waves propagating in 

multilayered soft soil with different impedance contrast between layers (Bard et al. 1988; Bard 

and Bouchon 1985; Kawase and Aki 1989).These site effects are observed in many 

earthquakes: San Fernando, California February 9, 1971 (Hanks 1975), Mexico, Mexico City 

valley September 19, 1985 (Singh et al. 1988), Venezuela, Caracas valley July 29, 1967 

(Papageorgiou and Kim 1991) etc.  

1.3.1. Impact of soil characterization  

In seismic site response, the shear wave velocity in the medium � is a key parameter for soil 

characterization. The average shear velocity of the top 30 m layers, �  is adopted as 

parameter to define the ground type in building codes. The soil stratigraphy influences the soil 

seismic response. In fact, when the seismic waves propagate across the layers, with different 

impedance contrast, some amplifications can be observed in the soil response.  

As depicted in  Figure 1-4, amplification in accelerographs of the May 13, 1995 earthquake 

(Ms 6.6, distance 130 km), is obtained at alluvial deposit surfaces in comparison with the 

reference borehole station (PRO).  

The largest amplification is registered at the station TST, it represents the deepest deposit of 

sediments in the Mygdonian basin (197 m deep). The shown stations are part of 

EUROSEISTEST a European experimental site instrumented with a network of 21 high-

resolution permanent accelerometers located in Mygdonia valley, epicenter area of the 1978 

Stivos (Thessaloniki) earthquake Ms 6.5 (http://euroseisdb.civil.auth.gr).  



1.3 Site effect 

50 

 

 

Figure 1-4 Time histories of the May 13, 1995 earthquake (Ms 6.6, distance 130 km) recorded 
on north-south components of stations of the EUROSEISTEST network. 
(http://euroseisdb.civil.auth.gr) 

Studies have shown that the geometry and material properties of the sedimentary basin govern 

the seismic amplification, for this reason it is very important to consider a correct 

characterization and modeling. Figure 1-5 shows the complete model gives amplification in the 

amplitude/frequency compared to the simplified model (Manakou et al. 2010; Pitilakis et al. 

1999; Raptakis et al. 2000; Semblat et al. 2005). Moreover, in wave propagation modeling, the 

definition of the sediment-bedrock interface is mandatory.  

 
                                (a)                                                                  (b) 
Figure 1-5 (a) Geotechnical model of the Mygdonia basin: complete model (top) and simplified 
model (bottom), (b) Amplification/frequency curves for various locations along the basin 
surface for simplified (continuous) and complete models (dashed). (Semblat et al. 2005) 
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1.3.2. Impact of the soil constitutive model 

Besides the description of the geometry and the elastic parameters of sedimentary layers, the 

soil behavior is responsible for observed variabilities on site response (Chin and Aki 1991; 

Field et al. 1997). These variabilities have been mostly the result of a strong shaking. The 

spectral analysis of accelerograms show a shift in frequency peaks to lower frequency. Hence, 

to characterize the nonlinear soil behavior the simplest way is to compare the transfer function 

of the same site subjected to weak and strong ground motion. Figure 1-6 shows the evolution 

of the borehole site response with the PGA at the downhole sensor at site IWTH23 from 

earthquake recordings of the KiK-net database Japan (Régnier et al. 2013). It is noted a clear 

change in site response with respect to the PGA of the incoming motion, this is explained by 

the nonlinear constitution of the soil. The impact of nonlinear behavior of soils in site effects 

has been quantified (Castro-Cruz et al. 2017; Field et al. 1997; Kwok et al. 2008; Régnier et al. 

2017).  

 

Figure 1-6 Reduction of the borehole site responses at IWTH23 with respect to the input-
motion PGA (cm/s²). (Régnier et al. 2013)  

Soil nonlinear behavior is manifested in the increase in damping and decrease in shear wave 

velocity, with the strengthening of the applied ground motion. Evidence of soil nonlinear 

behavior have been observed since a long time: we may cite data from Port Island in Kobe 

Japan, during the Hyogo-Ken Nanbu earthquake 1995 (Kawase et al. 1996), from California 

during the Loma Pietra earthquake 1985 (Chin and Aki 1991), from Mexico during Michoacan 

earthquake 1985 (Singh et al. 1988), from earthquake events in Japan (seismological data 

recorded in Kiban Kyoshin Network (Kik-net www.kyoshin.bosai.go.jp) and other events 

around the world (Beresnev and Wen 1996). 
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Modeling the hysteretic behavior in soil, imply to characterize the nonlinear stress-strain 

relationship for different strain levels (Hardin and Drnevich 1972a; b). Numerous constitutive 

equations for the nonlinear behavior of soil have been developed. During the benchmark 

PRENOLIN (Régnier et al. 2016) on numerical simulation for 1-D nonlinear site response, the 

following nonlinear constitutive relationships are compared: extended hyperbolic model 

(Phillips and Hashash 2009), Iai’s model (Iai and Ozutsumi 2011), isotropic hardening elasto-

plastic soil model (Schanz et al. 1999), Iwan’s model (Iwan 1967), Manzari-Dafalias model 

(Dafalias and Manzari 2004), modified Hujeux model (Aubry et al. 1982), multiyield model 

(Elgamal et al. 2003), Pisanò 3d elastic-plastic model  (Pisanò and Jeremić 2014) and others. 

These models demand an increase of the number of parameters to reproduce better the soil 

response in higher level of loading. As the soil parameters can be difficult to determine, an 

efficient soil constitutive model is the one that is reliable and needs few parameters to be 

characterized.  

1.4 Soil structure interaction 

The seismic response of a structure depends on the incident shake and the wave propagation in 

the soil to the ground level and in the structure itself. The excitation of the structure radiates 

waves back to the soil. This phenomenon is the soil-structure interaction (SSI).  

According to the European seismic design codes (CEN 2003) the motion at free-field (FF, site 

prior handling) is currently used as seismic loading at the bottom of a fixed-base (FB) building, 

for structural design of buildings with shallow foundation. This two-step analysis (Figure 1-7), 

as named by Saez et al. (2011), does not permit to numerically simulate the soil-structure 

interaction (SSI) that modifies the seismic demand (seismic motion amplitude for structural 

design), influenced by structural dynamic features, soil mechanical parameters and input 

motion characteristics.  
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Figure 1-7 Two-step analyses; step one (left) Free Field analyses and step two (right) Fixed 
Base analyses. 

1.4.1. Observations on existing building and prototype experiments  

The observations of a wave radiated back from a vibrating structure into the soil has been 

studied using earthquake records, ambient noise, shaking table and other alternative sources of 

dynamic excitation. An interesting early history on SSI is present in the work of Kausel (2010). 

Jennings (1970) observed, using vibration tests, large dynamic forces induced in the ground by 

the nine-story Millikan library building comparing surface ground records at about .  km from the building with seismo-graph records on Mt. Wilson at  m of altitude and 

about .  km from the same building. Rocking motion up to 50% of the transverse motion 

registered at the top of a building is observed by Bard (1988), from California strong motion 

instrumentation program on strong motion data corresponding to buildings. In 1992, Celebi 

and Safak studied the recorded seismic response of the Pacific Park Plaza building in 

Emeryville, California during the Loma Prieta earthquake of October 17, 1989 (Ms = 7.1), 

They noticed the largest SSI effect in the case where the soil is in resonance, the fundamental 

frequency of a building is in the same range of that of its relative soil (Celebi and Safak 1992; 

Safak and Celebi 1992). Chavez-Garcia and Cardenas (2002) investigate the SSI contribution 

on the ground motion in the Lake area of Mexico City using single and array measurements of 

ambient vibration. In this city, the structures are founded on soft soil and the frequency of the 

buildings coincide with that of the soil, both representing major factors in the SSI phenomenon, 

significantly altering the FF motion.  Other studies also observed important impact of the soil-
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structure resonance effects on SSI Ivanović et al. (2000) in Van Nuys California, Cornou et al. 

(2004) in Grenoble basin France and Ditommaso et al. (2010) in Potsdam Germany).  

Mucciarelli et al. (2003) concluded that the SSI can significantly extend the motion duration 

and concentrate the amplification of response in a limited range of frequencies. Gueguen 

and Bard (2005) found out, during the Volvi test conducted on a scaled building, an asymmetric 

behavior of the reinforced concrete (RC) building regarding SSI and a reduction in the 

fundamental frequency of the building compared to the fundamental frequency of the system 

building-soil. 

Exploring numerical simulation of series of shaking table tests, Paolucci et al. (2008) discussed  

evidence on the importance of nonlinear-inelastic foundation response to improve numerical 

SSI analysis results. Other experimental findings based on shaking table tests (Figure 1-8) have 

reported SSI evidence  (Chau et al. 2009; Gallipoli et al. 2004; Hung et al. 2008; Lu et al. 2004; 

Maugeri et al. 2000; Shirato et al. 2008).  

 

Figure 1-8 Photograph of a prototype model for the shaking table test. (Lu et al. 2004) 

1.4.2. Analytical study 

A theory about vibration foundation is proposed in 1936 (Reissner 1936). According to 

Veletsos and Meek (1974),  inertial interaction effects for buildings induce a lengthening of 

the natural period of the soil-structure system, because the structure is more flexible compared 

with the corresponding FB structure, and an increase of soil-structure system damping, due to 

dissipated energy and to radiated waves from the structure back into the soil. Wolf (1985) 

proposes the direct approach for SSI analyses that solves the dynamic equilibrium equation of 
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the soil-structure assembly, distinguishing the case of a FF motion applied to a FB model. 

Gazetas (1991) proposed the substructure approach SSI, analyzed as two separate interacting 

subdomains coupled through the concept of dynamic impedance functions, or two-step analysis 

as named by Saez et al. (2011) and shown Figure 1-7. Chopra and Gutierrez (1974), using an 

analytical simplified method, discuss SSI in the case of tall buildings, with reduced frequency 

of vibration, in very soft soil where the interaction has important effects on structural response. 

The dynamic response at the top of the building show a reduced frequency compared with the 

first FB mode shape. Using simplified numerical models, Jennings and Bielak (1973) show 

that the effect of SSI on the seismic response of buildings occurs predominantly in the direction 

of the fundamental mode shape. Moreover, the effects of interaction may be negligible for 

higher modes in the case of tall buildings having a translational first mode shape (of the FB 

structure). According to (Stewart et al. 1999a), two mechanisms of interaction take place 

between the structure, its foundation and soil: inertial and kinematic interaction. Inertia 

developed in the structure due to its own vibrations causes changes in seismic waves at the 

base of the structure, compared with the free FF that is the site prior handling. Furthermore, 

the presence of a deep foundation modifies seismic waves in the soil due to the stiffness contrast 

between soil and foundation. (Stewart et al. 1999b) studied the aptitude to SSI effects of 57 

buildings in California, using an analytical approach, and observed that SSI is directly 

proportional to the structure to soil stiffness ratio. 

1.4.3. Numerical study  

Numerical methods are largely developed for SSI problems. The FEM is a common computing 

method in civil engineering, and extensively used for the SSI problems. To model the seismic 

propagation in 2-D and 3-D soil domain, a large domain of soil is requested to reproduce the 

condition of hindered horizontal strain. In FEM this represents an important computation time 

and internal memory consumption. Thus, various boundary conditions to limit the soil domain 

has been proposed. In 1969 Lysmer and Kuhlemeyer (1969) suggest viscous boundary 

considering only elastic systems. In 1974, nonreflecting place boundary, allowing Dirichlet 

and Neumann conditions to alternate components at the boundary, is proposed by Smith (1974). 

In the following years other solutions have been proposed:  in 1977, paraxial boundary by 

Clayton and Engquist (1977), in 1988, absorbing boundary condition by Barry et al. (1988) and 

in 1989 tied boundaries, reducing significantly the modeled soil domain, by Zienkiewicz et al. 
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(1989). Various extensions of these methods have been and still are being developed (Bielak 

et al. 2003; Nielsen 2006, 2014; Yoshimura et al. 2003).  

1.4.3.1. Simplified models for SSI analysis 

Using simplified numerical models (SDOF and MDOF models), Jennings and Bielak (1973) 

show that the effect of SSI on the seismic response of buildings occurs predominantly in the 

direction of the fundamental mode shape. Moreover, the effects of interaction may be 

negligible for higher modes in the case of tall buildings having a translational first mode shape 

(of the FB structure). According to Mylonakis and Gazetas (2000), the increase in fundamental 

period of a structure due to SSI does not necessarily lead to a smaller structural response and 

considering SSI as always beneficial is an oversimplification which may lead to unsafe 

structural design.  

The application of a 1-D soil model is more suitable for engineering practice due to the 

accessible geotechnical characterization by using a single borehole investigation. The 1-D 

modeling of soil significantly reduces time and memory consumption and benefits simple 

boundary condition definition. Santisi d’Avila and Lopez-Caballero (2018) propose a one-

directional three-component (1D-3C) wave propagation approach SFRINT_3C for SSI 

problems, considering a 3-D frame structure rigidly connected to a 1-D soil profile. This latter 

solves the dynamic equilibrium equation using the direct method for the assembly of soil-

building, using three-node line finite element (FE) for soil and Timoshenko beam elements for 

the frame structure. 

1.4.3.2. Two-dimensional and three-dimensional models for SSI analysis 

Two-dimensional model, have served in solving the SSI models in several studies 

(Gandomzadeh 2011; Saez et al. 2008). According to (Saez et al. 2011) SSI effects exist when 

the seismic response obtained by solving the dynamic equilibrium problem, applied to the 

assembly of soil domain and frame structure (one-step analysis Figure 1-9), is strongly different 

from that obtained by imposing the FF motion at the base of the FB structure (two-step analysis 

Figure 1-7).  In a later study Saez et al. (2013) studied SSI in terms of total and effective stresses 

and conclude that SSI is generally beneficial or negligible for saturated soil condition. 

Furthermore, Lopez-Caballero and Modaressi-Farahmand-Razavi (2013) show that SSI effect 

increases with the building to soil fundamental frequency ratio.  
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Three-dimensional (3-D) wave propagation models have been proposed to obtain the six 

components of motion in soil and structure (such as the nuclear regulatory commission code 

for earthquake soil structure interaction, NRC ESSI simulator), by Coleman et al. (2013) and 

Jeremic et al. (2011), where the dynamic equilibrium problem is solved directly for the 

assembly of structure and a 3-D soil domain, incorporating the nonlinear behavior of soil in 

terms of effective stresses. This allows taking into account the propagation of body and surface 

waves and, at the same time, the spatial variability of the stratigraphy, rocking effect and the 

interaction with the foundation. Some other studies on SSI considering 3-D model are proposed 

(Iida 1998; Jeremic et al. 2009; Karapetrou et al. 2015; Mazzieri et al. 2013). Despite the 

evolution of 3-D numerical models, major uncertainties concerning the geotechnical model, 

difficulties related with the absorbing condition at the lateral boundaries, added to the high 

computational cost of an extended 3-D mesh make this kind of approach unusable for ordinary 

building design. 

 

Figure 1-9 One-step analysis for SSI problems. 

1.4.3.3. Large-scale model for SSI analysis 

The Large-Scale model is characterized by advantageous full-scale modelling, accurate 

calibration of soil properties and application of realistic time histories of horizontal force and 

overturning moment. On the other hand, large-scale model analysis ignores soil inertia forces, 
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and repetition of these analysis involve the treatment of a large amount of soil material. This 

model was employed by Shirato et al. (2008) for SSI problems and Gatti et al. for FF analysis. 

1.5 Structure-soil-structure interaction 

Investigation on SSI has shown evident interference of the structure response to seismic motion 

with the response of the constructed soil. When the construction is extended to more than one 

structure, the adjacent structure is affected by the interference through the soil. This cross-

interaction between neighbor structures and the soil, due to earthquake shaking, is called 

structure-soil-structure interaction (SSSI).  

1.5.1. Analytical study 

In 1971, Warburton et al. (1971) proposed a theory for the response of  two geometrically 

identical masses of circular bases attached to a half-space and subjected to a harmonic 

excitation. In another paper, Warburton et al. (1972) have found, through an analytical study, 

that the unexcited mass affects only slightly the response of the excited mass. On the other 

hand, the unexcited mass is largely influenced by the excited mass even for significant inter-

distance. When the adjacent mass has no more influence (increasing inter-distance), the SSI 

becomes more considerable with decreasing frequency of the soil.  

SSSI investigations to understand the effect of a nearby building are undertaken by Luco and 

Contesse (1973), using a 2-D analytical model. The effects of the presence of a second structure 

are more important for a smaller structure located close to a larger structure, inducing a base 

motion for the smaller structure significantly different from that obtained by ignoring the 

presence of the nearby larger structure. According to Vicencio and Alexander (2018) SSSI 

effects increase when considering loose soil and closely spaced buildings. The most adverse 

effects, on building displacement, occur when there is a big difference of height between the 

buildings. Moreover, including the presence of nonlinearity in the soil can increase the size of 

adverse/beneficial SSSI effects, so it should not be neglected. The nonlinear SSSI response 

acceleration is amplified for the case of a smaller building flanked by a taller building; a 

beneficial effect can arrive for the taller building, but this reduction is not assured for the entire 

range of aspect ratios. Exploiting SSSI, a vibration barrier (ViBa) behaving as an oscillator is 

proposed by Cacciola et al. (2015) The ViBa is able to reduce the seismic energy on its 

neighborhood structures and their seismic response.  An interesting complete review is present 

in the work of Lou et al. (2011) 
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1.5.2. Experimental study 

In natural sciences, observations and experimental testing are principles of the scientific 

methods. Mizuno (1980)  has experimentally observed the SSSI with the consequent variation 

and possible increase of the structural response caused by the radiation waves from a nearby 

structure. Moreover, the excitation of a nearby structure induces energy absorption from the 

ground. Under ambient vibration, the response of the building having low fundamental 

frequency becomes larger than that of a single building, while the response of the building 

having high natural frequency has an opposite tendency. 

The experiments to study SSSI are challenging in the real scale. Prototype experiments are 

proposed with a scaling theory to justify the parameters of the experiment. Li et al. (2012)  

proposed a model scaled to the ⁄  (Figure 1-10) and show damages are more important in 

a SSSI comparing with that of SSI.  Trombetta et al. (2014) investigate the SSSI by centrifuge 

tests. During high-intensity motions, the significance of SSSI is found to diminish; this could 

be due to a combination of superstructure yielding and saturation of footing forces. 

Consequently, from a design perspective, the results suggest that SSSI effects should be 

considered for low-to-moderate levels of earthquake shaking. 

 

Figure 1-10 Prototype of a shaking table model scaled to the ⁄ , SSI test model (left) and 
SSSI test model (right). (Li et al. 2012) 

A related problem to SSSI is addressed considering more than two adjacent structures known 

as the site city interaction (SCI). Aldaikh et al. (2015 and 2016) experimented shaking table 

tests on a group of three building subjected to seismic excitation Figure 1-11 and showed that 

two adjacent buildings have a greater influence on a central building than this latter having 

only one adjacent building. Schwan et al. (2016) also studied site-city effect, experimenting 

shake table tests consisting on a site-city setup with up to 37 anisotropic resonant structures,  

and show that SSSI have significant effect of the seismic responses of the site and the buildings 
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adding that the denser the city the greater the effect.Tombari et al. (2018) performed shaking 

table tests using buildings in single story structures including ViBa buried in the soil, 

represented by viscoelastic silicone rubber, (Figure 1-12) and show reduction up to 46.2% of 

the maximum acceleration registered in both structure due to the existing of a third structure, 

ViBa, properly tuned to absorb dynamic energy.  

 

 

Figure 1-11 Overview of experiment: (a) single building; (b) two identical buildings; (c) three 
identical buildings; (d) experimental system mounted on the shaking table. (Aldaikh et al. 
2016) 

 

Figure 1-12 (a) Prototype and (b) Finite Element Model of two different structures protected 
by the ViBa. (Tombari et al. 2018) 

1.5.3. Numerical study 

Even if the FEM is efficient and very common in civil engineering, dealing with irregular 

geometry and material nonlinearity, the computation time and memory are serious for a large 

scale of soil. On the other hand, the BEM present advantages on the FEM because it demands 

a unique surface discretization without the need of a boundary condition definition as the FEM. 

The BEM present difficulties in complicated heterogenous medium and loses its advantage in 
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non-linear systems. In the 1990s a coupled BEM and FEM consisting on meshing only the 

structure while the soil is presented as elastic medium model using BEM (von Estorff and 

Firuziaan 2000; Mohammadi and Karabalis 1995; Yazdchi et al. 1999). The BE-FE method 

reduces the mesh size and allow to represent modal or hysteretic damping but remains limited 

to linear studies. 

1.5.3.1. Finite element method for SSSI analyis 

Various study has aborted the SSSI using FEM (Lin et al. 1987; Matthees and Magiera 1982). 

Bolisetti and Whittaker (2011) and Roy et al. (2015) investigating the SSSI effect for nuclear 

structures. Cacciola et al. (2017) employed FE approach assuming linear behavior for the soil 

and structures and studied the impact of  a vibration barrier on an existing masonry structure. 

Nateghi A and Rezaei Tabrizi (2013) use a two-dimensional FE model to study the nonlinear 

dynamic response of two adjacent tall buildings having frame structure. In the cases wherein 

the soil and structure fundamental frequencies are near to each other, the interaction of the 

adjacent structures has an important effect on the increase of nonlinear responses, so it is not 

negligible. Varone et al. (2015) modeled the Vallerano valley located in Rome Italy in 2-D 

using the FE code CESAR-LCPC and highlighted the influence of the buildings in the local 

seismic response. Wang et al. (2013) draw attention to the interaction that touches ground and 

underground structure through the surrounding soil and model using the commercial software 

ANSYS an underground station with a nearby pile founded structure on a viscoelastic soil 

subjected to incident S wave. The obtained results show that the most important influence is 

due to the arrangement of the structures and the direction of the shaking.  

1.5.3.2. Boundary element method for SSSI analysis 

When it comes to site-city interaction the BEM is privileged. Semblat et al. (2000, 2004, 2008) 

proposed a 2-D model of Nice basin and studied the influence of  various surface structures 

and densities of the city on seismic wave propagation. Schwan et al. (2016) studied a 2D 

numerical model considering up to 37 anisotropic resonant structures on elastic soil and 

concluded that site-city effect depends strongly on the city density and arrangement and 

detrimental effect is mostly observed on the city boundaries. 
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1.5.3.3. Coupled finite element and boundary element method for SSSI model 

Padrón et al. (2009) addressed the effect of SSSI on nearby buildings subjected to incident S 

or Rayleigh waves and has shown that nearby buildings can significantly increase the seismic 

response of structure. A parametric investigation is carried by Clouteau et al. (2012) 

investigating the effect of two adjacent buildings. They show that slight influence is due to the 

SSSI in the case of shallow foundation, however, this influence is more pronounced in the case 

of embedded foundation. On the other hand, Álamo et al. (2015) studied the SSSI effects on 

the dynamic response of three nearby buildings subjected to obliquely incident waves and 

observed impact caused by the angle of the incident wave on SSSI but not necessarily worse 

than the vertical incidence wave.  

1.6 Conclusion 

The research presented in the following chapters aims to propose an efficient model for 

engineering practice, taking into account SSI. Consequently, the direct solution of the dynamic 

equilibrium equation is solved in a FE scheme. Moreover, a step by step solution is necessary 

to take into account the nonlinear behavior of materials. Periodic lateral boundary conditions 

are adopted to strongly reduce the soil domain when the periodicity assumption is possible. 
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Chapter 2 - One-dimensional three-component wave propagation 
model for soil-structure interaction 

 

 

 

 

European seismic design provisions consider, as seismic loading at the bottom of a FB building, 

a peak acceleration at the soil surface or a FF motion for structural design of buildings with 

shallow foundation. This two-step analysis, as named by Saez et al. (2011), does not permit to 

numerically simulate the SSI that modifies the seismic demand (seismic motion amplitude for 

structural design), influenced by structural dynamic features, soil mechanical parameters and 

input motion characteristics. Therefore, a numerical model accessible to engineers, that treats 

the SSI for buildings with shallow foundation, is proposed and discussed in this chapter. 

The commands to create such a model in Abaqus software are presented in Appendix B. 
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2.1. 1D-3C wave propagation model 

A 1-D soil profile is assembled with a 3-D frame structure in a FE scheme to treat the SSI 

problem (Figure 2-1a). A 1D-3C wave propagates in the soil domain from the bedrock until 

the building base. This model is based on the hypothesis of rigid shallow foundation, negligible 

rocking effects and negligible SSSI (it only permits the modeling of one structure). The discrete 

dynamic equilibrium equation for the assembly soil-structure is solved directly in a one-step 

analysis, as named by Saez et al. (2011). 

 

                           (a)                            (b)                                            (c) 

Figure 2-1 Assembly of a frame structure and a multilayer soil domain shaken by a three-
component seismic motion, for SSI analysis: (a) 1D-3C wave propagation model, where the 
assembly is done in only one node; (b) 3D-3C wave propagation model, with connection node-
to-node between building and soil; (c) 3D-3C model, where the foundation is modeled and 
embedded in the soil domain. 

2.1.1. Spatial discretization of soil domain and boundary conditions 

The soil basin is assumed as horizontally layered and infinitely extended along the horizontal 

directions  and , in the -coordinate system (Figure 2-1a). Consequently, no strain 

variation is considered in these directions. A periodic condition is applied at the lateral 

boundaries in the soil column, to impose zero stains  and . According to Zienkiewicz et al. 

(1989) and Saez et al. (2011), this condition is verified because the lateral limits of the problem 

are considered to be far enough from the structure and it is obtained using tie constraints 

between lateral surfaces. Shear and pressure waves propagate vertically in -direction from the 

top of the underlying elastic bedrock to the free surface. The soil is assumed to be a continuous 

and homogeneous medium, with nonlinear constitutive behavior. The hypothesis of vertical 
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propagation in a horizontally layered soil allows the 1-D spatial discretization of the soil 

domain. The soil column is modeled using 20-node solid FE, having three translational degrees 

of freedom per node Figure 2-2. The system of horizontal soil layers is bounded at the top by 

the free surface. Consequently, stresses normal to the free surface are assumed null.  

 

Figure 2-2 Unit area quadratic solid FE with 20 nodes, where ℎ   is the element height. 

The minimum number of quadratic solid elements (Figure 2-2) per layer is defined as ℎ / , where ℎ  is the thickness of the i-th layer and  is the shear wave velocity in 

the medium, this latter related to the minimum wavelength of the seismic signal by the ratio / . The maximum frequency, above which the spectral content of the input signal can be 

considered negligible, is fixed as =  . The minimum number of nodes per wavelength, 

to accurately represent the seismic signal, is assumed as the maximum between = /   

(almost one element every meter) and = . This criterium is adopted for the spatial 

discretization of soil domain in all the presented analyses of this research. Consequently, it will 

not be repeated in following chapters. 

The soil column is bounded at the bottom by a semi-infinite bedrock having elastic behavior. 

A linear viscous dashpot is imposed at the bottom of the soil column, in each direction of 

motion, as absorbing boundary condition (as adopted by Bardet and Tobita 2001; Joyner and 

Chen 1975; Santisi d’Avila et al. 2013), to take into account the finite rigidity of the bedrock 

and allow energy to be radiated back into the underlying medium. The same absorbing 

condition can be properly adopted if borehole records are used and a high impedance contrast 

is imposed between soil and bedrock. This option guarantees a numerical damping, decreasing 
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with the assumed impedance contrast. A deconvolved rock outcropping motion is applied at 

the soil-bedrock interface and propagated along the soil profile.  

In the adopted 1-D model of the soil domain, the solid elements have unit area in the horizontal 

plan Figure 2-2, to reduce modeling difficulties and computation time. In a 1D wave 

propagation model, the area of the soil column � appears as a constant in each term of the 

equilibrium equation Eq. (2-1), i.e. in the mass , stiffness  and damping  matrices and in 

the seismic loading vector ( ). Consequently, the FF motion can be correctly obtained even if 

a unit area is adopted. This is not the case in SSI analyses where the area of the soil domain �, 

concerned by interaction effects, must be taken into account in the balance. In a commercial 

FE code, the area of the soil domain � can be considered by imposing a soil density of � and 

an elasticity modulus in compression of �, where  and  are the soil density and elasticity 

modulus in compression, respectively, to correctly define the mass and stiffness of soil part 

(see Eq. (2-1) to Eq. (2-5), where �,  and  are the increments of acceleration, velocity 

and displacement, respectively, and the coefficients of matrix  are / , /  and / . The parameters ,  and  are the bedrock density and shear and compressional 

wave velocities in the bedrock, respectively. The parameter  v ,  and  are the wave velocity 

in the bedrock, the shape functions matrix and displacement differentiation matrix, 

respectively. The superscript e denotes element).  

 � + + =  (2-1) 

 = �∫ �  dz  (2-2) 

 = �∫ �  dz  (2-3) 

 = = �[ � ] (2-4) 

 = = �[ � ] (2-5) 

The damping coefficient of dashpots imposed at each node of the soil column base is 

proportional to �  for those in the horizontal directions and �  in the vertical 

direction. � = �⁄   is the influence area of each node and  is the number of nodes at the 

soil-bedrock interface. The seismic loading is applied at the soil-bedrock interface in terms of 

force. According to the applied boundary condition, the shear and normal stresses at the soil 

column base, at the bedrock interface, are − , −  and −  respectively. The three components of the incident seismic motion at the 

bedrock level in terms of velocity  ,  and  in -, - and -direction, respectively, can 

be obtained by halving the seismic motion at the outcropping bedrock. The three terms ,  
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and  are the unknown velocities (incident and reflected motion), at the interface soil-bedrock 

interface, in -, - and -direction, respectively that are evaluated during the process. 

2.1.2. Soil constitutive relationship: Iwan’s model 

The nonlinearity of soil demands the linearization at each time step of the rate-type constitutive 

relationship. Consequently, the stress-strain relationship needs to be expressed in its 

incremental form. The adopted Iwan’s 3-D elasto-plastic model for soils (Iwan 1967; Joyner 

and Chen 1975) satisfies Masing criterion (Kramer 1996) and does not depend on the number 

of loading cycles. According to Joyner (1975),the tangent constitutive matrix is deduced from 

the actual strain level and the strain and stress values at the previous time step. The stress 

increment is evaluated at each time step. The stress level depends on the strain increment and 

strain history but not on the strain rate. Therefore, this rheological model has no viscous 

damping. The energy dissipation process is purely hysteretic and does not depend on the 

frequency. The rheological formulation is in terms of total stresses and, consequently, it is 

appropriate in undrained conditions. The plasticity model uses von Mises yield surface that 

assumes pressure-independent behavior, that means yielding is independent of the average 

pressure stress. This assumption is acceptable for soils in undrained conditions. 

The main feature of Iwan’s model is that the mechanical parameters to calibrate the rheological 

model are easily obtained from laboratory dynamic tests on soil samples. The size of the yield 

surface is imposed by the first loading curve in the uniaxial stress case. The applied constitutive 

model does not depend on the selected backbone curve. In this research, the Poisson’s ratio is 

assumed constant during the time history and, consequently, the normalized decay curve of the 

elastic modulus in compression is ⁄ ≃ ⁄ . 

2.1.2.1. Rheological model for soils in total stress analysis 

The Iwan’s constitutive model is a 3-D elasto-plastic model with kinematic hardening, 

suggested by Iwan (1967) and employed by Joyner (1975) and Joyner and Chen (1975) in a 

finite difference discretization of the soil domain. Iwan’s model is applied by Bonilla (2001) 

in a finite difference formulation, by Santisi d’Avila and Lenti (2012) and Santisi d’Avila and 

Lopez-Caballero (2018)  in a finite element scheme, with quadratic line elements having three 

nodes and three translational degrees of freedom each, and by Gandomzadeh (2011) in a 2-D 

finite element model. The same model is employed by Mercerat and Glinsky (2015) in 
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association with 1-D discontinuous Galerkin elements, by Oral (2016) using a 2-D spectral 

element mesh and in the proposed model using 3-D finite elements in Abaqus software.  

As illustrated in Figure 2-3, the 1-D version of the stress-strain given by Iwan (1967) is 

composed of a series of  linear springs of spring constant , calibrated to reproduce the stress-

strain behavior measured in the laboratory and Coulomb friction units of stress threshold � , 

arranged parallel to each other. Each friction unit remains locked until the stress on it exceeds 

its stress threshold � , then it yields and the stress on it during yielding is equal to its yielding 

stress. The first spring reproduces the elastic behavior and the friction unit is set to � = . 

Each spring has stiffness expressed by spring constant . 

 

Figure 2-3 One-dimensional series-parallel rheological model proposed by Iwan in 1967. 

In the present study, the soil behavior is assumed adequately described by a hyperbolic stress-

strain curve (Hardin and Drnevich 1972a). This assumption yields a normalized shear modulus 

decay curve, expressed as ⁄ = + |γ γ⁄ |⁄ , where γ  is a reference shear strain 

corresponding to an actual tangent shear modulus equivalent to % of the elastic shear 

modulus, in a normalized shear modulus decay curve provided by laboratory test data  

(Figure 2-4a).  

 
                                                           (a)                                                               (b)  

Figure 2-4 (a) Shear modulus decay curve and (b) shear strain time history. 

The nonlinear isotropic-kinematic hardening model is used to simulate the inelastic material 

behavior subjected to cyclic loading. The kinematic hardening model, used to simulate the 
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inelastic material behavior subjected to cyclic loading, is linearly performed at a constant 

hardening rate to approximate the hardening behavior described by Prager hardening rule. The 

plasticity model assumes associated plastic flow, allowing isotropic yielding. Therefore, as the 

material yields, the inelastic deformation rate is in the direction of the normal to the yield 

surface (the plastic deformation is volume invariant). 

From 1 to 3 dimensions, an extension of the standard incremental theory of plasticity (Fung 

1965) is introduced, and the single yield surface stress space is replaced by a family of yields 

surfaces (Iwan 1967). 

2.1.2.2. Yield surface 

In Iwan’s formulation the von Mises yielding criterion is assumed. The von Mises yield surface 

is expressed as 

 (σ − σ ) + σ − σ + (σ − σ ) + [τ + τ + τ ] = �  (2-6) 

It corresponds to a cylinder of circular base and infinite length with its axis inclined at equal 

angles to the three principal stresses. Figure 2-5 shows the distribution of the yield surfaces of 

the material behavior according to Iwan’s model. Figure 2-5 top-left shows a virgin material. 

Then, a possible loading to a point A carrying along the yield surfaces as long as the material 

has not plastified, as a result of the kinematic hardening (Figure 2-5 top-right). Now the yield 

surfaces are altered by the loading to point A. Unloaded along the same path as the initial 

loading will not lead to the initial yield surfaces distribution (Figure 2-5 bottom-left). This 

loading and unloading leads to a linear hardening behavior exhibiting what is known as 

Bauschinger effect. 

2.1.3. Elasto-plastic model in Abaqus 

The plasticity model proposed in Abaqus has, similarly to Iwan’s model, a combined kinematic 

and isotropic hardening. When the stress state reaches the yield surface, it translates, and this 

is kinematic hardening, or it grow, and this is isotropic hardening (Figure 2-6). The kinematic 

hardening causes the ratcheting effect. It is generated by accumulation of plastic strain over 

each loading cycle and is characterized by a shift of the stress-strain hysteresis loop along the 

strain axis (Figure 2-7).  

https://en.wikipedia.org/wiki/Cylinder_(geometry)
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Figure 2-5 Schematic behavior of yield surfaces of Iwan model, in plane. 

 

Figure 2-6 Yield surface transformation after kinematic hardening (left) or isotropic hardening 
(right). 

 

Figure 2-7 Ratchetting (Abaqus User Manual 2014, Figure 23.2.2–5)  

The nonlinear behavior is characterized in Abaqus software providing the uniaxial first loading 

curve in terms of axial stresses and strains, deduced by the compressive modulus reduction 

curve. If resonance column tests provide shear modulus decay curves γ⁄ , the demanded 

first loading curve is evaluated as σ = ⁄  E , where the axial stress  σ   can be 

calculated from shear stress τ γ  as σ = √  τ γ , ⁄ is the normalized decay curve of 
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elastic modulus in compression versus axial strain  that is assumed equal to γ⁄  and                            = √ γ ⁄ . 

An example of the hysteresis loops that this model produces for =  is shown in Figure 2-8. 

It illustrates the stress-strain response of a unit cube of soil, with a shear modulus decay curve 

represented in Figure 2-4a, subjected to cyclic one-component shear strain loading  

(Figure 2-4b) of increasing amplitude. Figure 2-8 has been obtained using an external Fortran 

routine (UMAT) integrated in Abaqus, corresponding to the constitutive model used in 

SWAP_3C. Nevertheless, Iwan’s model does not need to be an external ‑ortran routine in 

Abaqus, because the multi-surface plasticity model already implemented in Abaqus 

corresponds to the Iwan’s model.  

 

Figure 2-8 Hysteresis loop in a unit cube of soil obtained with the Fortran implementation of 
Iwan’s model (UMAT/SWAP_3C)  

In Abaqus software, the first loading curve is discretized using the maximum number of 

intervals, equal to 98, and the nonlinear kinematic hardening with ratchetting is modeled using 

the maximum number of backstresses =  (kinematic shift of the yield surface,  

Appendix C). The constitutive soil model in SWAP_3C, the FE code used to verify the 

proposed modeling technique, is implemented using a number of backstresses  corresponding 

to the number of intervals employed to discretize the uniaxial yield surface. Figure 2-8 shows 

hysteresis loops in the cases of 1-, 2- and 3-Component loading, obtained using the Iwan’s 

model implemented in Abaqus with = . The same curves are obtained using SWAP_3C 

with = . As discussed by Santisi d’Avila and Lenti (2012), the shear strength is reduced 

for 3C loading, compared with the uniaxial case. The first loading curve is corrected as  σ = ⁄ �   to consider the soil domain surface �, in the case of the 1-D model 

(unit-area solid elements for soil) for SSI analyses undertaken using a commercial FE code as 

Abaqus.  
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Figure 2-9 Hysteresis loops in a unit cube of soil loaded by a 1-, 2- and 3-Component strain, 
for a different number of backstresses in the kinematic hardening model. 

2.1.4. Building model 

The 3-D frame structure is modeled using Timoshenko beam elements having six degrees of 

freedom per node. The transverse shear stiffness χ � of the beam cross-section is defined using 

a shear correction factor (Kaneko 1975) equal to χ = ( + ν ) + ν⁄ . A linear 

constitutive behavior is assumed for the structure. The damping provided by non-structural 

components is taken into account according to Rayleigh approach (Chopra 2001). In fact, the 

damping submatrix related to the building is assumed as mass and stiffness proportional, using 

coefficients dependent on the first two FB natural frequencies. Live and dead loads are imposed 

on the beams in terms of mass per unit length. 

The bases of building columns are all connected by a membrane rigid link under the assumption 

of rigid shallow foundation. According to the 1-D model approach, the building is rigidly 

connected at the bottom to the soil surface, under the assumption of rigid shallow foundation 

and negligible rocking effects. Rotational degrees of freedom of nodes at the base of columns 

are blocked.  

In the 3D-3C model in Figure 2-1b, a rigid link imposed between the different column bases, 

directly assembled with the soil, implies that the same horizontal motion is transmitted at each 

building column base. Consequently, the 1D-3C wave propagation model (Figure 2-1a) and 
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the 3-D model with connection node-to-node between building and soil shown in Figure 2-1b 

are equivalent.  

The advantages of the 1D-3C approach for SSI are that modelling difficulties and computation 

time are reduced compared with a 3D-3C approach. The dynamic equilibrium equation for the 

soil-structure assembly is solved in 11 minutes using the 1D-3C model and in 14 hours using 

the 3D-3C model, for an input motion of 120 s, on the CINES cluster using 1 core and 24 

nodes. In fact, geotechnical parameters are easy to characterize for a 1-D soil model (using a 

single borehole investigation) and boundary condition definition is simple (the input signal and 

the absorbing boundary condition are given for only one element. Moreover, the mesh is 

considerably reduced Figure 2-1). 

2.1.5. Time discretization 

The discretization of seismic loading requires a time discretization to permit the problem 

solution. The implicit dynamic process is solved step-by-step by the Hilber-Hughes-Taylor 

algorithm (Hughes 1987), the so-called -method. The three parameters = − . ,  = . − = .  and γ = . − = .   guarantee an unconditionally numerical 

stability of the time integration scheme and numerical damping to reduce high frequency 

content, without having any significant effect on the meaningful, lower frequency response. 

Material damping is purely hysteretic. The dynamic equilibrium equation is directly solved 

using a time step between = −  s and the time step used for the input signal sampling. 

The building weight and gravity load are imposed as static initial condition in terms of strain 

and stress. 

2.1.6. Soil domain area concerned by the SSI 

The simulation of SSI effects requires the representation of an adequate soil volume. The soil 

depth is imposed by the position of the soil-bedrock interface, where the incident motion is 

imposed. 

The soil domain area � is selected by evaluating the building base to bedrock transfer function 

(TF) that is the ratio of Fourier spectrum of acceleration signals at the building base and soil-

bedrock interface. The frequency corresponding to the peak of this TF matches the soil column 

fundamental frequency in the FF case, when the soil domain area � is wide, and it is 

progressively lower with a decreasing soil area. The selected soil domain area is the smallest 

for which the peak of the building base to bedrock TF corresponds to a soil column fundamental 
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frequency equivalent to the FF case. In this research, a squared soil area is used, after evaluation 

of the building base to bedrock TF for both horizontal directions of motion and verification 

that the adopted dimension is convenient for both directions. 

The building top to bottom TF, that provides the FB natural frequency of the building, is not 

influenced by the variation of the soil domain area. The building top to bedrock TF gives the 

frequency of the building-soil system. All the TF are evaluated in a linear elastic regime. 

2.2. Input data 

These input data are adopted in all the presented analyses of this research. Consequently, in 

following chapters, any used data will be referred to this section. 

2.2.1. Soil data 

The stratigraphy and mechanical parameters of soil profiles used in the verification phase are 

identified in Table 2-1. Soil properties are assumed constant in each soil layer. The soil density � and the shear and compressional wave velocities in the medium  and , respectively, allow 

the computation of the elastic shear and P-wave moduli =  and = . The shear 

wave velocity of each layer is fixed in such a way that the average shear wave velocity in the 

upper 30 m, , corresponds to the assumed fundamental frequency of the soil column , 

according to = ⁄ , where  is the soil profile depth. Densities and compressional 

wave velocities are deduced according to the relationships discussed by Boore (2015). The 

Poisson’s ratio ν = ( . ⁄ − ) ( ⁄ − )⁄  is evaluated as function of the 

compressional to shear velocity ratio. The at-rest lateral earth pressure can be obtained as  � =  ν − ν⁄ . The reference shear strain is assumed equal to γ = .  ‰ . 
Table 2-1 Stratigraphy and mechanical features of the analyzed multilayered soil profiles 
having different natural frequency. 

Profile fs = 3.8 Hz  Profile fs = 2.8 Hz  Profile fs = 1.9 Hz 

Depth  vs vp  Depth  vs vp  Depth  vs vp 

(m) (kg/m3) (m/s) (m/s)  (m) (kg/m3) (m/s) (m/s)  (m) (kg/m3) (m/s) (m/s) 

0-5 1930 250 1417  0-5 1930 220 1365  0-5 1930 180 1293 

5-15 1947 340 1568  5-15 1930 260 1435  5-15 1930 200 1329 

15-30 2019 500 1815  15-30 1957 360 1601  15-30 1930 240 1400 

> 30 2100 1000 2449  > 30 2100 1000 2449  > 30 2100 1000 2449 
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2.2.1. Building data 

The two three-story buildings which floor plans are shown in Figure 2-10 are used for the 

following analyses. The choice of a limited number of spans is motivated by the fact that an 

increasing number of spans does not modify the natural frequencies associated to the first mode 

shapes, implying an increase of both mass and stiffness but a constant stiffness to mass ratio. 

Consequently, it is not useful, for the scope of the presented analysis, to increase the modeling 

and computation time. The number of stories is determined according to the desired 

fundamental frequency of the building, for the purpose of the analysis.  

 

                                           (a)                                                        (b) 

Figure 2-10 Floor plan of the two analyzed three-story buildings that have same (a) and 
different (b) inertia to horizontal motion in the two orthogonal directions x and y. The 
dimensions of the two buildings are the same; the difference is in the rectangular column 
orientation.  

The building in Figure 2-10a has the same inertia to horizontal motion in the two orthogonal 

directions  and  due to column orientation, despite the rectangular floor plan. Its first and 

second natural frequencies are equal to = .  �z. The building in Figure 2-10b has very 

different inertia to horizontal displacement in the two orthogonal directions  and , 

consequently, the first two natural frequencies are distinct. The first natural frequency is equal 

to  = .  �z and corresponds to a translational mode shape in -direction, while the second 

one is = .  �z and is related to a translational mode shape in -direction. Building 

dimensions are indicated in Figure 2-10. The interstory height is 3.2 m. The rectangular cross-

section of beams and columns are indicated in Table 2-2.  

A live and dead load of  kg/m  is distributed on beams in -direction, according to their 

influence area, as mass per unit length. Mechanical properties of concrete are the elastic 

modulus in compression =   N/m² and the Poisson’s ratio ν = .  (shear 

correction factor  χ = . ). The reinforced concrete density is =  kg/m  and the 

damping ratio is =  %. 
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Table 2-2 Dimensions of the rectangular cross-section beams and columns 

Floor Beam Column 

 cm cm 
1 30×80 30×70 
2 30×70 30×70 
3 30×60 30×60 

 

2.2.2.1. Soil area definition 

Figure 2-11 shows the building bottom to bedrock TF for the soil profile and building having 

fundamental frequency = = .  �z  (Table 2-1 and Figure 2-10a), using different soil 

areas, in the case of seismic loading having predominant frequency = .  �z (Eq. (2-7) and 

Figure 2-12).  

The selected soil area is the smallest that provides the soil column fundamental frequency 

equivalent to the FF case. The soil area � =  m ×  m is selected for the following analyses 

and a squared area is adopted, after evaluation of the building base to bedrock TF for both 

horizontal directions of motion and verification that the adopted dimension is convenient for 

both directions. 

2.2.2. Input motion 

A synthetic wavelet has been used as seismic loading in the following research, in order to use 

an input motion whose predominant frequency is close to the fundamental frequency of the 

building or the soil. A registered earthquake signal is also tested, to study the effect of a large-

band seismic loading. 

 
Figure 2-11 Building base to bedrock Transfer Function, evaluated for different soil areas, and 
free-field to bedrock Transfer Function. 
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2.2.2.1. Synthetic narrow-band  

The seismic loading at the soil-bedrock interface (Mavroeidis and Papageorgiou 2002) has the 

following expression in terms of velocity: 

 = / [ + / − ] −  (2-7) 

The motion duration is , where = /  is the time of envelope peak, the predominant 

frequency is  and =  is the number of cycles. The incident motion is obtained by 

deconvolution (halving) of rock outcrop motion. The peak acceleration on rock outcrop in 

North-South direction (NS) is imposed as = .  m/s²  and = .  m/s² in the 

cases of linear and nonlinear soil behavior, respectively (Figure 2-12). East-West (EW) and 

Up-Down (UP) components of the incident motion have amplitude equal to the 90% and 50% 

of NS component.  

 

Figure 2-12 NS component of the synthetic seismic signal at the outcropping bedrock, in terms 
of normalized acceleration â  , for the predominant frequencies q = 2.8 Hz .  

2.2.2.2. Recorded large-band seismic loading 

A recorded signal of the 6 April 2009 Mw 6.3 L’Aquila earthquake is used as input motion at 

the base of the horizontally multilayered soil, in terms of velocity, after deconvolution. The 

signal is recorded at the Antrodoco (ANT) station of the Italian strong motion network, 

localized in Lazio region (Italy), at an epicentral distance of 26.2 km. The ANT is a FF station 

in a flat surface (slope angle lower than 15°) and on a stiff soil (type A in the Eurocode 8 soil 

classification). Consequently, the record is considered as rock outcropping motion. The PGA 

is .  m/s²  in North-South (NS) direction Figure 2-13a. The ground acceleration is .  m/s² and .  m/s²  in East-West (EW) and Up-Down direction, respectively. The 

time step of recorded signals is dt = × −  s. The selected seismic signal is applied at the 

base of the horizontally multilayered soil profile in terms of velocity (Figure 2-13a). 
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The Fourier spectra, and the predominant frequency associated, of the NS, EW and UP 

components of 2009 Mw 6.3 L’Aquila earthquake recorded at ANT station are shown in  

Figure 2-13b. 

2.2.3. Signal processing of the output motion 

All numerical signals in the present analysis are filtered by a zero-phase-shift two pole 

Butterworth filter between .  and  Hz, that is a band including the most relevant frequency 

content of the building. 

 

 

Figure 2-13 Velocity time history (a) and Fourier spectrum (b) for the NS, EW and UP 
components of the 2009 Mw 6.3 L’Aquila earthquake at recorded ANT station. Dashed lines 
show the predominant frequency in NS, EW and UP directions. 

2.3. Verification of the proposed model 

The adopted 1D-3C wave propagation model is verified, for linear and nonlinear behavior of 

soil, by comparison with the FF solution obtained by SWAP_3C, the 1-D FE code proposed 

by Santisi d’Avila et al. (2013). The latter uses 3-node line elements for the spatial 

discretization of soil, where zero strains ,  and γ  are directly imposed in the strain vector. 

The 1D-3C proposed model for SSI (assembly of 1-D soil and one 3-D building) is verified by 

comparison with SFRINT_3C (Santisi d’Avila and Lopez-Caballero 2018). 

Anderson’s criteria (Anderson 2004) are employed to quantitatively estimate the reliability of 

results obtained using the proposed models, compared with reference numerical models. The 

Goodness-of-fit (Gof) is represented using grades between 0 and 10, assigned to ten parameters 

(a) 

 

 

 

(b) 
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characterizing a signal: Arias duration (C1), energy duration (C2), Arias intensity (C3), energy 

integral (C4), peak acceleration (C5), velocity (C6) and displacement (C7), response spectrum 

(C8), Fourier spectrum (C9) and cross correlation ratio (C10). Scores in the intervals 0-4, 4-6, 

6-8 and 8-10 represent poor, fair, good and excellent fit, respectively. 

2.3.1. Comparison with other codes 

The three-story building in Figure 2-10a ( = .  �z) is associated with the soil profile having = .  �z and subjected, at soil-bedrock interface, to the seismic loading with = .  �z 

(Figure 2-12). No numerical damping ( = , = .  and γ = . ) is employed for the 

verification phase of SSI model because SFRINT_3C (Santisi d’Avila and Lopez-Caballero 

2018) considers only  and γ. The scores obtained in the case of linear soil behavior are listed 

in Table 2-3 and they guarantee an excellent fit. Figure 2-14 and Figure 2-15 show the obtained 

acceleration time histories in the FF case and for SSI, respectively, at different points.  

 

       (a)                                             (b) 

Figure 2-14 Acceleration time history at the soil surface, in the case of FF solution and linear 
soil behavior, for one- (a) and three-component (b) motion. 

Table 2-3 Gof of the 1-D model in the case of linear soil behavior ( = s = q = 3.8 Hz ). 

Compared models Position Direction 
Anderson Criterion 

C1 C2 C3 C4 C5 C6 C7 C8 C9 C10 

1D-1C FF SWAP_3C soil top X 9.7 9.7 10 10 10 10 10 10 9.5 9.8 
              

1D-3C FF SWAP_3C soil top 

X 9.7 9.7 10 10 10 10 10 10 9.5 9.8 

Y 9.7 9.7 10 10 10 10 10 10 9.5 9.8 

Z 9.8 9.6 10 10 10 10 10 10 9.6 9.9 
              

1D-1C SSI SFRINT_3C bldg. base X 9.9 9.9 9.9 10 10 10 10 10 9.4 10 
              

1D-1C SSI SFRINT_3C bldg. top X 9.9 9.9 9.9 9.9 10 10 10 10 9.7 10 
              

1D-3C SSI SFRINT_3C bldg. base 

X 9.9 9.9 9.9 10 10 10 10 10 9.4 10 

Y 9.9 9.9 9.9 10 10 10 10 10 9.2 10 

Z 9.9 10 9.8 9.8 10 10 10 10 9.4 10 
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             (a)                                           (b) 

Figure 2-15 Acceleration time history at the soil surface (top) and at the building top (bottom), 
in the case of linear soil behavior, for one- (a) and three-component (b) motion. 

The scores obtained in the case of nonlinear soil behavior are listed in Table 2-4 and they 

guarantee good and excellent fit. Some differences are due to the different implementation of 

the constitutive model for soil and convergence roots. Four scores are low, and the related 

curves are plotted in Figure 2-16. Some differences are observed between  s and  s, but they 

are assumed negligible and the verification of the proposed model is assured. 

The acceleration time histories in the case of nonlinear soil are shown in Figure 2-17 and  

Figure 2-18, for the proposed model and the reference code (Santisi d’Avila and Lenti 2012; 

Santisi d’Avila and Lopez-Caballero 2018). 
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Table 2-4 Gof of 1-D model in the case of nonlinear soil behavior ( = s = q = 3.8 Hz ). 

Compared models Position Direction 
Anderson Criterion 

C1 C2 C3 C4 C5 C6 C7 C8 C9 C10 

1D-1C 
FF 

SWAP_3C soil top X 9.8 9.6 10 10 10 10 9.9 4 6.1 9.9 
              

1D-3C 
FF 

 

soil top 

X 9.4 9.6 10 10 9.8 10 9.9 7.5 6.1 9.8 

SWAP_3C Y 9.4 9.6 10 10 9.8 10 9.9 7 6 9.8 
 Z 9.8 9.9 10 10 10 10 10 10 7 9.9 

              
1D-1C 

SSI 
SFRINT_3C bldg. base X 9.6 9.4 9.9 10 10 10 9.9 2.9 6.6 9.5 

              
1D-1C 

SSI 
SFRINT_3C bldg. top X 9.7 9.7 9.8 9.8 9.9 10 9.9 9.9 8.4 9.9 

              

1D-3C 
SSI 

 

bldg. base 

X 9.7 9.7 9.8 9.8 10 10 10 10 8.6 10 

SFRINT_3C Y 9.6 9.5 9.3 9.4 9.9 9.9 9.9 9.9 7.7 10 
 Z 9.1 9.2 9.5 9.7 10 9.8 10 9.9 5.6 9.5 

              

1D-3C 
SSI 

 

bldg. top 

X 9.2 9.4 9.7 10 9 10 9.9 8.2 7.2 9.2 

SFRINT_3C Y 9.2 9.5 9.8 10 9.2 10 9.9 7.7 7 9.2 
 Z 8.9 9.2 9.7 9.9 10 9.9 10 9.8 3.8 8.7 

 

 

Figure 2-16 Parameters associated to lowest GoF scores: (top-left) Response spectrum for the 
1C motion in x-direction at the FF, (top-right) Response spectrum for the 1C motion in x-
direction at the building bottom, (bottom-left) Fourier spectrum for the 3C motion in z-direction 
at the building bottom (bottom-right) Fourier spectrum for the 3C motion in z-direction at the 
building top. 
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        (a)                                          (b) 

Figure 2-17 Acceleration time history at the soil surface, in the case of FF solution and 
nonlinear soil behavior, for one- (a) and three-component (b) motion. 

 

              (a)                                         (b) 

Figure 2-18 Acceleration time history at the building base (top) and top (bottom), in the case 
of nonlinear soil behavior, for one- (a) and three-component (b) motion. 

2.4. 1D-3C vs 3D-3C wave propagation model for vertical propagation 

Evaluation of the accuracy of the 1D-3C model, compared with the case of 3D-3C model where 

the periodicity condition is assumed, in the case of horizontally layered soil having nonlinear 

behavior is studied.  

The employed models for this analysis are shown in Figure 2-1. The 1D-3C model, the 3D-3C 

model with connection node-to-node between building and soil and the 3D-3C model with 
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reinforced concrete foundation, named SFSI that stands for Soil-Foundation-Structure 

Interaction, are shown in Figure 2-1a, b and c, respectively.  

A recorded signal of the 6 April 2009 Mw 6.3 L’Aquila earthquake (UTC 1:32) is employed 

as rock outcropping motion (Figure 2-13a). The selected seismic signal, recorded at an 

outcropping bedrock, is halved to consider the free surface effect and integrated to obtain the 

corresponding input data in terms of vertically incident velocities, before being forced at the 

base of the horizontally multilayered soil profile. 

The three-story building in Figure 2-10a (same inertia in both orthogonal directions, = .  �z) is associated with the soil profile having = .  �z. The rigid foundation, 

embedded in the soil, has the same concrete properties as the structure. It is 16 m long by 7 m 

wide and 0.5 m deep.  

The GoF criteria are listed in Table 2-5, giving excellent fit for all cases. A qualitative 

comparison of 1D-3C and 3D-3C models is shown in Figure 2-19 and  

Figure 2-20, in terms of acceleration time history at the building bottom and top. 

 

Figure 2-19 Simulated acceleration time history at the building bottom in the case of resonance  
( = s = 3.8 Hz ) during the input signal duration (top) and in a 10 s time window over the 
largest amplitudes (bottom). 
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Figure 2-20 Simulated acceleration time history at the building top in the case of resonance  
( = s = 3.8 Hz ) during the input signal duration (top) and in a 10 s time window over the 
largest amplitudes (bottom). 

 

The three-story building in Figure 2-10b (different inertia in both orthogonal directions, = .  �z) is associated with the soil profile having = .  �z. The rigid foundation, 

embedded in the soil, has the same concrete properties as the structure. It is 16 m long by 7 m 

wide and 0.5 m deep.  

The GoF criteria are listed in Table 2-6, giving excellent fit for all cases. A qualitative 

comparison of 1D-3C and 3D-3C models is shown in Figure 2-21 and Figure 2-22, in terms of 

acceleration time history at the building bottom and top. 
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Table 2-5 Gof of 1D-3C model in the case of nonlinear soil and resonance = s = 3.8 Hz . 

Compared Models Position Direction 
Anderson Criterion 

C1 C2 C3 C4 C5 C6 C7 C8 C9 C10 

1D-3C 
FF 

3D-3C   
FF 

soil top 

X 10 10 10 10 10 10 10 10 10 10 

Y 10 10 10 10 10 10 10 10 10 10 

Z 10 10 10 10 10 10 10 10 9.9 10 
              

1D-3C 
SSI 

3D-3C 
SSI 

bldg. base 

X 10 10 10 10 10 10 10 10 10 10 

Y 10 10 10 10 10 10 10 10 9.8 10 

Z 9.9 10 10 10 10 10 10 10 9.2 9.9 
              

1D-3C 
SSI 

3D-3C 
SSI 

bldg. top 

X 9.9 9.9 10 10 10 10 10 10 10 10 

Y 9.8 9.9 10 10 10 10 10 10 9.8 10 

Z 9.9 10 10 10 10 10 10 10 9.1 9.9 
              

3D-1C 
SSI 

3D-1C 
SFSI 

bldg. base 

X 9.9 10 10 10 10 10 10 10 9.9 10 

Y 10 10 10 10 10 10 10 10 9.8 10 

Z 9.8 10 10 10 10 10 10 10 8.8 9.6 
              

3D-1C 
SSI 

3D-1C 
SFSI 

bldg. top 

X 9.5 9.7 10 10 10 10 10 10 9.7 9.6 

Y 9.9 9.9 10 10 10 10 10 10 9.8 10 

Z 9.7 9.9 9.8 10 10 10 10 10 8.9 9.6 
              

1D-3C 
SSI 

3D-3C 
SFSI 

bldg. base 

X 10 10 10 10 10 10 10 10 9.9 10 

Y 10 10 10 10 10 10 10 10 9.8 10 

Z 9.8 10 10 10 10 10 10 10 8.7 9.6 
              

1D-3C 
SSI 

3D-3C 
SFSI 

bldg. top 

X 9.4 9.6 10 10 9.9 10 10 10 9.7 9.4 

Y 9.7 9.8 10 10 10 10 10 10 9.7 9.9 

Z 9.6 9.9 9.7 10 10 10 10 10 8.8 9.7 
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Table 2-6 Gof of 1D-3C model in the case of nonlinear soil and SSI = 3.8 > s = 2.8 Hz 
. 

Compared Models Position Direction 
Anderson Criterion 

C1 C2 C3 C4 C5 C6 C7 C8 C9 C10 

1D-3C 
FF 

3D-3C 
FF 

soil top 

X 10 10 10 10 10 10 10 10 9.9 10 

Y 10 10 10 10 10 10 10 10 9.9 10 

Z 9.9 10 10 10 10 10 10 10 9.8 10 
              

1D-3C 
SSI 

3D-3C 
SSI 

bldg. base 

X 10 10 10 10 10 10 10 10 9.9 10 

Y 10 10 10 10 10 10 10 10 9.6 10 

Z 9.9 10 10 10 10 10 10 10 9.2 9.8 
              

1D-3C 
SSI 

3D-3C 
SSI 

bldg. top 

X 9.9 9.9 10 10 10 10 10 10 9.9 10 

Y 9.8 9.9 10 10 10 10 10 10 9.6 9.9 

Z 9.8 10 10 10 10 10 10 10 9.2 9.8 
              

3D-3C 
SSI 

3D-3C 
SFSI 

bldg. base 

X 10 10 10 10 10 10 10 10 9.8 10 

Y 10 10 10 10 10 10 10 10 9.9 10 

Z 9.8 9.9 10 10 10 10 10 10 8.7 9.6 
              

3D-3C 
SSI 

3D-3C 
SFSI 

bldg. top 

X 9.5 9.8 9.9 9.9 10 10 10 10 9.6 9.5 

Y 9.9 10 10 10 10 10 10 10 9.6 10 

Z 9.7 9.9 9.9 10 10 10 10 10 8.8 9.6 
              

1D-3C 
SSI 

3D-3C 
SFSI 

bldg. base 

X 10 10 10 10 10 10 10 10 9.7 10 

Y 10 10 10 10 10 10 10 10 9.6 10 

Z 9.7 9.9 10 10 10 10 10 10 8.6 9.6 
              

1D-3C 
SSI 

3D-3C 
SFSI 

bldg. top 

X 9.4 9.7 9.9 9.9 10 9.9 10 10 9.5 9.3 

Y 9.7 9.9 10 10 10 10 10 10 9.3 9.8 

Z 9.6 9.9 9.9 10 10 10 10 10 8.6 9.5 

 

2.5. SSI analysis 

The proposed 1D-3C model is used to investigate SSI effects that exist, according to Saez et 

al. (2011), when the seismic response obtained by a one-step analysis (direct solution) is 

strongly different from that obtained by a two-step analysis and increases with the building to 

soil fundamental frequency ratio (Lopez Caballero and Farahmand Razavi 2008). The SSI is 

investigated in the case of resonance, when the fundamental frequency of building and soil 

column are close together hence, seismic response amplification is induced. In this analysis 

linear elastic materials are considered. 
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Figure 2-21 Simulated acceleration time history at the building bottom in the case of SSI        
( = 3.8 > s = 2.8 Hz ) during the input signal duration (top) and in a 10 s time window 
over the largest amplitudes (bottom). 

 

 

Figure 2-22 Simulated acceleration time history at the building top in the case of SSI              
( = 3.8 > s = 2.8 Hz )  during the input signal duration (top) and in a 10 s time window 
over the largest amplitudes (bottom). 
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The three-story building having fundamental frequency = .  �z (Figure 2-10a) is placed 

on two different soil profiles having natural frequency = .  �z and .  �z (see Table 2-1) 

and linear behavior. The synthetic 3C motion having peak rock outcrop acceleration  a = .  m/s² in -and -direction and halved in -direction is applied at the soil-bedrock 

interface. The narrow band input with predominant frequency = .  �z  is selected to excite 

the building. 

Results in Figure 2-23 and Figure 2-24 show the building seismic response in the cases of 

resonance ( = .  �z  and = .  �z) and SSI ( = .  �z  and = .  �z) respectively. 

The ground motion and the acceleration at the building top are amplified in Figure 2-23, due 

to the resonance effect, compared with the case in Figure 2-24. The difference between one- 

and two-step analyses, due to SSI, is more pronounced in Figure 2-23, in the direction of the 

first mode shape, and in Figure 2-24, in the direction of the second mode shape in terms of 

acceleration at the building top. The differences in the building response in the two horizontal 

directions is because the building is rectangular shaped, even if the two first natural frequencies 

associated to the two translational modes are almost equal. 

 

 

Figure 2-23 Horizontal acceleration time history in the cases of soil profile with fundamental 
frequency s = b = q = 3.8 Hz , at building bottom (top) and at building top (bottom). 
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Figure 2-24 Horizontal acceleration time history in the cases of soil profile with fundamental 
frequency s = 2.8 Hz , and b = q = 3.8 Hz , at building bottom (top) and at building top 
(bottom). 

 

2.6. Conclusion 

The proposed 1D-3C seismic wave propagation model, used to simulate the response of soil 

and building to earthquakes taking into account site effects and SSI, is verified either 

comparing with SWAP_3C code or with a 3D-3C model, for linear and nonlinear soil behavior. 

The proposed model avoids modeling problems related to the definition of boundary conditions 

and the lack of geotechnical data to produce a detailed 3-D soil model and strongly reduce the 

computational time. Consequently, it is suitable for professional practice. 

The hypothesis of rigid shallow foundation with the same seismic motion at the base of all 

columns does not permit to consider the foundation deformability and rocking effects and this 

model cannot simulate the interaction between more buildings. Therefore, the 1D-3C model is 

limited to the study of SSI with rigid shallow foundation. Hence, in the next chapter an 

improved modeling technique is introduced to simulate the seismic response of soil and 

building also the foundation deformability, rocking effects and SSSI.   
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Chapter 3 - One-directional three-component wave propagation 
in a T-shaped soil domain for SSI and SSSI  

 

 

 

 

A modeling technique is proposed to take into account SSI in building design, considering 

rocking effects and the shallow foundation deformability. The one-directional three-component 

wave propagation is numerically simulated in a T-shaped horizontally layered soil domain 

assembled with a three-dimensional (3-D) frame structure. A 3-D soil model is used until a 

fixed depth and a 1-D model is supposed to be a sufficient approximation in deeper soil layers. 

The 1D-3C wave propagation approach in a T soil model (1DT-3C) is inspired by the 

consideration that SSI is detected in the near-surface soil layers. The proposed modeling 

approach is verified by comparison with a fully 3D-3C model for vertical propagation in 

horizontally layered soil and periodic lateral boundary condition. The 1DT-3C modeling 

technique is used to investigate the building response and SSI effects that vary with the 

frequency content of seismic loading and building-to-soil frequency ratio, respectively. 

 

 

 

 

 

 

 

 

 



3.1 1DT-3C wave propagation model for SSI and SSSI analyses 

92 

 

3.1. 1DT-3C wave propagation model for SSI and SSSI analyses 

The proposed 1D-3C approach for SSI investigations, discussed in Chapter 2 -  (Figure 3-1a), 

is limited to the case of rigid shallow foundation, negligible rocking effects, horizontally 

layered soil with periodic lateral boundary condition and homogeneous properties in each layer. 

Furthermore, the numerical simulation of seismic response of a group of buildings demands a 

fully 3-D soil domain Figure 3-1b.  

 

                                        (a)                                        (b) 
Figure 3-1 Assembly of a multilayer soil domain and a frame structure shaken by a three-
component seismic motion: 1D-3C (a) and 3D-3C (b) model for SSI analysis. 

In this research, a modeling technique is proposed to take into account the foundation 

deformability, rocking effects and the cross-interaction between neighbor structures and the 

soil. It is inspired by the consideration that SSI and SSSI are detected in the near-surface soil 

layers. The soil profile is assumed as horizontally layered and infinitely extended along the 

horizontal directions  and , according to the  coordinate system represented in  Figure 

3-1. Consequently, no strain variation is considered in these directions. Shear and pressure 

waves propagate vertically in z-direction from the top of the underlying elastic bedrock to the 

soil surface. The soil is assumed to be a continuous and homogeneous medium, with nonlinear 

constitutive behavior. The discrete dynamic equilibrium equation for the assembly of soil 

domain and frame structure, including compatibility conditions, 3-D nonlinear constitutive 

relation and the imposed boundary conditions, is solved directly (one-step analysis). All the 

proposed modeling techniques, in this research, can be adopted independently of the 

constitutive relationship selected for soil and structure. 
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A fully 3-D soil model is adopted until a fixed depth h and a 1-D model is used for deeper soil 

layers Figure 3-2. Due to the T-shaped soil domain area, the proposed modeling technique is 

named as 1DT-3C approach for SSI and SSSI analyses Figure 3-3 (Appendix D). 

 

 

Figure 3-2 Section of the 1DT-3C model for SSI analysis where h is the thickness of  the 3-D 
soil domain and � is the Thickness of the considered soil until bedrock interface. 

 

                                                    (a)                                            (b) 

Figure 3-3 1DT-3C model for soil-structure interaction (a) and for structure-soil-structure (b) 
analysis. 

A constraint equation is used to condense out the degrees of freedom at the base of the 3-D soil 

domain to those at the top of the unit area soil column. The foundation is modeled using 20-

node solid FE and it is embedded in the soil domain. Consequently, the foundation 
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deformability and its rigid rotation, due to rocking effects, can be taken into account and the 

seismic motion at the base of each building column is independent. 

The periodic lateral boundary condition is maintained at the lateral boundaries all along the 

depth. The lateral boundary condition could be defined using semi-infinite elements when the 

periodicity is not assured. The proposed 1DT-3C model, compared with a fully 3D-3C model, 

reduces the modeling time because the boundary condition definition is simple, especially in 

the case of periodic lateral boundary condition, because the input motion and the absorbing 

condition are defined in only one element at the base. Moreover, a one-dimensional soil profile 

can be characterized with a single borehole investigation, instead a 3-D soil domain needs more 

investigations to define in a reliable way the geotechnical model. 

3.2. Verification of the proposed model 

The 1DT-3C wave propagation approaches is verified by comparison with the case of 3-D soil 

domain, for vertical propagation, horizontally layered soil having nonlinear behavior and 

periodic lateral boundary condition. Anderson’s criteria are employed to quantitatively 

estimate the reliability of results obtained using the proposed models, compared with the 

reference numerical model (Anderson 2004).  

3.2.1. Input data 

3.2.1.1. Soil and building data 

The soil profiles with = .  �z and = .  �z are used in the verification phase. The 

stratigraphy and mechanical parameters of are introduced in Table 2-1. The two three-story 

buildings introduced in section 2.2 are used for the following analyses. The soil area  A =  m ×  m is selected for the following analyses and a squared area is adopted, after 

evaluation of the building base to bedrock TF for both horizontal directions of motion and 

verification that the adopted dimension is convenient for both directions. 

3.2.1.2. 3-D soil thickness definition  

The depth of the fully 3-D soil domain is fixed using the results obtained using the 1D-3C wave 

propagation model in a SSI analysis and in linear elastic regime, compared with a simulation 

in FF conditions. Results of the Maximum shear strain and stress profiles with depth are shown 

in Figure 3-4. Only in the first meters the effect of SSI is not negligible. Hence, a 3-D soil 
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domain is assumed until a depth h =  m, that corresponds to the interface between the first 

and second soil layers, and a 1-D model is used in deeper soil layers. 

 

 
                                                       (a)                                          (b) 
Figure 3-4 Maximum shear strain (a) and stress (b) profile with depth obtained using de 1D-
3C wave propagation model for the SSI analysis in a linear elastic regime. 

3.2.1.3. Input motion 

The recorded signal of the 6 April 2009 Mw 6.3 L’Aquila earthquake (Chapter 2 - 2.2) is used 

as rock outcropping motion for the verification phase.  

3.2.2. Verification 

The 1DT-3C and the 3D-3C wave propagation approaches, in the case of vertical propagation 

in a horizontally layered soil for soil-foundation-structure interaction (SFSI) analysis shown in 

Figure 3-3a and Figure 3-1b respectively, are compared for the same case of building having          = .  �z (Figure 2-10a), placed on the soil profile having = .  �z and nonlinear 

behavior. GoF show excellent fit of the 1DT-3C model compared with a 3D-3C model for SFSI 

analysis, as reported in Table 3-1. The acceleration time histories at the building bottom and 

the relative displacement time history at the building top are shown in  Figure 3-5. The energy 

integral, the pseudo-acceleration response spectrum and Fourier spectrum in direction x are 

represented in Figure 3-6 to confirm the excellent fit given by the GoF scores (C4, C8 and C9, 

respectively, in Table 3-1). The correlation of the estimated acceleration in  direction is shown 
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in Figure 3-7. These comparisons with respect to the case of a 3D-3C model allow the 

verification of the 1DT-3C model, in the case of periodic lateral boundary condition and 

vertical propagation along a horizontally layered soil. Moreover, it is checked that the selected 

thickness h of the 3-D soil layer is suitable for this particular stratigraphy. 

Table 3-1 Gof of 1DT-3C model, with respect to a 3D-3C model for SSI analysis. 

      Compared    models Position Direction Anderson criteria 

    C1 C2 C3 C4 C5 C6 C7 C8 C9 C10 

 
3D-3C 
SFSI 

bldg. 
base 

X 10 10 10 10 10 10 10 10 9.5 10 

1DT-3C Y 10 10 10 10 10 10 10 10 9.3 10 

 Z 9.7 10 9.9 10 10 10 10 10 8.4 9.9 

 
3D-3C 
SFSI 

bldg. 
top 

X 9.9 9.9 10 10 10 10 10 10 9.3 10 

1DT-3C Y 9.9 10 10 10 10 10 10 10 9.0 10 

 Z 9.7 10 9.9 10 10 10 10 10 8.5 9.9 

 

 

 

Figure 3-5 Comparison of 1DT-3C and 3D-3C models for SSI analysis: acceleration time 
history at the building bottom (top) and roof drift time history at the building top (bottom). 
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Figure 3-6 Comparison of 1DT-3C and 3D-3C models for SSI analysis: energy integral (IE), 
response spectrum acceleration (Spa) and Fourier spectrum (FS) for the horizontal x-component 
of motion at the building bottom (top) and top (bottom). 

 

 

                    (a)                                                                     (b)                              

Figure 3-7 Comparison of 1DT-3C and 3D-3C models for SSI analysis: correlation coefficient 
of accelerations for the horizontal x-component of motion at the building bottom (a) and top 
(b). 
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3.3. SSI analysis 

3.3.1. Impact of the excitation frequency on the structural response 

The 1DT-3C seismic wave propagation approach for SSI analysis is used in order to understand 

the impact of the seismic motion frequency content on the response of a building over a 

horizontally layered soil. 

The building-soil system composed by a T-shaped soil profile having natural frequency  = .  �z (Table 2-1) and a building having fundamental frequency = .  �z  

(Figure 2-10a) is first shaken by the synthetic narrow-band seismic loading (section 2.2) having 

predominant frequency = = .  �z, close to the FB building frequency, and then by 

another having = = . �z, close to the soil column frequency. 

Figure 3-8 shows an amplification of the acceleration at the building bottom in the case where 

the soil frequency is excited ( = = . �z), that implies an amplification of the seismic 

loading for the building. However, the higher roof drift at the building top (Figure 3-8) is 

obtained for the case where the predominant frequency of the earthquake is close to the fixed-

base frequency of the building ( = = .  �z .  

This result signifies that the frequency content of the seismic load imposed at the bottom of the 

building is more important for the building deformation than the concept of expected maximum 

ground acceleration amplitude, derived from building design in static conditions and still used 

in design codes.  

 

Figure 3-8 Acceleration time history at the building bottom (left) and roof drift at the building 
top (right), for the building-soil system composed by a T-shaped horizontally layered soil 
having frequency s = 1.9 Hz and a building having fundamental frequency = 3.8 Hz   , in 
the case of earthquake predominant frequency equal to = s = 3.8 Hz  and 

= s = 1.9 Hz .  
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Furthermore, Figure 3-9 shows the building top to bottom TF in the cases of FB building and 

SSI analysis, using the 1DT-3C approach, for the two cases of soil profile having = = .  �z and  = .  �z > = .  �z. It can be observed a reduction of the 

building fundamental frequency due to SSI, that is I = .  �z. In this case of three-story 

building, the variation of frequency, also for softer soil ( = .  �z), is not important because 

rocking effects are reduced. It is expected that more important rocking effects would reduce 

the building frequency when SSI is considered.  

 

Figure 3-9 Building top to bottom transfer function estimated for a FB building and for SSI 
analysis in the cases of building-soil resonance ( = s = 3.8 Hz ) and softer soil                                
( = 3.8 Hz > s = 1.9 Hz ). 

3.3.2. SSI estimation 

The 1DT-3C seismic wave propagation model is used to compare the seismic response of a 

building-soil system shaken by a synthetic narrow-band seismic loading (section 2.2) having 

predominant frequency   equal to the fundamental frequency of the building, . The analysis 

is done in both cases of horizontally layered soil having natural frequency =  and < .  

The building having = .  �z (Figure 2-10a) is placed at the surface of the soil profiles 

having = .  �z and = .  �z. The seismic input signal has predominant frequency  = = .  �z.  

The acceleration time history at the building bottom and the roof drift at the building top are 

shown in Figure 3-10 for the cases of one-step analysis (building-soil system) and two-step 

analysis (FF motion at the base of a FB building).  
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                                                      (a)                                              (b)  

Figure 3-10 Acceleration time history at the building bottom and roof drift at the building top, 
for the building-soil system composed by a building having fundamental frequency

b = 3.8 Hz  and a T-shaped horizontally layered soil having frequency = b = 3.8 Hz (a) 
and = 1.9 Hz < b = 3.8 Hz (b), in the case of earthquake predominant frequency equal to 

= b = 3.8 Hz . 

Taking into account the SSI using a one-step analysis gives a reduction of structural 

deformation. This SSI effect is quantitatively measured as the one-step to two-step ratio of the 

maximum acceleration at the building top, _ / _ . It is obtained a _ /a _ = .  and a _ /a _ = . , for both - and -direction, in the cases = = = .  �z and = .  �z < = = .  �z  respectively. As expected, the 

SSI is more important in the case where the soil is softer (lower a _ /a _  ratio) in 

the case of nonlinear soil behavior. The resonance effect ( = = = .  �z  produces an 

amplified seismic response, as can be observed by comparing Figure 3-10a and Figure 3-10b. 

3.3.3. 1st vs 2nd natural frequency 

The building represented in Figure 2-10b, having natural frequencies = .  �z and  = .  �z, is placed at the surface of the soil profile having natural frequency = .  �z. 

Figure 3-11 and Figure 3-12 show the comparison between the results obtained by a one-step 
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analysis, using the 1DT-3C approach, and a two-step analysis, in terms of acceleration at the 

building bottom and the roof drift at the building top. In particular, the cases of input seismic 

loading (section 2.2) having predominant frequency equal to the first ( = = .  �z) and 

second ( = = .  �z) natural frequency of the building are shown in Figure 3-11 and  

Figure 3-12, respectively.  

The one-step to two-step ratio of the maximum acceleration at the building top, quantitatively 

estimating the SSI effect, is a _ /a _ = .  for -direction and  a _ /a _ = .  for -direction, in the case where = = .  �z and a _ /a _ = .  for -direction and a _ /a _ = .  for  

-direction, in the case where = = .  �z. SSI effect is observed for both translational 

mode shapes and, in the structure, it is more pronounced in the direction of the mode shape 

excited by the input load.  

 

Figure 3-11 Acceleration time history at the building bottom and roof drift at the building top, 
for the building-soil system composed by a building having fundamental frequencies  

b1 = 2.8 Hz  and b2 = 4.7 Hz  and a T-shaped horizontally layered soil having frequency 

s = 1.9 Hz , in the case of earthquake predominant frequency equal to = b1 = 2.8 Hz . 
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Figure 3-12 Acceleration time history at the building bottom and roof drift at the building top, 
for the building-soil system composed by a building having fundamental frequencies 

b1 = 2.8 Hz   and b2 = 4.7 Hz  and a T-shaped horizontally layered soil having frequency 

s = 1.9 Hz , in the case of earthquake predominant frequency equal to = b2 = 4.7 Hz . 

3.4. Conclusion 

The 1D-3C wave propagation is suitable for SSI analysis in the hypothesis of rigid shallow 

foundation, with the same seismic motion at the base of all columns. The latter model does not 

permit to consider the foundation deformability and rocking effects and furthermore cannot 

simulate the interaction between more buildings. 

Therefore, the T-shaped model for 1D-3C seismic wave propagation is introduced (1DT-3C). 

It is proposed as modeling technique for the simulation of the response of soil and building to 

earthquakes, taking into account site effects, the foundation deformability, rocking effects and 

structure-soil-structure interaction. A fully 3-D model is adopted until a fixed depth, where SSI 

and SSSI effects are considered to modify the ground motion, and for deeper layers a 1-D 

model is used and supposed a sufficient approximation.  

The 1DT-3C approach is verified by comparison with a fully 3-D model, in the case of vertical 

propagation in a horizontally layered soil. The proposed 1DT-3C modeling technique is an 

efficient tool for building design allowing SSI to be taken into account in an effective and easy 

way. In fact, in the case of vertical propagation and homogeneous geotechnical parameters in 

each soil layer, using unit area solid elements for deeper layers, instead of a 3-D domain, 
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represents a reduction of computational time without affecting the results. The dynamic 

equilibrium equation for the soil-structure assembly is solved in 1 hour 11 minutes using the 

1DT-3C model and in 14 hours using the 3D-3C model, for an input motion of 120 s, on the 

CINES cluster using 1 core and 24 nodes. 

The use of the 1DT-3C approach for SSI analyses shows that the frequency content of the 

seismic load imposed at the bottom of the building can be more significant for the building 

deformation than the concept of expected maximum ground acceleration amplitude, derived 

from building design in static conditions. The SSI effect is defined as difference between the 

direct solution of the dynamic equilibrium problem of the assembly of soil and building  

(one-step solution) and the FF motion applied to a FB building (two-step analysis), in terms of 

maximum acceleration ratio a _ /a _ . It appears more important in the case where 

the soil is softer, in the case of nonlinear soil behavior. The resonance between building, soil 

and earthquake frequency content produces an amplified seismic response. SSI effect is 

observed for both translational mode shapes and it is more pronounced, for the structural 

behavior, in the direction of the mode shape excited by the input load. In the next chapters, 

further studies are undertaken using the 1DT-3C wave propagation approach to understand the 

effect of SSI on the seismic building response and the effect of an adjacent building on 

structural seismic response.   



3.4 Conclusion 

104 

 

 

 
 

 
  



Chapter 4 - Response spectrum for structural design considering soil-structure interaction 

105 

 

Chapter 4 - Response spectrum for structural design considering 

soil-structure interaction 

 

 

 

 

In professional practice, the conception and design of civil engineering structures in seismic 

zones is done according to national seismic design codes to guarantee safety against 

earthquake. A good compromise between safety and cost is expected and parameters as the 

importance of the structure and the probability of seismic event occurrence during the life of a 

structure are considered. However, design norms evolve following research results and need to 

be actualized to introduce parameters not considered before. 

Concerning environmental parameters in seismic zones, the motion amplification due to site 

effects is currently taken into account in the FF motion, without including the SSI neither the 

presence of nearby structures. It is investigated the importance of these parameters and if they 

should be introduced in the definition of seismic loading for structural design. 

A parametric analysis is developed to investigate the interference of the structure response to 

seismic motion with the response of the constructed soil, considering soil profiles in the 

different ground types classified by the Eurocode 8 (CEN 2003) and multi-story multi-span RC 

buildings having frame structure, in a FE scheme suited for engineering practice. Even if 

previous studies (Jennings and Bielak, 1973; Bielak 1976; Chopra and Gutierrez 1974; Stewart 

et al., 1999b) considered the predominant effect of the first mode shape on SSI and SSSI, the 

seismic response of a building depends on several modes, especially considering the 

prescription of the Eurocode 8 (CEN 2003) where the sum of the effective modal masses for 

the modes taken into account has to amount to at least 90% of the total mass of the building. 

Consequently, the 3-D structure of each building has been modeled. The present parametric 

analyses are done in terms of total stress.  
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4.1. 1DT-3C wave propagation model 

The ground motion at the base of a frame structure and the building motion are estimated taking 

into account site effects and SSI. The 1D propagation of a three-component seismic wave in a 

T-shaped soil domain, with a building at the surface, is modeled in a FE scheme, as proposed 

by Fares et al. (2018). The modeling of a T-shaped soil domain is inspired by the consideration 

that the SSI is detected in the near-surface soil layers. A fully 3-D soil model is adopted until 

a fixed depth ℎ and a 1-D model is used for deeper soil layers.  

Shear and pressure waves propagate vertically in -direction from the top of the underlying 

elastic bedrock to the soil surface. The soil basin is assumed as horizontally layered and 

infinitely extended along the horizontal directions  and , according to the  coordinate 

system represented in Figure 4-1. Consequently, no strain variation is considered in these 

directions and, for this reason, a periodic lateral boundary condition is imposed using a tie 

constraint between lateral surfaces, under the assumption that the lateral limits of the problem 

are far enough from the structure. Continuity and homogeneity of materials is assumed for the 

structure and each soil layer. 

 

Figure 4-1 2-D section of the 1DT-3C model for SSI analysis where h is the thickness of  the     
3-D soil domain and � is the Thickness of the considered soil until bedrock interface. 

The discrete dynamic equilibrium equation is solved directly for the assembly of soil domain 

and frame structure, including compatibility conditions, 3-D constitutive relation and the 

imposed boundary conditions. A constraint equation is used to condense out the degrees of 

freedom at the base of the 3-D soil domain to those at the top of the unit area soil column.  
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The dynamic process is solved step-by-step by the implicit Hilber-Hughes-Taylor algorithm 

(Hughes 1987). The three parameters = − . , = . − ² = .  and  γ = . − = .  guarantee an unconditionally numerical stability of the time integration 

scheme and numerical damping to reduce high frequency content, without having any 

significant effect on the meaningful, lower frequency response. The time step is automatically 

selected in the range between −  s and the time step used for the input signal sampling. 

The Iwan’s 3-D elasto-plastic model with isotropic and multilinear kinematic hardening (Iwan 

1967; Joyner 1975; Joyner and Chen 1975) is adopted for soil. The main feature of Iwan’s 

model is that the mechanical parameters to calibrate the rheological model are easily obtained 

from laboratory dynamic tests on soil samples. The rheological formulation is in terms of total 

stresses. The size of the yield surface is imposed by the backbone curve in the uniaxial stress 

case. In the present study, the soil behavior is assumed adequately described by a hyperbolic 

stress-strain curve (Hardin and Drnevich 1972a). This assumption yields a normalized shear 

modulus reduction curve expressed as G/G = / + |γ/γ | , where G  is the elastic shear 

modulus and γ  is a reference shear strain corresponding to an actual tangent shear modulus 

equivalent to G/G = . . 

The 3-D frame structure is modeled using Timoshenko beam elements. The building shallow 

foundation is rigidly connected to the soil, node-by-node. A linear constitutive behavior is 

assumed for the rigid foundation. The rotational degrees of freedom of nodes at the base of 

building columns are blocked. The damping due to non-structural elements is taken into 

account by the damping matrix that is assumed as mass and stiffness proportional, according 

to Rayleigh approach (Chopra 2000).  

When the nonlinear behavior of reinforced concrete is taken into account, the constitutive 

relationships in terms of generalized strains and stresses are deduced by the analysis of a unit-

length 3-D beam model, having solid FE for concrete and embedded steel bars. The cross-

sectional behavior of RC beams under axial force, bending moment and shear is assumed 

independent, neglecting the coupling effect. The Lubliner’s model (Lubliner et al. 1989) is 

selected for RC in compression and a linear behavior until the small tensile strength. A bilinear 

elasto-plastic behavior with hardening is adopted for the steel bars.  
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4.2. Input data for the parametric analysis 

A parametric analysis is developed to study the importance of SSI effects with the building to 

soil frequency ratio, for the different ground types in the Eurocode 8 classification (CEN 2003), 

in the cases of linear and nonlinear behavior of the building-soil system.  

4.2.1. Soil profiles 

Stratigraphy and mechanical parameters of the eleven soil profiles used in the present 

parametric analysis are given in Table 4-1. Soil properties are assumed constant in each soil 

layer. The shear wave velocity profile is arbitrary fixed to obtain a selected fundamental 

frequency of the soil column (Table 4-2)  

Table 4-1 Stratigraphy and mechanical properties of the analyzed soil profiles 

Depth Thickness ρ vs vp  ρ vs vp  ρ vs vp 

m m kg/m3 m/s m/s  kg/m3 m/s m/s  kg/m3 m/s m/s 

  Profile 1  Profile 2  Profile 3 

5 5 1999 450 1741  1957 360 1601  1937 320 1536 

15 10 2108 750 2156  2020 500 1815  1976 400 1664 

30 15 2166 950 2400  2092 700 2091  2058 600 1957 

  Profile 4  Profile 5  Profile 6 

5 5 1930 280 1469  1930 250 1417  1930 240 1400 

15 10 1957 360 1601  1947 340 1568  1932 310 1519 

30 15 2039 550 1887  2020 500 1815  1994 440 1726 

  Profile 7  Profile 8  Profile 9 

5 5 1930 230 1382  1930 220 1365  1930 200 1329 

5 10 1930 280 1469  1930 260 1435  1930 240 1400 

30 15 1976 400 1664  1957 360 1601  1930 300 1502 

  Profile 10  Profile 11     

5 5 1930 180 1293  1930 160 1256     

15 10 1930 210 1347  1930 170 1275     

30 15 1930 250 1417  1930 180 1293     
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Table 4-2 Eurocode ground type and fundamental frequency of the analyzed soil profiles 

Soil profile EC8 soil type Frequency 

  Hz 

1 A 7.5 

2 B 5.4 
3 B 4.5 
4 B 4.1 
5 B 3.8 
6 B 3.4 

7 C 3.0 
8 C 2.8 
9 C 2.5 
10 C 2.0 

11 D 1.5 

 

The soil density  and the compressional wave velocity v  are deduced according to the 

relationships discussed by Boore (2015). Then, the elastic shear and P-wave moduli (G = v ² 

and M = v ², respectively) are estimated. The Poisson’s ratio is evaluated as function of the 

compressional to shear velocity ratio, according to the relation  ν = ( . v v⁄ − ) (v v⁄ − )⁄  the reference shear strain is assumed equal to γ = .  ‰ 

for all layers. 

A squared soil area  A =  m ×  m is selected for the following analyses, as explained 

above in Chapter 2 - 2.2, considering also that the maximum dimension of the building floor is  m. A  3-D soil domain is modeled until a depth h =  m, that corresponds to the interface 

between the first and second soil layer, and a 1-D model is used in deeper soil layers  

(see Chapter 3 - 3.2.1).  

4.2.2. RC buildings 

Concerning the five analyzed buildings, the number of stories is determined according to the 

desired fundamental frequency of the building (Table 4-3), for the purpose of the analysis. The 

building floor area is defined arbitrarily, because it is the building height that characterizes the 

building fundamental frequency. 

The column orientation and the floor plan dimensions are indicated in the plans of Figure 2-10 

and the mechanical properties of RC beams, altogether, previously introduced in 

Chapter 2 - 2.2, for the buildings listed in Table 4-3. The sum of considered dead and live load 

is  kg/m . This load is distributed on beams in x-direction, according to their influence 
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area, as mass per unit length. The interstory height is 3.2 m. All the analyzed buildings have a 

translational motion as first mode shape. The rectangular cross-section of beams is given in  

Table 4-4.  

Table 4-3 Fundamental frequency of the analyzed frame structures 

Building Floors Floor plan Frequency Figure 

   Hz  

1 3 a 3.8 

 

2 3 b 2.8 

 

3 5 a 2.2 

 

4 5 b 1.7 

 

5 7 a 1.5 
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Table 4-4 Dimensions of rectangular cross-section beams for the analyzed buildings 

 Buildings 1-2 Buildings 3-4 Building 5 

Floor Beam Column Beam Column Beam Column 

 cm cm cm cm cm cm 

1 30×80 30×70 30×70 30×80 30×80 30×70 
2 30×70 30×70 30×70 30×70 30×70 30×70 
3 30×60 30×60 30×60 30×60 30×60 30×60 
4   30×60 30×60 30×60 30×60 
5   30×60 30×60 30×60 30×60 
6     30×60 30×60 
7     30×60 30×60 

 

When the nonlinear behavior of RC is taken into account, for the same concrete strength, the 

Hognestad’s parabola is selected as first-loading curve (Appendix A). A cubic characteristic 

concrete strength � =  N/mm² is assumed in compression. The rupture strain is fixed as = .  ‰  and the concrete density is =  kg/m . A linear behavior is assumed 

until the concrete tensile strength f = .  N/mm².  
Two  mm diameter and three   diameter longitudinal steel bars are used as top and 

bottom reinforcement, respectively, and  mm diameter stirrups with spacing of  mm. 

The steel of bars has elastic modulus E =  N/mm², Poisson’s ratio ν = .  and 

density =  kg/m . A bilinear elasto-plastic behavior with hardening is adopted, having 

yield stress f =  N/mm², yield strain =  ‰  , rupture stress f =  N/mm² and 

rupture strain =  ‰.  

 

 

4.2.3. Input motion 

The recorded signal of the 6 April 2009 Mw 6.3 L’Aquila earthquake, and the synthetic narrow 

band loading (Chapter 2 - 2.2) are used as rock outcropping motion for this parametric analysis.  

4.3. SSI analysis 

The results obtained from the 55 combinations of building-soil system are presented in this 

section, trying to identify common aspects in the seismic response of buildings, with the 

purpose of understanding if a correction factor for the design response spectrum proposed by 
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the Eurocode 8 (CEN 2003) would be enough to take into account the SSI effect for RC 

buildings with shallow foundation. 

4.3.1. Linear elastic analyses 

According to the purpose of correcting the actual approach imposed by the seismic design code 

and refering to results obtained by Trombetta et al. (2014) that show more important interaction 

effects in linear elastic conditions, a first part of this parametric analysis is undertaken 

considering linear behaving soil and structure. 

The variation of the peak acceleration at the top of each analyzed building a_max with the soil 

natural frequency   is shown in Figure 4-2, in the two cases of synthetic narrow-band seismic 

loading having predominant frequency  close to the building fundamental frequency  and 

amplitude a = .  m/s², and the North-South component of the recorded large-band input 

loading (the 2009 Mw 6.3 L’Aquila earthquake: a = .  m/s², = .  �z) applied in the 

direction of the first mode shape of the building. The peak acceleration is normalized with 

respect to the maximum amplitude of the seismic load a  to highlight the difference between a 

narrow- and large-band input, independently on the difference in terms of amplitude.  
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Figure 4-2 Variation of the peak acceleration at the top of five different buildings, normalized 
with respect to the maximum amplitude of the seismic load aq  , with the soil fundamental 
frequency: synthetic signal having predominant frequency close to the building fundamental 
frequency (left) and 2009 Mw 6.3 L’Aquila earthquake (right) as seismic loading. A vertical 
dashed line indicates the building fundamental frequency 
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The peak acceleration at the building top a_max is maximum for the resonance of soil and 

building ( = ). This, for both cases of excited building by a synthetic signal having  = , but also for the recorded earthquake with distant predominant frequency. In the case 

of large-band input signal, the peak acceleration is higher for buildings having fundamental 

frequency close to = .  �z. The acceleration peak decreases, compared with resonance 

( = ), for f  higher and lower than . The same trend is obtained for all the structures. 

Figure 4-3 shows the variation with the building to soil fundamental frequency ratio /  of 

the peak acceleration at the top of each analyzed building, normalized with respect to its 

maximum  � . It is confirmed that a similar result is achieved for all the structures, with a 

maximum seismic response for the resonance of soil and building. 

 

Figure 4-3 Variation with the building to soil fundamental frequency ratio of the peak 
acceleration at the top of five different buildings, normalized with respect to its maximum: 
synthetic signal having predominant frequency close to the building fundamental frequency 
(left) and 2009 Mw 6.3 L’Aquila earthquake (right) as seismic loading 

The variation of the peak acceleration at the top of the building in a one-step analysis over that 

in a two-step analysis a /a −  with the building to soil fundamental frequency ratio / , is shown in Figure 4-4, for the five analyzed buildings. According to Saez et al. (2011), 

the ratio a /a −  is a measure of SSI effect. In the analyzed cases, the influence of 

SSI can reduce the acceleration peak at the top of the building of about 30% in the case of 

narrow-band seismic input having predominant frequency exciting the building fundamental 

frequency. In the case of large-band recorded earthquake, the influence of SSI can variate 

between 40% of reduction and 5% of increase of the acceleration peak at the top of the building. 

The similarity of all the cases is maintained, even if there is more variability in the case of 

recorded input loading. Consequently, an average curve for all analyzed cases could provide 

an acceleration ratio a /a −  to quantify the SSI effect for any structure, known the 



Chapter 4 - Response spectrum for structural design considering soil-structure interaction 

115 

 

building to soil fundamental frequency ratio /  in the studied case. This result suggests the 

definition of a correcting factor c I = a /a −   of the design response spectrum that 

takes into consideration the SSI. In other words, the SSI effect could be predicted as  a = c I a − , correcting the result obtained using a two-step analysis by the 

correcting factor cf I read in a response spectrum considering SSI, similar to that in Figure 

4-4, once the structure and soil dynamic features are known in terms of building to soil 

fundamental frequency ratio / .  

 

Figure 4-4 Variation of the peak acceleration at the top of the building in a one-step analysis 
over that in a two-step analysis with the building to soil fundamental frequency ratio, for five 
different buildings: synthetic signal having predominant frequency close to the building 
fundamental frequency (left) and 2009 Mw 6.3 L’Aquila earthquake (right) as seismic loading 

The variation of the peak acceleration at the top of the building in a one-step analysis over that 

in a two-step analysis a /a −  with the soil fundamental frequency , is shown in  

Figure 4-5, for the five analyzed buildings. The variability of SSI effect is high, for ground 

types B, C and D, in particular for softer soils. Consequently, it is more convenient to generalize 

the problem by characterizing SSI with respect to the building to soil fundamental frequency 

ratio /  (Figure 4-4).  

4.3.2. Effect on SSI of soil and structure nonlinear behavior 

The variation with the soil natural frequency  of the peak acceleration a  at the top of the 

building is represented in Figure 4-6 in both cases of nonlinear behaving soil and nonlinear 

behaving structure and soil. The results are shown for a three- and seven-floor RC buildings, 

having fundamental frequency = .  �z  and = .  �z, respectively, that are the most 

flexible and stiffest analyzed buildings (Table 4-3). A synthetic narrow-band seismic loading 

is used as incident motion at the soil-bedrock interface, having predominant frequency  close 
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to the building fundamental frequency  and an amplitude of a = .  m/s  to trigger the 

nonlinear behavior in the soil. 

 

Figure 4-5 Variation of the peak acceleration at the top of the building in a one-step analysis 
over that in a two-step analysis with the soil fundamental frequency, for five different buildings 
and a synthetic signal having predominant frequency close to the building fundamental 
frequency as seismic loading. The ground type range is indicated by vertical boundaries 

The peak acceleration at the building top a  decreases from stiff to soft soils (decreasing ). 

This is due to the soil nonlinearity that, for the same amplitude of the input loading, is more 

pronounced in softer soils (decreasing ) and is reduced progressively for stiff soils. A similar 

trend is obtained for both structures for nonlinear behaving soil, even if the seismic response 

in the stiffer building is reduced.  

A difference is expected between the cases where the nonlinearity of RC is taken into account 

or not, because the constitutive curves in terms of generalized stresses, used for the nonlinear 

behaving RC beams, are deduced using a 3-D beam model with embedded steel bars, instead 

when the RC is assumed linear behaving the only elastic mechanical parameters of concrete 

are used, under the assumption of uncracked beam. 

Comparing the case of nonlinear behaving building-soil system with the case of nonlinearity 

of soil only, the trend is maintained, but the attained acceleration level at the building top is 

reduced because the steel reinforcement is taken into account and for the energy dissipation 

due to the hysteretic behavior in the structure.  

The nonlinearity of RC induces higher dissipation in more flexible buildings and a consequent 

lower acceleration. 
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Figure 4-6 Variation with the soil fundamental frequency of the peak acceleration at the top of 
two buildings having fundamental frequency = 1.5 Hz (left) and = 3.8 Hz (right), in the 
case of nonlinear behaving soil and nonlinear behaving building-soil system. The synthetic 
input signal has predominant frequency close to the building fundamental frequency 

Figure 4-7 shows the variation with the soil natural frequency   of the peak acceleration a  

at the top of the same buildings, normalized with respect to the maximum amplitude of the 

seismic load a , for linear behaving building-soil system, nonlinear behaving soil and nonlinear 

behaving building-soil system. In softer soils (decreasing ), the structural seismic response 

increases for linear behaving soil and decreases for nonlinear behaving soil. The nonlinearity 

increases with decreasing soil fundamental frequency , for the same amplitude of the input 

loading. The peak acceleration at the building top decreases for increasing soil nonlinearity. 

Similar results are obtained for the seismic response of the building in a softer soil (decreasing 

 and higher soil nonlinearity), if the building nonlinearity is taken into account or not. The 

contribution of modeling the effect of steel bars and RC nonlinearity is more remarkable in the 

case of stiff soil and reduced soil nonlinearity. 

The building seismic response is similar for both structures, when the nonlinearity of soil only 

or soil and structure is taken into account. In fact, the effect of maximum seismic response at 

the resonance of soil and building ( = ) is lost. 

The seismic response is reduced for nonlinear RC due to the energy dissipation and the steel 

reinforcement, taken into account in the model. Nevertheless, for softer soils, a negligible 

reduction of the building seismic response is obtained when the nonlinearity of the structure is 

also taken into account.  

Figure 4-8 shows the variation of the peak acceleration a  at the top of the two analyzed 

buildings normalized with respect to the maximum amplitude of the seismic load  
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a = .  m/s², with the building to soil fundamental frequency ratio / . The trend of these 

curves is similar for both structures when the nonlinearity of materials is taken into account.  

The comparison of the structural response in the cases where the nonlinearity is taken into 

account, for the soil only or soil and structure, with the case of linear behaving system (Figure 

4-7 and Figure 4-8), suggests the preponderance on the structural seismic response of soil 

nonlinearity effect, compared with the structure nonlinearity. 

 

Figure 4-7 Variation with the soil fundamental frequency of the peak acceleration, normalized 
with respect to the maximum amplitude of the seismic load aq  , at the top of two buildings 
having fundamental frequency = 1.5 Hz (left) and = 3.8 Hz (right), for the cases of linear 
behaving building-soil system, nonlinear behaving soil and nonlinear behaving building-soil 
system. The synthetic input signal has predominant frequency close to the building 
fundamental frequency 

 

 

Figure 4-8 Variation with the building to soil fundamental frequency ratio of the peak 
acceleration, normalized with respect to the maximum amplitude of the seismic load aq  , at the 
top of two buildings having fundamental frequency = 1.5 Hz (left) and = 3.8 Hz (right), 
for the cases of linear behaving building-soil system, nonlinear behaving soil and nonlinear 
behaving building-soil system. The synthetic input signal has predominant frequency close to 
the building fundamental frequency 
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The curves representing the variation with the building to soil fundamental frequency ratio /   of the peak acceleration at the building top, normalized with respect to its maximum 

(� ), have been obtained for different buildings, in the case of linear behaving building-soil 

systems, and superposed (Figure 4-3), obtaining an average curve with small variance. 

Nevertheless, according to Figure 4-9, when the nonlinearity of materials is attained, the 

seismic response of the two analyzed buildings (the stiffest and the supplest), in terms of peak 

acceleration at the building top, have the same trend with the building to soil fundamental 

frequency ratio / , but it attains a maximum for a different value of /  and not for the 

elastic resonance case ( / = ). Moreover, the influence on the structural seismic response 

of the nonlinearity of RC structure is less pronounced, compared with the effect of soil 

nonlinearity.  

 

Figure 4-9 Variation with the building to soil fundamental frequency ratio of the peak 
acceleration at the top of two analyzed buildings, normalized with respect to its maximum, for 
the cases of linear behaving building-soil system (left), nonlinear behaving soil (middle) and 
nonlinear behaving building-soil system (right). The synthetic input signal has predominant 
frequency close to the building fundamental frequency  

The attainment of strains in the nonlinear plastic range, for soil or soil and structure, tends to 

increase the irregularity of the structural seismic response and modifies the vibration frequency 

during the process. Consequently, the building to soil fundamental frequency ratio /  is 

modified compared with the elastic regime and the curves in Figure 4-9 do not give similar 

structural response for all the analyzed buildings, depending only on the parameter / , as in 

the case of linear behaving building-soil system (Figure 4-3).  

The variation with the building to soil fundamental frequency ratio /  of the peak 

acceleration at the top of the three- and seven-floor RC buildings, having fundamental 

frequency = .  �z  and = .  �z (Table 4-3), respectively, is shown normalized with 

respect to the peak acceleration at the top of the building in a two-step analysis 
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(a /a − ) in Figure 4-10. This, for the cases of linear behaving building-soil system, 

nonlinear behaving soil and nonlinear behaving building-soil system. Taking into account the 

nonlinear behavior of materials, the structural seismic response considering SSI becomes 

unpredictable using a correction factor depending only on the elastic building to soil 

fundamental frequency ratio / , applied to a two-step analysis. According to Figure 4-10, 

the variability of SSI effect is higher when the nonlinearity of materials is taken into account 

and the nonlinearity of the structure strongly modifies the influence of SSI, compared with the 

case of nonlinear behaving soil only. 

 

Figure 4-10 Variation with the building to soil fundamental frequency ratio of the peak 
acceleration at the top of the building in a one-step analysis over that in a two-step analysis, for 
the two analyzed buildings, in the cases of linear behaving building-soil system (left), nonlinear 
behaving soil (middle) and nonlinear behaving building-soil system (right). The synthetic input 
signal has predominant frequency close to the building fundamental frequency 

4.4. Conclusion 

The extensive application of 3-D SSI models in the usual engineering practice is hindered by 

the lack of geotechnical data that makes more difficult realizing a reliable soil model and, on 

the other hand, the dimension of soil domain results in a significant modeling and computation 

time. The proposed 1DT-3C model, compared with a fully 3-D model, reduces the modeling 

and computation time. In fact, geotechnical parameters are easy to characterize for a one-

dimensional soil model (using a single borehole investigation) and boundary condition 

definition is simple (the input signal and the absorbing boundary condition are given for only 

one element. Moreover, the mesh is considerably reduced. 

- The SSI, estimated as the peak acceleration at the building top in a one-step analysis over that 

in a two-step analysis, is maximum for the resonance of soil and building, for both cases of 

synthetic narrow-band signal exciting the building and for recorded large-band seismic signal, 

and for the five selected RC frame structures. 
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- In the analyzed cases, the SSI effect reduces the seismic response of about 30-40% for the 

resonance of soil and building and can induce some negligible amplification for other values 

of the building to soil frequency ratio. The results are similar for all the analyzed structures, 

with an increase of variability in the case of large-band input exciting the building fundamental 

frequency, compared with the narrow-band input signal.  

- In the linear elastic regime, the SSI can be taken into account using a correction factor applied 

to the result of a two-step analysis (FB building model loaded by a FF seismic signal). This 

correction factor depends on the building to soil fundamental frequency ratio / . 

- With an increasing soil softness and attained nonlinearity, the structural seismic response 

increases for linear behaving soil and decreases for nonlinear behaving soil (the attained 

nonlinearity level increases). 

- The effect of soil nonlinearity on the structural seismic response is preponderant compared 

with the effect of the RC nonlinearity. 

- The attainment of strains in the nonlinear plastic range, for soil or soil and structure, tends to 

increase the irregularity of the structural seismic response. Moreover, the nonlinearity of soil 

and structure modifies the vibration frequency during the process. Consequently, taking into 

account the nonlinear behavior of materials, the structural seismic response considering SSI 

becomes unpredictable using a simple correction factor depending only on the elastic building 

to soil fundamental frequency ratio / , applied to a two-step analysis. 

The present parametric analysis confirms some results of the literature concerning SSI analyses 

and shows that general results can be obtained in a linear elastic regime for structural design 

taking into account SSI. Coupling seismic site effects and SSI for nonlinear behaving materials 

demands a specific one-step SSI analysis.  
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The effect of an adjacent structure whose interference passes through the soil (named SSSI) is 

studied, questioning about the validity of actual seismic design which considers structures 

isolated from surroundings. The proposed advanced model, suited for engineering practice, can 

be adopted to explore the coupling of seismic site effects, due to soil stratigraphy and 

nonlinearity, with dynamic features of superstructures, foundation deformability and 

earthquake motion.  

In this research, a linear behaving soil-building system is used to identify the key parameters 

that influence the SSSI phenomenon and understand if a simple procedure can be proposed for 

structural design. This, in the case of two nearby buildings. This work is inspired by the 

possibility of using vibration barriers for risk mitigation.  The idea of an oscillator absorbing 

the energy of earthquakes and protecting buildings is a smart solution if well designed. It is 

important to study the phenomenon of SSSI before proposing a procedure for vibration barrier 

design. 
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5.1. 1DT-3C wave propagation model for SSSI analysis 

The proposed 1D-3C wave propagation model for SSI investigations is limited to the case of 

rigid shallow foundation. Rocking effects cannot be reproduced. Furthermore, the numerical 

simulation of seismic response of a group of buildings demands a fully 3-D model.  

The proposed T soil model for 1DT-3C wave propagation permits the consideration of a city, 

deep foundation, rocking effect and soil spatial stratigraphy. The modeling of a T-shaped soil 

domain is inspired by the consideration that the SSI is detected in the near-surface soil layers. 

A fully 3-D soil model is adopted until a fixed depth ℎ and a 1-D model is used for deeper soil 

layers (Figure 5-1).  

 

Figure 5-1 2-D section of the 1DT-3C model for SSI analysis where h is the thickness of  the     
3-D soil domain and � is the Thickness of the considered soil until bedrock interface. 

5.2. Input data for the parametric analysis 

A parametric analysis is developed to study the importance of SSSI effects for different ground 

types in the Eurocode 8 classification (CEN 2003), in the case of linear of the building-soil 

system.  

5.2.1. Soil profiles 

Stratigraphy and mechanical parameters of the eleven soil profiles used in the present 

parametric analysis are given in Table 5-1. Soil properties are assumed constant in each soil 

layer. The shear wave velocity profile is arbitrary fixed to obtain a selected fundamental 

frequency of the soil column (Table 5-2).  
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The soil density  and the compressional wave velocity v  are deduced according to the 

relationships discussed by Boore (2015). Then, the elastic shear and P-wave moduli  

(G = v ² and M = v ², respectively) are estimated. The Poisson’s ratio is evaluated as 

function of the compressional to shear velocity ratio, according to the relation  ν = ( . v v⁄ − ) (v v⁄ − )⁄ . The reference shear strain is assumed equal to  γ = .  ‰ for all layers.  

Table 5-1 Stratigraphy and mechanical properties of the analyzed soil profiles 

Profile 1   Profile 2  Profile 3 

Depth  vs vp  Depth   vs vp  Depth   vs vp 

(m) (kg/m3) (m/s) (m/s)  (m) (kg/m3) (m/s) (m/s)  (m) (kg/m3) (m/s) (m/s) 

0-5 1930 220 1365  0-5 1930 180 1293  0-5 1930 160 1256 
5-15 1930 260 1435  5-15 1930 210 1347  5-15 1930 170 1275 
15-30 1957 360 1601  15-30 1930 250 1417  15-30 1930 180 1293 
> 30 2100 1000 2449  > 30 2100 1000 2449  > 30 2100 1000 2449 

 

Table 5-2 Eurocode ground type and fundamental frequency of the analyzed soil profiles 

Soil profile EC8 soil type Frequency 

  Hz 
1 C 2.8 
2 C 2.0 
3 D 1.5 

 

A squared soil area  A =  m ×  m is selected for the following analyses, as explained 

above in Chapter 2 - 2.2, considering also that the maximum dimension of the building floor is  m. A  3-D soil domain is modeled until a depth h =  m, that corresponds to the interface 

between the first and second soil layer, and a 1-D model is used in deeper soil layers  

(see Chapter 3 - 3.2.1).  

5.2.2. Buildings characteristics 

Concerning the analyzed buildings, the number of stories is determined according to the desired 

fundamental frequency of the building (Table 5-3), for the purpose of the analysis. The building 

floor area is defined arbitrarily, because it is the building height that characterizes the building 

fundamental frequency. 

The column orientation and the floor plan dimensions are indicated in the plans of Figure 2-10 

and the mechanical properties of RC beams, altogether, previously introduced in 

Chapter 2 - 2.2, for the buildings listed in Table 5-3.  
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Table 5-3 Fundamental frequency of the analyzed frame structures 

Building Floors Floor plan Frequency 

   Hz 

1 3 a 3.8 
2 3 b 2.8 
3 5 a 2.2 
4 7 a 1.5 

 

Table 5-4 Dimensions of rectangular cross-section beams for the analyzed buildings 

 Buildings 1-2 Building 3 Building 4 

Floor Beam Column Beam Column Beam Column 

 cm cm cm cm cm cm 

1 30×80 30×70 30×70 30×80 30×80 30×70 
2 30×70 30×70 30×70 30×70 30×70 30×70 
3 30×60 30×60 30×60 30×60 30×60 30×60 
4   30×60 30×60 30×60 30×60 
5   30×60 30×60 30×60 30×60 
6     30×60 30×60 
7     30×60 30×60 

5.2.3. Input motion 

The recorded signal of the 6 April 2009 Mw 6.3 L’Aquila earthquake, and the synthetic narrow 

band loading are used as rock outcropping motion for this parametric analysis (Chapter 2 - 2.2).  

5.3. SSSI analysis 

5.3.1. SSSI versus SSI  

The 1DT-3C seismic wave propagation model is used to compare the seismic response of a 

building when it is isolated and in the case of presence of a nearby building, in order to 

investigate the influence of SSSI.  

The analysis is undertaken using the soil profile with = .  �z (Table 5-1), the 2009 Mw 

6.3 L’Aquila earthquake as seismic loading, the buildings in Figure 2-10a, with the same inertia 

in both orthogonal directions ( = = .  �z), and the building in Figure 2-10b, with 

different inertia in two orthogonal directions ( = .  �z, = .  �z). 
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Table 5-5 Gof of 1DT-3C wave propagation model in the case of a building having a nearby 
building compared with the case of isolated building.  

Compared Models Position x⃗  Anderson Criterion 

C1 C2 C3 C4 C5 C6 C7 C8 C9 C10 

1DT-3C 
SSSI  == .  �z 

1DT-3C 
SSI = .  �z 

= .  �z 

bldg. base 

x 9.7 9.8 9.8 9.9 10 9.9 10 10 9.6 9.8 

y 9.8 9.8 10 10 10 10 10 10 9.3 9.9 

z 9.8 9.9 9.9 10 9.9 10 10 10 9.5 9.8 
              

1DT-3C 
SSSI  = .  �z  =  .  �z 

1DT-3C 
SSI = .  �z 

= .  �z 

bldg. base 

x 9.9 9.9 10 10 10 10 10 10 9.8 10 

y 9.8 9.9 10 10 10 10 10 10 9.5 9.9 

z 9.9 9.9 9.9 10 9.8 10 10 10 9.6 9.9 
              

1DT-3C 
SSSI  == .  �z 

1DT-3C 
SSI = .  �z 

= .  �z 

bldg. top 

x 9.8 9.9 9.9 10 10 10 10 10 9.8 9.9 

y 9.9 9.9 10 10 10 10 10 10 9.8 10 

z 9.8 10 10 10 9.9 10 10 10 9.8 10 

1DT-3C 
SSSI  = .  �z  =  .  �z 

1DT-3C 
SSI = .  �z 

= .  �z 

bldg. top 

x 9.8 9.8 10 10 9.9 10 10 10 9.6 9.8 

y 9.8 9.8 10 10 10 10 10 10 9.5 9.9 

z 9.9 9.9 9.9 10 9.8 10 10 10 9.7 9.9 
              

1DT-3C 
SSSI  == .  �z 

1DT-3C 
SSI = .  �z 

= .  �z 

bldg. base 

x 8.2 8.3 9.2 9.9 8.5 9.4 10 9.4 6.3 3.2 

y 8.7 8.9 9.7 8 9.8 9.6 8.8 9.4 5.3 2.8 

z 9.4 9.9 9.8 10 9.9 9.9 10 9.9 8 8.1 
              

1DT-3C 
SSSI  = .  �z  

1DT-3C 
SSI = .  �z 

= .  �z 

bldg. base 

x 8.2 8.3 9.3 9.9 8.4 9.4 10 9.4 6.4 3.2 

y 8.6 8.9 9.7 8.1 9.9 9.7 8.8 9.5 5.3 2.6 

z 9.4 9.8 9.7 10 10 9.9 10 9.9 7.9 8 
              

1DT-3C 
SSSI  == .  �z 

1DT-3C 
SSI = .  �z 

= .  �z 

bldg. top 

x 8.9 8.5 10 10 9.9 9.9 10 9.6 6.4 3.4 

y 8.6 8.5 7.3 9.7 9.3 9.6 10 9.5 5.5 3.1 

z 9.2 9.8 9.8 10 10 10 10 9.9 7.7 7.6 
              

1DT-3C 
SSSI  = .  �z = .  �z 

1DT-3C 
SSI = .  �z 

= .  �z 

bldg. top 

x 8.9 8.6 9.9 10 10 10 10 9.6 6.5 4 

y 8.5 8.4 5.4 9.2 9.1 9.4 10 9.5 5.5 3 

z 9.3 9.8 9.8 10 10 9.9 10 9.9 7.7 7.5 
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Figure 5-2 Simulated acceleration time history of the building with b1 = b2 = 3.8 Hz  at the 
building bottom, in the case of a nearby building with b1 = b2 = 3.8 Hz , during the input 
signal duration (top) and in a 10 s time window over the largest amplitudes (bottom). 

 

Figure 5-3 Simulated acceleration time history of the building with b1 = b2 = 3.8 Hz  at the 
building bottom, in the case of a nearby building with b1 = 2.8 Hz different than 

b2 = 4.7 Hz , during the input signal duration (top) and in a 10 s time window over the largest 
amplitudes (bottom). 
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Figure 5-4 Simulated acceleration time history of the building with b1 = 2.8 Hz different than 

b2 = 4.7 Hz at the building bottom, in the case of a nearby building with b1 = 2.8 Hz  
different than b2 = 4.7 Hz , during the input signal duration (top) and in a 10 s time window 
over the largest amplitudes (bottom). 

 

Figure 5-5 Simulated acceleration time history of the building with b1 = 2.8 Hz different than 

b2 = 4.7 Hz at the building bottom, in the case of a nearby building with b1 = b2 = 3.8 Hz 
, during the input signal duration (top) and in a 10 s time window over the largest amplitudes 
(bottom). 
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                        (a)                                          (b)                                           (c)                                          (d) 

Figure 5-6 Comparison of results obtained using the 1DT-3C wave propagation model for 
isolated building and SSSI, in terms of Arias integral (AI), energy integral (IE), pseudo-
acceleration response spectrum (Spa) and Fourier spectrum (FS) for the vertical component (z) 
of motion and s = 2.8 Hz : (a) building with b1 = b2 = 3.8 Hz at the building bottom, in the 
case of a nearby building with b1 = b2 = 3.8 Hz ; (b) building with b1 = b2 = 3.8 Hz  at 
the building bottom, in the case of a nearby building with b1 = 2.8 Hz different than

b2 = 4.7 Hz ; (c) building with b1 = 2.8 Hz different than b2 = 4.7 Hz at the building 
bottom, in the case of a nearby building with b1 = 2.8 Hz  different than b2 = 4.7 Hz ; (d) 
building with b1 = 2.8 Hz different than b2 = 4.7 Hz at the building bottom, in the case of a 
nearby building with b1 = b2 = 3.8 Hz . 

The seismic response of each building, influenced by a nearby more flexible or stiffer building, 

is investigated. Anderson’s criteria are employed to quantitatively estimate the differences in 

results obtained, comparing the response of an isolated building and a building having a nearby 

building (Anderson 2004). According to Gof scores in Table 5-5, Figure 5-2 and Figure 5-3, 

where the case with one building is assumed as reference and the influence of the nearby 

building is observed, it can be deduced that the building with = = .  �z is not influenced 
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by a nearby building. On the contrary, the building with = . �z different than = .  �z 

is influenced by SSSI effects, both considered cases. 

In terms of peak acceleration of the building with = . �z different than = .  �z at the 

building bottom (Table 5-5, Figure 5-4, Figure 5-5 and Figure 5-6), the SSSI is observed in the 

direction of the first translational mode shape (x) of the building. 

Considering SSSI gives an amplification of motion, not taken into account when the building 

is considered isolated. 

 

Figure 5-7 1DT-3C for SSSI analysis 

5.3.2. SSSI parametric analysis 

The effect of a nearby building, in the linear elastic regime, is investigated for three buildings 

(Table 5-3), with fundamental frequency = .  �z (the supplest), = .  �z 

(intermediate) and = .  �z (the stiffest). Two soft soil profiles have been selected for the 

analysis, to highlight the SSSI effect, whose natural frequencies are = .  �z  (ground type 

D, see Table 5-2) and =  �z (the softest analyzed soil of ground type C).  

In a first part of the analysis, the seismic response of a target building having fundamental 

frequency  is investigated using a synthetic seismic signal having predominant frequency      = , in the five cases where one of the buildings in Table 5-3 is placed at a distance of 1m  

(distance between the shallow foundations), as shown in Figure 5-7. 

The variation of the peak acceleration at the top of the excited building with the fundamental 

frequency of the nearby building   is shown in Figure 5-8, for the two selected soil profiles. 
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The seismic response of the excited building does not have important variations caused by the 

different buildings placed nearby. This effect suggests that when the first mode shape of the 

building is excited ( = ), the SSSI is less evident. The maximum accelerations at the top 

of the excited building are obtained in the case of resonance of the building-soil system                     

( = = ). Whereas, a slight increase of the seismic response of the building having 

fundamental frequency far from the soil profiles ( = .  �z), is noticed for the softest soil 

with = .  �z (Figure 5-8). 

In a second part of the analysis, the seismic response of a target building having fundamental 

frequency  is investigated in the five cases where one of the buildings in Table 5-3, having 

fundamental frequency , is placed at a distance of  m (Figure 5-7) and the system is excited 

using a synthetic seismic signal having predominant frequency equal to that of the nearby 

building    ( = ).  

 

Figure 5-8 Variation of the peak acceleration at the top of the excited building with the natural 
frequency of the nearby building, for the cases of soil profile having natural frequency 

s = 1.5 Hz (left) and s = 2 Hz (right) 

Figure 5-9 shows the variation of the peak acceleration at the top of the target building in a 

SSSI analysis over that in a SSI analysis (single building) a /a − I with the fundamental 

frequency of the nearby building , in a soft soil, in both cases of seismic loading exciting 

the target ( = ) and nearby building ( = ). A similar result is obtained for the two 

selected soil profiles. When the target building is excited, its structural seismic response can 

attain a reduction of  % or an increment of  %, in the analyzed cases. Instead, when the 

nearby building is excited the seismic response of the target building has a variability of ±  %.  

In a soft soil, when the nearby building is quite stiff ( > .  �z) the SSSI induces a slight  % reduction of the seismic response, compared with the case of single building, with small 
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variability for the different analyzed buildings. This suggests that a stiff nearby building does 

not have a remarkable effect on the seismic response of the target building. 

Figure 5-10 shows the variation of the peak acceleration at the top of the target building in a 

SSSI analysis over that in a SSI analysis (single building) a /a − I with the target to 

nearby building fundamental frequency ratio / , in a soft soil, in both cases of seismic 

loading exciting the target ( = ) and nearby building ( = ). A similar result is 

obtained for the two selected soil profiles. When the target building is excited, its structural 

seismic response can attain a reduction until  % for a target to nearby building fundamental 

frequency ratio   / ≈ . . Instead, when the nearby building is excited, the seismic 

response of the target building has a variability of ±  % for a target to nearby building 

fundamental frequency ratio / ≈  that is when the nearby building is more flexible. 

 

Figure 5-9 Variation of the peak acceleration at the top of the target building in a SSSI analysis 
over that in a SSI analysis (single excited building) with the natural frequency of the nearby 
building, for the cases of soil profile having natural frequency s = 1.5 Hz (left) and s = 2 Hz  
(right): excited target building (top); excited nearby building (bottom) 
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Figure 5-10 Variation of the peak acceleration at the top of the target building in a SSSI analysis 
over that in a SSI analysis (single excited building) with the target to nearby building 
fundamental frequency ratio, for the cases of soil profile having natural frequency s = 1.5 Hz 
(left) and s = 2 Hz  (right): excited target building (top); excited nearby building (bottom) 

5.4. Semi-infinite elements and dashpot boundary conditions 

When the periodicity assumption is not verified, for example when it is studied the dynamic 

response of soil representing any irregularity in the geometry, as nonsymmetrical city plan, 

complicated topography or spatial stratigraphy, it is mandatory to model the far field, where 

the reflected waves are far enough to be neglected in the analyzed zone an absorbing lateral 

boundary condition is necessary to dissipate energy out of the truncated domain and reduce 

soil domain. Nevertheless, due to the impossibility to impose zero horizontal strains, the soil 

domain to be modeled is much larger compared with the case of periodic lateral condition.  

Abaqus software provides semi-infinite elements, to model the far field region, based on the 

work of Lysmer and Kuhlemeyer (1969) to assembly with the standard finite elements used to 

model the region of interest (Figure 5-11 ).  
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Figure 5-11 3-D soil model with semi-infinite lateral elements. 

The solution of the infinite element representing the far field is considered linear and have no 

influence on the truncated domain of interest and the damping on this boundary is introduced 

such that 

 σ = −  (5-1) 

and  

 σ = −  (5-2) 

 
σ = −  

 
(5-3) 

where   and  are damping constants, ,  and  are the velocities in x, y and z direction 

respectively, σ  is the normal stress and σ  and σ  are shear stresses. 

We consider plane wave traveling along the x-direction, to calculate the damping constants,. 

The solution exists in two forms, the plane longitudinal wave solution, written in this form  

 u = (  ± ),   = =  (5-4) 

and the shear wave solution, written in this form 

 u =  ± ,   = =  (5-5) 

or   

 u =  ± ,   = =  (5-6) 
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where  and  are the body and shear wave velocity respectively, −   represents the 

wave propagating in the positive x-direction and +   represents the wave propagating 

in the negative x-direction. 

Now, considering the plane solution u  will be equal to the sum of the propagating wave 

approaching to the boundary ( − ) and the reflected wave away from the 

boundary ( + ), the total displacement is then written u = ( − ) + ( + ). 

In order to obtain a silent boundary, the reflection is set equal to zero ( + ) = , which 

implies that the damping coefficient is written as following  

 = �  (5-7) 

where � is the soil density. 

Similarly,  

 = �  (5-8) 

Proof: 

 u = ( − ) + ( + ) (5-9) 

 u = − [ ′( − ) − ′( + )] (5-10) 

 
= /  [� /� + [� /� ] ] = ′( − ) + ′( + ) 

(5-11) 

 

� = λ�� ∶ � + G � 

� = � + [ ′( − ) + ′( + )]= [ ′( − ) − ′( + )] (5-12) 

Since ( + ) = , ′( + ) is then equal to 0 and ′( − ) ≠ , 

 λ + G = d  (5-13) 

 d = � + /  (5-14) 
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where � is Lamé’s constant, � = �/ + � − � ,  is the shear modulus  = / + � = /  (� − �) = � ,  � and  are the Poisson’s ratio and the Young’s 

modulus, respectively. 

Hence,  

 d = �  (5-15) 

5.4.1. Semi-infinite elements vs dashpots 

A verification is undertaken using dashpot (Figure 5-12a) and semi-infinite elements  

(Figure 5-12b) as lateral boundary condition. The 3D-3C model is used for a FF analysis of a 

homogeneous one-layer soil of  m depth. The soil parameters are density equal to   Kg/m , Young modulus equal to   N/m² and a Poisson ratio equal to . , is considered. The frequency of this soil profile is = .  �z. 

The narrow band synthetic signal with = .  �z is imposed at the soil-bedrock interface 

(Chapter 2 - 2.2). 

Figure 5-13 shows the comparison between the FF response of the 3D-3C model using dashpot 

or semi-infinite elements as lateral boundary condition. The time histories for the acceleration 

registered at the top of the FF soil are similar in both lateral boundary conditions.   

Consequently, this test confirms that both modeling techniques are equivalent. 

 

                                                    (a)                                            (b) 

Figure 5-12 3D-3C modeled using lateral boundary condition as linear dashpots (a) as semi-
infinite elements (b). 
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Figure 5-13 Comparison between lateral boundary conditions; dashpots and semi-infinite 
elements in a 3D-3C FF analysis: acceleration time history at the soil top. 

5.4.2. Domain truncation definition 

In this analysis the 3D-3C model having semi-infinite lateral boundary condition is used for a 

FF analysis of  the homogeneous one-layer soil presented in section 5.4.1, subjected to a narrow 

band synthetic signal with = .  �z at the soil-bedrock interface (Chapter 2 - 2.2). 

In order to define the dimension of the truncated domain, a parametric analysis is run using 

several dimensions for the finite domain: ×  m , ×  m , ×  m ,×  m  , the frequency is calculated for each case using modal analysis. 

Figure 5-14 shows the variation of the soil frequency with the dimension of the soil. It is noticed 

that in order to get the frequency of the soil obtained using a periodic condition, a large domain 

needs to be modeled using the semi-infinite elements as lateral boundary condition. Hence, the 

use of the semi-infinite or dashpots as absorbing lateral boundary conditions is only interesting 

when modeling a large-scale geometry, as a city, or in the case of important site or site-city 

effects where the periodicity is not verified and it is required a “far” field for the waves to 

dissipate. Therefore, for engineering practice the tie boundary condition remains the preferred 

lateral boundary condition for SSI and SSSI analysis. 
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Figure 5-14 Variation of the soil frequency with the side dimension of the, squared geometry, 
finite domain. 

5.5. Conclusion  

The analysis done using the 1DT-3C modeling technique show that SSSI is observed in the 

direction of the first translational mode shape of the building. Considering SSSI gives an 

amplification of motion, not taken into account when only an isolated building is considered. 

In addition; 

- In a soft soil, the seismic response of the excited building does not have important variations 

caused by the different buildings placed nearby. This effect suggests that when the first mode 

shape of the building is excited ( = ), the SSSI is less evident. 

- The structural seismic response in a SSSI analysis, compared with the case of single building, 

attains  % of reduction and the variability is less pronounced, when the target building is 

excited. Instead, when the nearby building is excited the seismic response of the target building 

has a variability of ±  %.  

- In a soft soil, a stiff nearby building does not have a remarkable effect on the seismic response 

of the target building, inducing a slight  % reduction of the seismic response, compared with 

the case of single building, with small variability for the different buildings. 

- In a soft soil, when the target building is excited, its structural seismic response can attain a 

reduction until  % for a target to nearby building fundamental frequency ratio  / ≈ . .  
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- In a soft soil, when the nearby building is excited, the seismic response of the target building 

has a variability of ±  % when the nearby building is more flexible, for a target to nearby 

building fundamental frequency ratio / ≈ . . 

- The 3D-3C model is considered to study lateral boundary condition influence on soil 

response. The periodicity lateral boundary condition that induces zero horizontal stresses in the 

soil, remains the preferred assumption for engineering practice, due to the important reduction 

of the soil domain to analyze. When the periodicity assumption is not verified, the dashpots 

represent a satisfactory absorbing boundary condition. They can be applied as lateral boundary 

condition. However, the modeled soil domain becomes important, because the condition of 

zero horizontal stresses is not imposed but is attained using huge soil domain. 

The increased number of influencing parameters in a SSSI analysis (stiffness of soil, relative 

stiffness of buildings and which building is excited) demands further work for a generalization 

of results.  

  



Chapter 6 - Conclusions and perspectives 

141 

 

Chapter 6 - Conclusions and perspectives 

In professional practice, the concept of design of a civil engineering structure that resists to 

horizontal forces was introduced in the 1970s in European seismic design codes to guarantee 

safety against earthquakes and other phenomena that acts horizontally on a structure as wind. 

However, design norms advance according to new findings and with the increasing progress of 

computer capacities. Today, the European seismic design codes still do not consider SSI and 

SSSI in the conception of structures. This research proposes modeling techniques to evaluate 

soil and structure dynamic responses to earthquakes, taking into account SSI and SSSI for 

conception purposes. This research aims to introduce in building design parameters taking into 

account SSI and in the urban planning the concept of SSSI. 

The 3-D soil model permits taking into account the spatial variability of soil properties, 

topography effects, foundation deformability, rocking effects and the presence of a group of 

buildings at the soil surface. On the other hand, the 1-D model avoids modeling problems 

related to the definition of lateral boundary conditions and the lack of geotechnical data to 

produce a detailed 3-D soil model and strongly reduces the computational time. A one-direction 

three-component (1D-3C) seismic wave propagation approach is proposed to take into account 

SSI in professional practice using any commercial FE code. The seismic response of soil and 

building can be simulated considering site effects and soil-structure interaction for linear and 

nonlinear soil behavior.  

The 1D-3C wave propagation model for SSI is limited to the assumption of rigid shallow 

foundation, and negligible rocking effects. The 1DT-3C seismic wave propagation approach is 

proposed as modeling technique for the simulation of the seismic response of soil and building, 

taking into account site effects, the foundation deformability, rocking effects and, eventually, 

SSSI. The 1DT model consists on adopting a fully 3-D model until a fixed depth, where SSI 

and SSSI effects are considered to modify the ground motion and a 1-D model is supposed a 

sufficient approximation.  

The 1DT-3C wave propagation approach is verified by comparison with a fully 3-D model, in 

the case of vertical propagation in a horizontally layered soil, considering linear and nonlinear 

soil behavior. The proposed 1DT-3C modeling technique is an efficient tool for building design 

allowing SSI to be taken into account in an effective and easy way, providing benefits in 

modeling and computation time comparing to a fully 3-D model. In fact, geotechnical 

parameters are easy to characterize for a one-dimensional soil model (using a single borehole 
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investigation) and boundary condition definition is simple (the input signal and the absorbing 

boundary condition are given for only one element moreover, the mesh is considerably reduced. 

The dynamic equilibrium equation for the soil-structure assembly is solved in 1 hour 11 

minutes using the 1DT-3C model and in 14 hours using the 3D-3C model, for an input motion 

of 120 s, on the CINES cluster using 1 core and 24 nodes. 

The proposed 1DT-3C approach is used modeling different soil profiles and structure frames 

in the objective to understand the SSI phenomenon. The results for SSI analyses show that: 

➢ The frequency content of the seismic load imposed at the bottom of the building can be 

more significant for the building deformation than the concept of expected maximum 

ground acceleration amplitude, derived from building design in static conditions.  

➢ The SSI effect appears more important in the case where the soil is softer.  

➢ The resonance between building, soil and earthquake frequency content produces an 

amplified seismic response.  

➢ The SSI effect is observed at the soil surface for both translational mode shapes and it 

is more pronounced, for the structural behavior, in the direction of the building mode 

shape excited by the input load.  

The results confirm the impact of SSI effect on responses of both soil and buildings. Further 

studies are undertaken, using the 1DT-3C wave propagation approach, to understand the effect 

of SSI on the structural seismic response for building seismic design. The SSI effect, defined 

as the difference between the direct solution of the dynamic equilibrium problem of the 

assembly of soil and building (one-step solution) and the FF motion applied to a fixed-base 

building (two-step analysis), in terms of maximum acceleration ratio a _ /a _ , is 

estimated for different cases. A parametric analysis combining 11 soil profiles and 5 different 

frame structures is undertaken, in linear elastic regime, using a synthetic narrow-band signal 

with predominant frequency equal to that of the structure and a recorded large-band seismic 

signal of L’Aquila earthquake (Mw 6.3). The results show that: 

➢ The SSI ratio a _ /a _  is maximum for the resonance of soil and building, 

for both cases of synthetic narrow-band signal exciting the building and for recorded 

large-band seismic signal, and for the five selected RC frame structures. 

➢ In the analyzed cases, the SSI effect reduces the seismic response of about 30-40% for 

the resonance of soil and building and can induce some negligible amplification for 
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other values of the building to soil frequency ratio. The results are similar for all the 

analyzed structures, with an increase of variability in the case of large-band input 

exciting the building fundamental frequency, compared with the narrow-band input 

signal.  

➢ The SSI can be taken into account using a correction factor applied to the result of a 

two-step analysis (FB building model loaded by a FF seismic signal). This correction 

factor depends on the building to soil fundamental frequency ratio / . 

➢ The variability of SSI effect is high, for ground types B, C and D, in particular for softer 

soils. Consequently, it is more convenient to generalize the problem by characterizing 

SSI with respect to the building to soil fundamental frequency ratio /  

This parametric analysis is repeated to investigate the influence of nonlinear soil behavior and 

nonlinear RC behavior on structural seismic response and SSI, compared with the linear 

behaving assumption. The results give: 

➢ With an increasing soil softness and attained nonlinearity, the structural seismic 

response increases for linear behaving soil and decreases for nonlinear behaving soil 

(the attained nonlinearity level increases). 

➢ The effect of soil nonlinearity on the structural seismic response is preponderant 

compared with the effect of the RC nonlinearity. 

➢ The attainment of strains in the nonlinear plastic range, for soil or soil and structure, 

tends to increase the irregularity of the structural seismic response. Moreover, the 

nonlinearity of soil and structure modifies the vibration frequency during the process. 

Consequently, taking into account the nonlinear behavior of materials, the structural 

seismic response considering SSI becomes unpredictable using a simple correction 

factor depending only on the elastic building to soil fundamental frequency ratio / , 

applied to a two-step analysis. 

This parametric analysis confirms some results of the literature concerning SSI analyses and 

shows that general results can be obtained in a linear elastic regime for structural design taking 

into account SSI. Coupling seismic site effects and SSI for nonlinear behaving materials 

demands a specific one-step SSI analysis.  
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A parametric analysis, using the 1DT-3C modeling technique in the linear elastic regime, is 

developed to study the influence of SSSI on a target building having different nearby structure. 

Results show that:    

➢ SSSI is observed in the direction of the first translational mode shape of the building. 

Considering SSSI gives an amplification of motion, not taken into account when only 

an isolated building is considered.  

➢ In a soft soil, the seismic response of the excited building does not have important 

variations caused by the different buildings placed nearby. This effect suggests that 

when the first mode shape of the building is excited ( = ), the SSSI is less evident. 

➢ The structural seismic response in a SSSI analysis, compared with the case of single 

building, attains  % of reduction and the variability is less pronounced, when the 

target building is excited. Instead, when the nearby building is excited the seismic 

response of the target building has a variability of ±  %.  

➢ In a soft soil, a stiff nearby building does not have a remarkable effect on the seismic 

response of the target building, inducing a slight  % reduction of the seismic 

response, compared with the case of single building, with small variability for the 

different buildings. 

➢ In a soft soil, when the target building is excited, its structural seismic response can 

attain a reduction until  % for a target to nearby building fundamental frequency ratio / ≈ . .  

➢ In a soft soil, when the nearby building is excited, the seismic response of the target 

building has a variability of ±  % when the nearby building is more flexible, for a 

target to nearby building fundamental frequency ratio / ≈ . . 

➢ The periodicity lateral boundary condition that induces zero horizontal stresses in the 

osil, remains the preferred assumption for engineering practice, due to the important 

reduction of the soil domain to analyze. When the periodicity assumption is not verified, 

the dashpots represent a satisfactory absorbing boundary condition. They can be applied 

as lateral boundary condition. However, the modeled soil domain becomes important, 

because the condition of zero horizontal stresses is not imposed but is attained using 

huge soil domain. The increased number of influencing parameters in a SSSI analysis 
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(stiffness of soil, relative stiffness of buildings and which building is excited) demands 

further work for a generalization of results. 

In conclusion, this research provides a 1DT-3C modeling technique to study SSI and SSSI 

effects, for linear and nonlinear material behavior. Furthermore, it shows a potential 

improvement of the design spectra proposed by the Eurocode 8 in the elastic regime. The 

nonlinear behavior of material causes a change in the seismic response of soil and buildings 

hence, results are unpredictable using only the parameters adopted for linear material behavior. 

The 1DT-3C wave propagation approach used for SSSI analysis is a tool to inspire the design 

of seismic risk mitigation tools and urban organization. The parametric analysis gives 

preliminary results that do not permit a generalization yet. 

The evolution of this research can evolve in an extensive parametric analysis and statistical 

study to generalize the conception of structures in seismic zones considering SSI effects in the  

Eurocode 8. On the other hand, the 1DT-3C modeling technique can help the design of risk 

mitigation tools. To allow the verification of the numerical model, experiments on 

instrumented structures in real and proportional scales could be used to compare the numerical 

and experimental structural response to dynamic loading.  

The 1DT-3C wave propagation approach could evolve to model underground floors and deep 

foundations, with 3-D soil domain arriving at a greater depth. An effective stress analysis, 

taking into account the water table position in a 1DT-3C wave propagation model for SSI, is 

currently developed in the framework of the PhD thesis of Stefania Gobbi. 

Other improvements can be the introduction of, corrosion of the steel bars in the reinforced 

concrete or different construction material for the structure can be adopted as wood and steel.  
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Appendix A - Nonlinear behavior of RC 
 

 

The behavior of reinforced concrete is no longer linear when cracks initiate in beams and 

columns, and the steel start working. The distribution of steel in a beam section or column 

section is not necessary uniform and symmetrical, consequently, an homogenization is 

difficult. The constitutive maws for RC sections are deduced in terms of generalized stresses 

and strains and used in the nodes of a 1-D beam element. 

 Constitutive relationship in terms of generalized stresses 

A 3-D beam having a rectangular section with cross-sectional area � = ×  cm² and a 

length of  m (Figure E-1), is used as example to explain the adopted procedure. 

 

Figure E-1 Reinforced unit length 3-D beam (left) and beam cross-section (right) 

When the nonlinear behavior of RC is taken into account, the Hognestad’s parabola is selected 

as first-loading curve plotted in Figure E-2 for a cubic characteristic concrete strength  � =  N/mm² in compression.  
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Figure E-2 Hognestad’s parabola. 

 
 

 Axial behavior 

 
 

Figure E-3 Abaqus capture of the unit length beam subjected to axial loading. 

 
A first static analysis is run to study the axial behavior of the RC beam an increasing axial 

pressure of maximum � = ×  N/m² is applied as shown in Figure E-3. A  cm thick 

steel plate is used to uniformly distribute the pressure in the beam cross-section.  
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Considering that the beam has unit length, the calculated axial displacement corresponds to the 

axial strain. The constitutive relationship is obtained in terms of generalized stresses and strains N,  and imposed to nodes of a 1-D beam model, after verification of the elastic relationship N = σ  � = � . 

The model using beam elements, subjected to the same boundary conditions is compared with 

the 3-D model, and the verification of the obtained response of the 1-D beam element is shown 

in Figure E-4. 

 

Figure E-4 Strain time history under axial loading: comparison between 1-D and 3-D beam 
modeling. 
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 Bending moment 1 

 

Figure E- 5 Abaqus capture of the unit length beam subjected to bending moment in x-
direction. 

A static analysis is undertaken to obtain the constitutive law in terms of generalized stress and 

strain M ,K . An increasing axial pressure of maximum � = ×  N/m² is applied in 

a band of  cm as shown in Figure E- 5. A  cm  thick steel plate is used to uniformly 

distribute the pressure in the beam cross-section. Considering the unit length of the beam, the 

axial displacement  calculated, at the top and bottom, at the free edges of the beam is used 

to evaluate the curvature  K = (u − − u − )/ / ℎ/  .  

The constitutive relationship is obtained in terms of generalized stresses and strains M ,K  

and imposed to the nodes of a 1-D beam model, after verification of the elastic relationship 

 M /K = E�  where E is the Young modulus, �  is the moment of inertia around the -axis 

and M = σ ℎ −  Δ . The parameters ,  and ℎ are defined in Figure E- 6 and Δ  is is 

the time increment. 
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Figure E- 6 Diagram of the beam section (left) and of the deformed section after the application 
of the bending moment in x-direction (right). 

The model using beam elements, subjected to the same boundary conditions is compared with 

the 3-D model, and the verification of the obtained response of the 1-D beam element is shown 

in Figure E- 7. 

 

Figure E- 7 Displacement time history, comparison between 1-D and 3-D analysis in bending 
moment loading in direction x. 
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 Bending moment 2 

 

Figure E- 8 Abaqus capture of the unit length beam subjected to bending moment in y-
direction. 

A static analysis is undertaken to obtain the constitutive law in terms of generalized stress and 

strain M ,K . An increasing axial pressure of maximum � = ×  N/m² is applied in 

a band of  cm as shown in Figure E- 8. A  cm  thick steel plate is used to uniformly distribute 

the pressure in the beam cross-section. Considering the unit length of the beam, the axial 

displacement  calculated, at the top and bottom, at the free edges of the beam is used to 

evaluate the curvature  K = (u − − u − )/ / /  , the parameters b, u −  and u −  are defined in Figure E- 9.  

The constitutive relationship is obtained in terms of generalized stresses and strains M ,K  

and imposed to the nodes of a 1-D beam model, after verification of the elastic relationship 

 M /K = E�  where E is the Young modulus, �  is the moment of inertia around the -axis 

and M = σ ℎ −  Δ . The parameters ,  and ℎ are defined in Figure E- 9 and Δ  is is 

the time increment. 
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Figure E- 9 Diagram of the beam section (left) and of the deformed section after the application 
of the bending moment in y-direction (right). 

The model using beam elements, subjected to the same boundary conditions is compared with 

the 3-D model, and the verification of the obtained response of the 1-D beam element is shown 

in Figure E- 10. 

 

Figure E- 10 Displacement time history, comparison between 1-D and 3-D analysis in bending 
moment loading in direction y. 

 

 Section definition and RC material definition in Abaqus 

After creating the Abaqus and completing the geometry the mesh the steps of analysis the field 

and history outputs, the loadings and the boundary conditions and creating the job, it is 
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mandatory to create sets in module Part for each group of beams and columns that have the 

same steel reinforcement and beam or column section, together. 

The material and property are not to be defined. From module Job, Job Manager click on write 

input. Open the .inp file as text file and add the following text for each defined SET. 

*Beam General Section, elset=SET, section=NONLINEAR GENERAL �, , , , , ,  � � : Area,  : Moment of inertia for bending about the 1-axis,   : Moment of inertia for 

cross bending,  : Moment of inertia for bending about the 2-axis,    : Torsional constant,  

: Sectorial moment OPTIONAL needed in Abaqus/Standard when the section is associated 

with open-section beam elements,  � : Warping constant OPTIONAL needed in 

Abaqus/Standard when the section is associated with open-section beam elements 

 �, � , �� 

� : Local -coordinate of centroid, . The default is 0., � Local -coordinate of 

centroid, . The default is 0 , �� : Thickness of segment ending at this point, The default is -

1.  

�, � , ��  

� : Local -coordinate of shear center, . The default is 0., � : Local -coordinate of 

shear center, . The default is 0. , �� : Thickness of segment ending at this point, The default 

is -1.  THIS LINE IS OPTIONAL 

*AXIAL 

0,0 

…  

0,  ��� 

Insert Tabular ,  of the centroid of the beam section. The axial behavior tabular starting 

with 0,0 and ending 0,  corresponding to the ultimate point 

*M1 

0,0 

…  

0,  � � 



Appendix A - Nonlinear behavior of RC 

165 

 

Insert Tabular , � . The Moment curvature tabular in direction 1 starting 0,0 and ending 

0,  corresponding to the ultimate point 

*M2 

0,0 

…  

0,  � � 

Insert Tabular , � . The Moment curvature tabular in direction 1 starting 0,0 and ending 

0,  corresponding to the ultimate point 

*TORQUE 

…  

add the torque tabular starting 0,0 

*Damping, alpha=xxx, beta=xxx 

Corresponding to Reighley damping 

*Transverse Shear � , � , 

Corresponding to shear correction factor in Timoshenko beam elements 

 

Refer to Abaqus manual for more information and beam general section options 26.3.7 Using 

a general beam section to define the section behavior 

 

 

Example of the general beam section definition in the input file 

*Beam General Section, elset=_I1, section=NONLINEAR GENERAL 

0.18, 0.00135, 0., 0.0054, 0.0037098 

0.,0.,-1. 

*AXIAL 

0,0 

436170.6,9.02396E-005 
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… 

7879644,0.0208312 

0,0.021 

*M1 

0,0 

42000,0.0002786545 

… 

600000,0.41798 

0,0.42 

*M2 

0,0 

25500,0.00070586333333333 

… 

150000,0.26877566666667 

0,0.27 

*TORQUE 

0,0 

10643750000,0.0037098 

*Damping, alpha=0.471756, beta=0.00529881 

*Transverse Shear 

2.007e+09, 2.007e+09, 

 

 

 

Defining the nonlinear behavior of the concrete in Abaqus  
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Defining the nonlinear behavior of the steel in Abaqus  
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Appendix B - 1D-3C model for SSI analysis 
 

 
This guide is intended for users who will exercise research or engineering in earthquake design. 

A step-by-step procedure is described to model the 1-D soil model of linear behavior 

introduced in 0 for SSI analysis. 

 1-D soil model 

 

1. Choose the module Part  

2. Click on the icon Create Part  

3. Choose a Name for your part  

4. Select the Modeling space → 3D 

5. Select the Type → Deformable 

6.  Select the Base Feature → Shape → Solid  

7. Select the Base Feature →  Type → Extrusion 
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8.  Continue 

 

 

 
1. Click on the icon Create Lines: Rectangle → Draw a rectangle 

2. Click on the icon Add Dimension → Correct the dimension of the rectangle to  ×  ² 

3. Click on Done  

4. Write the Depth in the new dialog  →   

OK 
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1. Click on the icon Create Datum Plane: Offset From Plane  

2. Click on the plane you want to offset from    

3. Choose the direction of offset 

4. Write the Offset distance in the new dialog  → �  

5. Press Enter 

Repeat this step in order to have planes in the intersection of layers 

 



 

174 

 

 

 
1. Click on the icon Partition Cell: Use Datum Plane  

2. Select the cell(s) to partition, for the first partition this step is omitted  

3. Select the datum plane to define the cutting plane  

4. Click on Create Partition 

Repeat this step in order to partition all the layers 
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Choose the module Property 

1. Click on the icon Material Manager   

2. Click on the icon Create 

3. Choose a Name for your material  

4. Select from the catalogue General → Density, enter the density of the material.  

PS: Don’t forget to multiply the density by the area 

5. Select from the catalogue Mechanical → Elasticity, enter the Young modulus and the 

poison ratio of the material. 

PS: Don’t forget to multiply the Young modulus by the area 

6.  Click OK  

Repeat this step in order to have a material for each layer 
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1. Click on the icon Section Manager   

2. Click on the icon Create → Choose a Name for your section  

                                         → Select Solid from Category 

                                         → Select Homogeneous from Type 

3. Continue 

4. Select the material from the catalogue  → Soil-1  

5. Click OK  

Repeat this step in order to have a section for each material 
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1. Click on the icon Section Assignment Manager   

2. Click on the icon Create  

3. Select the Regions to be assigned a section and a Name for this region  

Click Done 

4. Select the Section from the catalogue  → Section-1  

5. Click OK  

Repeat this step in order to assign a section for each layer 
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Choose the module Assembly 

1. Click on the icon Create Instance 

2. Choose the SOIL Part from the list of Parts  

3. Click OK 
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1. Double click on Sets 

2. Name the Set → Continue → Select all bottom geometric nodes 

3. Click on Done 

4. Double click on the icon Springs/Dahpots → Name → Select Connect points to 

ground 

5. Select points from the Sets catalogue → Select all bottom nodes → Continue → Done 

6. Select the degree of freedom 1 → disable Spring stiffness → Enable Dashpot 

coefficient → Enter the value of damping → OK 

PS. Don’t forget to divide by the number of bottom nodes    

Repeat this step for the degrees of freedom 2 and 3 
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Choose the module Mesh 

1. Click on the icon Seed Edges → Meshed By size → Approximate element size 1 → OK 

2. Done 

3. Click on the icon Assign Element Types → Select the region to mesh → Done  

4. From Family select 3D Stress → from Geometric Order enable Quadratic → OK 

5. Click on YES 
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Choose the module Interaction 

1. Click on the icon Create Constraint → Select Tie  → Continue 

2. Choose the master type Surface 

3. Select a lateral surface of the column → Then choose the slave type Surface → Select 

the opposite lateral surface of the column 

4. Specify distance 1.1 → disable Adjust slave surface initial position → OK 

Repeat this step for the other two opposite lateral surfaces 
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 3-D building model 

 

1. Double click on Parts  

2. Choose a Name for your part  

Select the Modeling space → 3D 

Select the Type → Deformable 

 Select the Base Feature → Shape → Wire  

3. Sketch the floor plan of the building as shown in the picture 

4. Adjust the dimensions  

Continue 
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1. Click on the icon Create Datum Plane: 3 Points and create the plane using the 

selecting red points as shown 

2. Click on the icon Create Datum Plane: Offset From Plane 

Select the plane you want to offset from    

Choose the direction of offset 

Write the Offset distance in the new dialog  → .   

3. Press Enter 

Repeat this step in order to have a plane for each level 
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1. Click on the icon Create Wire Planar  

2. Select a plane on which you want to sketch a planar wire    

3. Select an edge that will appear on the write of the screen 

Following 

 

1. Click on the icon Project Edges  

2. Select the edges to project onto the sketch   →  
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3.   

4.  

Repeat this step in order to have the plan wire for each floor 

 

 

Click on the icon Create Datum Plane: 3 Points and create the plane using the 

selecting red points as shown 

Repeat this step in order to have datum plans as shown 
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1. Click on the icon Create Wire Planar  

2. Select a plane on which you want to sketch a planar wire    

3. Select an edge that will appear on the write of the screen 

 

1. Click on the icon Create Wire  

Sketch wire to create the column as shown 

2.   
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1. Click on the icon Create Wire Planar  

2. Select a plane on which you want to sketch a planar wire    

3. Select an edge that will appear on the write of the screen 

Following 
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1. Click on the icon Project Edges  

2. Select the edges to project onto the sketch   →  

3.   

4.  

Repeat this step in order to have the plan wire for all y-z datum plans 



Appendix B - 1D-3C model for SSI analysis 

189 

 

 

1. Double click on the icon Inertias → Name → Nonstructural mass 

2. Select the region to assign nonstructural mass → Select Edge Beams → From Units 

select Mass per Length, from Magnitude input �  → OK 

3. Select the region to assign nonstructural mass → Select Middle Beams→ From Units 

select Mass per Length, from Magnitude input  → OK 
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Choose the module Property 

1. Click on the icon Create Material → Choose a Name for your material  

2. Select from the catalogue Mechanical → Damping, enter the damping coefficients. 

3. Select from the catalogue General → Density, enter the density of the material.  

4. Select from the catalogue Mechanical → Elasticity, enter the Young modulus and the 

poison ratio of the material. 

5. Click OK  
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1. Click on the icon Create Section   

2. Choose a Name for your section → Select Beam from Category → Select Beam from 

Type → Continue 

3. Click on the icon Create Beam Profile → Choose a Name for your Profile → Select 

Rectangular from Shape → Continue 

4. Input a and b 

5. Choose the material from Basic → Material Name 

6. Enable Specify transverse shear from Stiffness  →  input K23 and K13 → OK 

Repeat this step in order to create a section for beam and column section type 
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1. Double Click on the icon Sets   

2. Create Sets for all the beams on the same level  

3. Create Sets for all the columns on the same level  

As shown in the Fugure 
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1. Click on the icon Assign Section  

2. Click on the icon Create → Choose a Region from sets  

                                         → Select a section from Section  

Repeat this step in order to have a section for all columns and beams as shown in 

the Figure 
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1. From Property default choose Sections 

 

1. Double Click on the icon Sets 

2. Create sets for beams in the direction x-z → beams in the direction y-z → columns as 

shown in the yellow square → columns as shown in the aqua blue square 
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1. Select from View → Part Display Options  

2. Enable  → Render beam profiles  

             → Render shell thickness 

 

Choose the module Assembly 

1. Click on the icon Create Instance 
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2. Choose the Building Part from the list of Parts  

3. Click OK 

 

1. Click on the icon Rotate Instance → Select the building part → Done 

2. Select a start point for the axis of rotation , ,  

3. Select an end point for the axis of rotation , ,  

4. Input Angle of rotation  

Press Enter →  OK 
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1. Select from Constraint → Coincident Point  

2. Select a point of the movable instance  

3. Select a point of the fixed instance  



 

198 

 

 

Choose the module Part 

1. From building part  

2. Double click on Sets 

3. Create Geometry set for all Bottom nodes of the building → Continue 

 

1. From soil part  

2. Double click on Sets 
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3. Create Geometry set for one top node of the soil → Continue 

 

Choose the module Interaction 

1. Click on the icon Create Constraint 

2. Select Equation 

3. Input in table following this Figure  

Repeat this step in order to have a constraint for DOF 1, 2 and 3 
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Choose the module Mesh 

1. Click on the icon Seed Edges → Meshed By size → Approximate element size 1 → OK 

2. Done 

 

1. Click on the icon Assign Element Types → Select the region to mesh → Done  

2. From Family select Beam → from Geometric Order enable Quadratic → OK 

3. Click on the icon Mesh Part 

4.  



Appendix B - 1D-3C model for SSI analysis 

201 

 

 Calculation procedure 

Combination of static and dynamic response 

The static and dynamic response of the structure can be superposed only in the case considering 

a linear elastic system. In the case of inelastic systems, the dynamic response of the structure 

must consider the stresses and strains existing in the structure due to its static response. In the 

presented work, dry soil is adopted, and static response of the system is negligible compared 

to the dynamic one. Hence the static response is not considered, only dynamic response of the 

structure is calculated.  

 

 

Choose the module Step 

1. Click on the icon Create Step 

From Procedure Type → select Linear perturbation → select Frequency → 

Continue 



 

202 

 

2. From Other enable Mass  

3. From Basic enable value →  

Enable Minimum frequency → .  

Enable Maximum frequency → � → OK 

 

 

 

1. Click on the icon Create Step 

2. From Procedure Type → select General → select Dynamic Implicit → Continue 

3. From Basic → Time period → input  

4. From Incrementation → enable Automatic → 

For Maximum number of increments input   

For Increment size → Initial input  . � → Minimum input −  

5. From Other → Convert severe discontinuity iterations → OFF → Extrapolation of previous state at start of each increment → Linear → Time Integrator Parameter → Alpha → enable Specify → − .  
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Choose the module Load 

1. Click on the icon Create Boundary Condition 

2. From Step → select Initial 

From Category → select Mechanical  

From Types for selected step→ select Symetry/Antisymetry/Encastre → Continue 

3. Select the bottom face of the soil → Enable Encastre  → OK 

4. Select Ptopagated in Step-2 and Deactivate  
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1. Click on the icon Create Boundary Condition 

2. From Step → select Initial 

From Category → select Mechanical  

From Types for selected step→ select Displacement/Rotation → Continue 

3. Select from sets all building bottom nodes → Enable UR1, UR2 and UR3  → OK 
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1. Click on the icon Create Load 

2. From Step → select Step-2 

From Category → select Mechanical  

From Types for selected step→ select Concentrated Force → Continue 

3. Select the bottom nodes of the soil → Input = . � +  and 

 = =  → Select Create Amplitude 

4. Select Tabular → Continue 

5. Enter tabular of the signal → OK 

6. OK 
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1. Double Click on the icon F-Output-1 

2. Domain → Whole model 

Select U from Displacement/Velocity/Acceleration → OK 
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1. Double Click on the icon F-Output-2 

2. Domain → Whole model 

Frequency → every x unit of time → x =  

Select U,V and A from Displacement/Velocity/Acceleration  

Select S from Stress 

Select E from strain → OK 
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1. Double Click on the icon Set from Assembly 

2. Name the set → enable Geometry → Continue → select a bottom node of the soil → 

Done 

3. Repeat steps 1 and 2 only this time select a bottom node of the building 

4. Repeat steps 1 and 2 only this time select a top node of the building 
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1. Double Click on the icon History Output Requests 

2. Domain → Set → soil bottom node set 

Frequency → every x unit of time → x = .  

Select UT,VT and AT from Displacement/Velocity/Acceleration → OK 

Repeat this step for building bottom node set and building top node set 
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Choose the module Job 

1. Click on the icon Create Job 

2. Select Model-1 → Continue 

3. Submit 
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Appendix C - Soil behavior calibration 
 

The fundamental concepts of plasticity theories are sufficiently general, to be developed in 

Abaqus for a wide range of materials successfully. 

 Equation proof 

A yield surface, to determine if the material responds elastically at a certain state of stress, is 

needed. 

Tests on soils provide the backbone curve for a half cycle shear stress-strain. 

But Abaqus asks for stress-strain data obtained from the first half cycle of a unidirectional 

tension or compression experiment. 

To obtain yield axial stress-strain curve from yield shear stress-strain curve 
0 0and  are 

calculated as follow  

 

 σ = √  τ γ  (B- 1) 

 = √  γ G /E  (B- 2) 

Proof: 

Von Mises Criteria  

 

 σ = /√  √ σ − σ + σ − σ + σ − σ +  τ + τ + τ  (B- 3) 

 

Where 
0 is the yield stress, then for uniaxial cases 

 

 σ = /√  √ σ +  τ  (B- 4) 

 σ = √σ +  τ  (B- 5) 

 

 

That can be written as an ellipse equation  
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 σ + τ = σ  (B- 6) 

Or 

 σ /σ + τ /(σ /√ ) =  (B- 7) 

 

The ratio between the big axe and the small axe would be 

 

 σ / τ = σ /τ = σ /(σ /√ ) = √  (B- 8) 

Hence  

 

 σ = √ τ  (B- 9) 

 

Then we can determine  as following 

 

 

σ = √  τ γ  E = √  G γ E/E  E  = √  G/G  G  γ E/E  E  = √  G/G  G  γ = √  G /E  γ 

(B- 

10) 

   

 Calibration 

Once σ  and  data are calculated, the calibration experiment should be performed at a strain 

range, Δ  that corresponds to the strain range anticipated in the analysis because the material 

model does not predict different isotropic hardening behavior at different strain ranges. For that 

reason, i suggest taking the minimum  Δ   accepted by Abaqus. 

Two possible ways to enter data; by importing a .txt file or by entering data manually. For this 

step, total strain must be provided. 
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Abaqus/CAE Usage: Property module: calibration → Data Set: σ ,   

PS: For SSI analysis you need to multiply the stress by the area chosen for the analysis in order 

to have the correct dynamic equation 

In Abaqus/CAE Usage: Property module: calibration → Edit Behavior: 

Three behavior types are available: 

➢ Elastic Isotropic 
➢ Elastic Plastic Isotropic 
➢ Hyperelasticity with Permanent Set 

For our analysis, Elastic Plastic Isotropic in chosen. 
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 In the Editor, you need: 

 

➢ First: To indicate the data set 

➢ Second: To Calculate or to choose an Ultimate point.  

I recommend choosing the calculator tool, it indicates the last point you have given in 

your set data. You can always enter manually the point coordinates simply by writing 

them in the text bar or providing it with the set data. 
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➢ Third: To pick a yield point. When you pick a yield point the young’s modulus is 

calculated, simply by calculating the slope. This way you can verify if the yield point 

you have picked corresponds to your soil. To help doing this procedure, I strongly 

recommend to switch plastic points to max and to use the text bar to increment 

manually the abscissa (or strain). By pressing ENTER Abaqus will calculate the 

ordinate (or stress). This procedure takes few minutes, yes, it is by trial and error. The 

purpose is, to estimate a Young’s modulus as close as possible from the real Young’s 

modulus and to have the second point in the table with an ordinate or stress greater 

than E/ , where  is the elastic strain or abscissa of the first point in the table. 

➢ ‑ourth: To enter the Poisson’s ratio, in this analysis it is entered as a constant value by 

typing the value in the text bar  

Now, you create a material by clicking on the button next to Material, you name it, and 

you click on OK. 

 Elasticity definition 

The Abaqus plasticity models also need an elasticity definition to deal with the recoverable 

part of the strain. In Abaqus the elasticity is defined by including linear elastic behavior 

 

 

Go to 

Abaqus/CAE Usage: Property module: material  

You will find in your editor: Elastic and Plastic properties  

Click on Elastic correct the Young’s Modulus if needed  
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 Plasticity definition 

Adjusting the Plastic behavior according to yout material 

 

 

 

Click on Plastic correct the first Yield Stress by E/  if needed. For this analysis: 

Hardenning → Combined 

Data type → Half Cycle 

Number of backstresses →  

Use temperature-dependent data → disabled  

Number of field variables →  

 Density definition 

Do not forget to enter your material’s Density  
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Abaqus/CAE Usage: Property module: material editor: General→Density: 
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Appendix D - Guide for 1DT-3C model for SSI and SSSI in 

Abaqus 
 

This guide is intended for users who will exercise research or engineering in earthquake design. 

A step-by-step procedure is described to model the 1DT soil model of nonlinear behavior 

introduced in Chapter 3 -  for SSI analysis. 

 

 1DT soil model 

 

1. Choose the module Part  

2. Click on the icon Create Part  
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3. Choose a Name for your part  

4. Select the Modeling space → 3D 

5. Select the Type → Deformable 

6.  Select the Base Feature → Shape → Solid  

7. Select the Base Feature →  Type → Extrusion 

8.  Continue 

 

 

 
1. Click on the icon Create Lines: Rectangle → Draw a rectangle 

2. Click on the icon Add Dimension → Correct the dimension of the rectangle to  ×  ² 

3. Click on Done  

4. Write the Depth in the new dialog  →   
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OK 

 

 

 
1. Click on the icon Create Datum Plane: Offset From Plane  

2. Click on the plane you want to offset from    

3. Choose the direction of offset 

4. Write the Offset distance in the new dialog  →   

5. Press Enter 

Repeat this step in order to have planes in the intersection of layers 
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1. Click on the icon Partition Cell: Use Datum Plane  

2. Select the cell(s) to partition, for the first partition this step is omitted  

3. Select the datum plane to define the cutting plane  

4. Click on Create Partition 

Repeat this step in order to partition all the layers 
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Create new Part 

1. Click on the icon Create Lines: Rectangle → Draw a rectangle 

2. Click on the icon Add Dimension → Correct the dimension of the rectangle to  � × � ² 
3. Click on Done  

4. Write the Depth in the new dialog  → �  

OK 
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Choose the module Property 

1. Click on the icon Material Manager   

2. Click on the icon Create 

3. Choose a Name for your material  

4. Select from the catalogue General → Density, enter the density of the material.  

PS: Don’t forget to multiply the density by the area 

5. Select from the catalogue Mechanical → Elasticity, enter the Young modulus and the 

poison ratio of the material. 

PS: Don’t forget to multiply the Young modulus by the area only for the soil modeled 

in 1-D 

6.  Click OK  

Repeat this step in order to have a material for each layer 
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6. Click on the icon Section Manager   

7. Click on the icon Create → Choose a Name for your section  

                                         → Select Solid from Category 

                                         → Select Homogeneous from Type 

8. Continue 

9. Select the material from the catalogue  → Soil-1  

10. Click OK  

Repeat this step in order to have a section for each material 
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For each Part 

1. Click on the icon Section Assignment Manager   

2. Click on the icon Create  

3. Select the Regions to be assigned a section and a Name for this region  

Click Done 

4. Select the Section from the catalogue  → Section-1  

5. Click OK  

Repeat this step in order to assign a section for each layer 
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Choose the module Assembly 

1. Click on the icon Create Instance 

2. Choose the SOIL Part from the list of Parts  

3. Click OK 

            Repeat this step for the part of 3-D soil 
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1. Double click on Sets 

2. Name the Set → Continue → Select all bottom geometric nodes 

3. Click on Done 

4. Double click on the icon Springs/Dahpots → Name → Select Connect points to 

ground 

5. Select points from the Sets catalogue → Select all bottom nodes → Continue → Done 

6. Select the degree of freedom 1 → disable Spring stiffness → Enable Dashpot 

coefficient → Enter the value of damping → OK 

PS. Don’t forget to divide by the number of bottom nodes    

Repeat this step for the degrees of freedom 2 and 3 
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Choose the module Interaction 

1. Click on the icon Create Constraint → Select Tie  → Continue 

2. Choose the master type Surface 

3. Select a lateral surface of the column → Then choose the slave type Surface → Select 

the opposite lateral surface of the column 

4. Specify distance 1.1 → disable Adjust slave surface initial position → OK 

Repeat this step for the other two opposite lateral surfaces and for the 3-D soil but 

the distance this time would be 25.1 
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In Module Part create datum plane at the mid-top of the 1-D soil and at the mid-bottom 

of the 3-D soil  

1. Click on the icon Create Datum Point : Midway Between 2 Points → Select two 

points 

In Module Assembly 

2. Select Coincidence Point from constraint → Select the datum points created earlier 

3. Both parts will be joined 
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 3-D building model 

 

1. Double click on Parts  

2. Choose a Name for your part  

Select the Modeling space → 3D 

Select the Type → Deformable 

 Select the Base Feature → Shape → Wire  

3. Sketch the floor plan of the building as shown in the picture 

4. Adjust the dimensions  

Continue 
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1. Click on the icon Create Datum Plane: 3 Points and create the plane using the 

selecting red points as shown 

2. Click on the icon Create Datum Plane: Offset From Plane 

Select the plane you want to offset from    

Choose the direction of offset 

Write the Offset distance in the new dialog  → .   

3. Press Enter 

Repeat this step in order to have a plane for each level 
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1. Click on the icon Create Wire Planar  

2. Select a plane on which you want to sketch a planar wire    

3. Select an edge that will appear on the write of the screen 

Following 

 

1. Click on the icon Project Edges  

2. Select the edges to project onto the sketch   →  
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3.   

4.  

Repeat this step in order to have the plan wire for each floor 

 

 

Click on the icon Create Datum Plane: 3 Points and create the plane using the 

selecting red points as shown 

Repeat this step in order to have datum plans as shown 

 

1. Click on the icon Create Wire Planar  
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2. Select a plane on which you want to sketch a planar wire    

3. Select an edge that will appear on the write of the screen 

 

1. Click on the icon Create Wire  

Sketch wire to create the column as shown 

2.   
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1. Click on the icon Create Wire Planar  

2. Select a plane on which you want to sketch a planar wire    

3. Select an edge that will appear on the write of the screen 

Following 
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1. Click on the icon Project Edges  

2. Select the edges to project onto the sketch   →  

3.   

4.  

Repeat this step in order to have the plan wire for all y-z datum plans 
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1. Double click on the icon Inertias → Name → Nonstructural mass 

2. Select the region to assign nonstructural mass → Select Edge Beams → From Units 

select Mass per Length, from Magnitude input �  → OK 

3. Select the region to assign nonstructural mass → Select Middle Beams→ From Units 

select Mass per Length, from Magnitude input  → OK 
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Choose the module Property 

1. Click on the icon Create Material → Choose a Name for your material  

2. Select from the catalogue Mechanical → Damping, enter the damping coefficients. 

3. Select from the catalogue General → Density, enter the density of the material.  

4. Select from the catalogue Mechanical → Elasticity, enter the Young modulus and the 

poison ratio of the material. 

5. Click OK  
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1. Click on the icon Create Section   

2. Choose a Name for your section → Select Beam from Category → Select Beam from 

Type → Continue 

3. Click on the icon Create Beam Profile → Choose a Name for your Profile → Select 

Rectangular from Shape → Continue 

4. Input a and b 

5. Choose the material from Basic → Material Name 

6. Enable Specify transverse shear from Stiffness  →  input K23 and K13 → OK 

Repeat this step in order to create a section for beam and column section type 
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1. Double Click on the icon Sets   

2. Create Sets for all the beams on the same level  

3. Create Sets for all the columns on the same level  

As shown in the Fugure 
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1. Click on the icon Assign Section  

2. Click on the icon Create → Choose a Region from sets  

                                         → Select a section from Section  

Repeat this step in order to have a section for all columns and beams as shown in 

the Figure 
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2. From Property default choose Sections 

 

1. Double Click on the icon Sets 

2. Create sets for beams in the direction x-z → beams in the direction y-z → columns as 

shown in the yellow square → columns as shown in the aqua blue square 
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1. Select from View → Part Display Options  

2. Enable  → Render beam profiles  

             → Render shell thickness 

 

Choose the module Assembly 

1. Click on the icon Create Instance 

2. Choose the Building Part from the list of Parts  
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3. Click OK 

 

1. Click on the icon Rotate Instance → Select the building part → Done 

2. Select a start point for the axis of rotation , ,  

3. Select an end point for the axis of rotation , ,  

4. Input Angle of rotation  

Press Enter →  OK 

 

 3-D foundation  
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Choose the module Part → 3-D Soil Part 

1. Click on the icon Create Datum Plane : Offset from Plane  

2. Create planes to form the edge surfaces of the foundation 
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1. Click on the icon Partition cell : Use Datum Plane  

2. Partition the 3-D soil domain to cut the shape of the embedded foundation 
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Choose the module Property → 3-D Soil Part 

1. Click on the icon Section Manager   

2. Click on the icon Create → Choose a Name for your section  

                                         → Select Solid from Category 

                                         → Select Homogeneous from Type 

3. Continue 

4. Select the material from the catalogue  → Reinforced concrete for the foundation 

And Soil-1 for the soil 
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 Calculation procedure 

 

1. In Module Part create datum point offset from the edge of the foundation by (0.5,0.5,0) 

to the inside of the foundation  

2. In Module Assembly  

Select from Constraint → Coincident Point  

Select a point of the movable instance  

Select a point of the fixed instance  
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Choose the module Part 

1. From building part  

2. Double click on Sets 

3. Create Geometry set for all Bottom nodes of the building → Continue 
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Choose the module Part 

1. From building part  

Double click on Sets 

Create Geometry set for very Bottom node of the building → Continue 

2. From 3-D soil part  

Double click on Sets 

Create Geometry set for very Top node of the foundation that coincides with the first 

node of the building columns → Continue 
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This step needs to be done for each bottom node set from the part building and its 

coincident node set from the foundation in the part 3-D soil 

1. Click on the icon Create Constraint 

2. Select Equation 

3. Input in table following this Figure  

Repeat this step in order to have a constraint for DOF 1, 2 and 3 
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Choose the module Mesh 

3. Click on the icon Seed Edges → Meshed By size → Approximate element size 1 → OK 

4. Done 

 

5. Click on the icon Assign Element Types → Select the region to mesh → Done  

6. From Family select Beam → from Geometric Order enable Quadratic → OK 

7. Click on the icon Mesh Part 
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Choose the module Mesh 

1. Click on the icon Seed Edges → Meshed By size → Approximate element size 1 → OK 

2. Done 

3. Click on the icon Assign Element Types → Select the region to mesh → Done  

4. From Family select 3D Stress → from Geometric Order enable Quadratic → OK 

5. Click on YES 

 

Repeat this step for the part of Foundation Approximate element size 0.5 

Repeat this step for the part of 3-D soil Approximate element size 2 
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1. Double click on the icon Sets: Slave-nodes → Select all nodes in the bottom of the 3-

D soil without edge nodes (as shown in 6) and all node at the top of the 1-D soil except 

one (as shown in 5) in order to do that follow the steps 

2. Click on Display Group Manager 

3. Click on Create 

4. From Item select Part/Model instances → Select 1-D Soil → from Perform a boolean 

on the viewport contents and the selection click Replace  

5. Select the top 3 nodes 

6. Repeat 4 for the 3-D soil → Select all the bottom nodes except nodes at the edges 

7. Repeat from 1 to create Node-Master and select the top node not selected before from 

the 1-D soil part 

8. Create a Constraint Equation as following for the Dof 1,2 and 3 

 

 

Combination of static and dynamic response 

The static and dynamic response of the structure can be superposed only in the case considering 

a linear elastic system. In the case of inelastic systems, the dynamic response of the structure 
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must consider the stresses and strains existing in the structure due to its static response. In the 

presented work, dry soil is adopted, and static response of the system is negligible compared 

to the dynamic one. Hence the static response is not considered, only dynamic response of the 

structure is calculated.  

 

 

Choose the module Step 

1. Click on the icon Create Step 

From Procedure Type → select Linear perturbation → select Frequency → 

Continue 

2. From Other enable Mass  

3. From Basic enable value →  

Enable Minimum frequency → .  

Enable Maximum frequency → � → OK 



Appendix D - Guide for 1DT-3C model for SSI and SSSI in Abaqus 

257 

 

 

 

 

1. Click on the icon Create Step 

2. From Procedure Type → select General → select Dynamic Implicit → Continue 

3. From Basic → Time period → input  

4. From Incrementation → enable Automatic → 

For Maximum number of increments input   

For Increment size → Initial input  . � → Minimum input −  

5. From Other → Convert severe discontinuity iterations → OFF → Extrapolation of previous state at start of each increment → Linear → Time Integrator Parameter → Alpha → enable Specify → − .  
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Choose the module Load 

1. Click on the icon Create Boundary Condition 

2. From Step → select Initial 

From Category → select Mechanical  

From Types for selected step→ select Symetry/Antisymetry/Encastre → Continue 

3. Select the bottom face of the soil → Enable Encastre  → OK 

4. Select Ptopagated in Step-2 and Deactivate  
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1. Click on the icon Create Boundary Condition 

2. From Step → select Initial 

From Category → select Mechanical  

From Types for selected step→ select Displacement/Rotation → Continue 

3. Select from sets all building bottom nodes → Enable UR1, UR2 and UR3  → OK 
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1. Click on the icon Create Load 

2. From Step → select Step-2 

From Category → select Mechanical  

From Types for selected step→ select Concentrated Force → Continue 

3. Select the bottom nodes of the soil → Input = . � +  and 

 = =  → Select Create Amplitude 

4. Select Tabular → Continue 

1. Enter tabular of the signal → OK 

2. OK 
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1. Double Click on the icon F-Output-1 

2. Domain → Whole model 

Select U from Displacement/Velocity/Acceleration → OK 
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1. Double Click on the icon F-Output-2 

2. Domain → Whole model 

Frequency → every x unit of time → x =  

Select U,V and A from Displacement/Velocity/Acceleration  

Select S from Stress 

Select E from strain → OK 
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1. Double Click on the icon Set from Assembly 

2. Name the set → enable Geometry → Continue → select a bottom node of the soil → 

Done 

3. Repeat steps 1 and 2 only this time select a bottom node of the building 

4. Repeat steps 1 and 2 only this time select a top node of the building 
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1. Double Click on the icon History Output Requests 

2. Domain → Set → soil bottom node set 

Frequency → every x unit of time → x = .  

Select UT,VT and AT from Displacement/Velocity/Acceleration → OK 

Repeat this step for building bottom node set and building top node set 
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Choose the module Job 

1. Click on the icon Create Job 

2. Select Model-1 → Continue 

3. Submit 
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